Notice

Creation of derivative works unless agreed to in writing by the copyright owner is forbidden. No portion of this publication may be reproduced, stored in a retrieval system or transmitted in any form or by any means, electronic, mechanical, photocopying, recording or otherwise, without the prior written permission from the copyright holder.

Texas Instruments reserves the right to update this Guide to reflect the most current product information for the spectrum of users. If there are any differences between this Guide and a technical reference manual, references should always be made to the most current reference manual. Information contained in this publication is believed to be accurate and reliable. However, responsibility is assumed neither for its use nor any infringement of patents or rights of others that may result from its use. No license is granted by implication or otherwise under any patent or patent right of Texas Instruments or others.

Copyright © 1997 - 2011 by Texas Instruments Incorporated.
All rights reserved.

Training Technical Organization
Texas Instruments, Incorporated
6500 Chase Oaks Blvd, MS 8437
Plano, TX  75023
(214) 567-0973

Revision History
October 2002, Version 1.0
October 2002, Version 1.0a  (Errata only)
April 2003, Version 1.1
   − Lab solutions for C64x (as well as C67x)
   − Labs now use CCS v2.2
January 2005, Version 1.2
   − Add support for CCS 3.0
   − Add tutorials for code tuning tools
August 2005, Version 1.3
   − Add C64x+ CPU information
December 2007, Version 1.4
   − Add support for CCS 3.3
March 2011, Version 1.51
   − Partial support for CCSv4
   − Updated for new devices (C674x, C66x)
Chapter 1 – Exam

It’s now time to prove you’ve been intently listening the past hour or so. You have approximately 20 minutes to complete the exam. Afterwards, the instructor will debrief each question while your neighbor grades your exam. Have fun!

- You will have 20 minutes to complete the exam.
- Exam is open mind, open book, open eyes. Sharing answers, cheating, asking the instructor questions, anything to get the highest grade possible is completely acceptable, encouraged, and expected.
- Good luck!

Student Name: ____________________________________________________________

1. Functional Units
   a. How many can perform an ADD? Name them.  ☐ (5 pts)

   ________________________________________________________________

   b. Which support memory loads/stores?  ☐ (5 pts)


2. C6000 Memories and Busing
   a. What is the advantage of L1 memory?  ☐ (5 pts)

   ________________________________________________________________

   b. What does the EDMA3 stand for … and what does it do?  ☐ (5 pts)

   ________________________________________________________________

   c. What is an SCR master?  ☐ (5 pts)

   ________________________________________________________________
3. **Conditional Code**
   a. Which registers can be used as conditional registers? (5 pts)
   _______________________________________________________________
   b. Which instructions can be conditional? (5 pts)
   _______________________________________________________________

4. **Performance**
   a. What is the ‘C6201 instruction cycle time? (5 pts)
   _______________________________________________________________
   b. How can the ‘C6201 execute 1600 MIPs? (10 pts)
   _______________________________________________________________
   How many MIPs can the ‘C6678 execute?
   _______________________________________________________________
   c. How many 16-bit MMACs (millions of MACs) can the ‘C6201 perform? (10 pts)
   _______________________________________________________________
   How about C674x or C66x cores?
   _______________________________________________________________

5. **Coding Problems** (write the code to perform the following)
   a. Move contents of A0 \(\rightarrow\) A1. (5 pts)
   _______________________________________________________________
   b. Clear register A5. (5 pts)
   _______________________________________________________________
   c. \(A2 = A0^2 + A1\) (5 pts)
   _______________________________________________________________
<table>
<thead>
<tr>
<th>Part Number</th>
<th>CPU</th>
<th>Peak MMACS</th>
<th>Frequency (MHz)</th>
<th>Single-Cycle SRAM per core (L1)</th>
<th>On-Chip SRAM per core (L2)</th>
<th>Local SRAM (LL2)</th>
<th>Shared SRAM (SL2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVCE6467T</td>
<td>C64x+ ARM9</td>
<td>8000</td>
<td>1000</td>
<td>32KB L1P, 32KB L1D</td>
<td>128 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DM3730-1000</td>
<td>C674x ARM Cortex-A8</td>
<td>6400</td>
<td>800</td>
<td>64 KB (ARM Cortex-A8)</td>
<td>9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OMAP3530</td>
<td>C674x ARM Cortex-A8</td>
<td>4160</td>
<td>520</td>
<td>32KB L1P, 80KB L1D</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OMAP-L137</td>
<td>C674x ARM9</td>
<td>3000, 3648</td>
<td>375, 456</td>
<td>32KB L1P, 32KB L1D</td>
<td>256 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OMAP-L138</td>
<td>C674x ARM9</td>
<td>3000, 3648</td>
<td>375, 456</td>
<td>32KB L1P, 32KB L1D</td>
<td>256 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6201-200</td>
<td>C62x</td>
<td>400</td>
<td>200</td>
<td>128 KB</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6202B-300</td>
<td>C62x</td>
<td>600</td>
<td>300</td>
<td>384 KB</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6203B-300</td>
<td>C62x</td>
<td>600</td>
<td>300</td>
<td>896 KB</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6204-200</td>
<td>C62x</td>
<td>400</td>
<td>200</td>
<td>128 KB</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6205-200</td>
<td>C62x</td>
<td>400</td>
<td>200</td>
<td>128 KB</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6211B-167</td>
<td>C62x</td>
<td>334</td>
<td>167</td>
<td>8 KB</td>
<td>64 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6410-400</td>
<td>C64x</td>
<td>3200</td>
<td>400</td>
<td>32 KB</td>
<td>128 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6411-300</td>
<td>C64x</td>
<td>2400</td>
<td>300</td>
<td>32 KB</td>
<td>256 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6412-720</td>
<td>C64x</td>
<td>5760</td>
<td>720</td>
<td>32 KB</td>
<td>256 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6413-500</td>
<td>C64x</td>
<td>4000</td>
<td>500</td>
<td>32 KB</td>
<td>256 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6414T-1000</td>
<td>C64x</td>
<td>8000</td>
<td>1000</td>
<td>32 KB</td>
<td>1024 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6415T-1000</td>
<td>C64x</td>
<td>8000</td>
<td>1000</td>
<td>32 KB</td>
<td>1024 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6416T-1000</td>
<td>C64x</td>
<td>8000</td>
<td>1000</td>
<td>32 KB</td>
<td>1024 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6418-600</td>
<td>C64x</td>
<td>4800</td>
<td>600</td>
<td>32 KB</td>
<td>512 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6421-700</td>
<td>C64x+</td>
<td>5500</td>
<td>700</td>
<td>32 KB</td>
<td>64 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6424-700</td>
<td>C64x+</td>
<td>5600</td>
<td>700</td>
<td>112 KB</td>
<td>128 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6452-900</td>
<td>C64x+</td>
<td>7200</td>
<td>900</td>
<td>64 KB</td>
<td>1408 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6455-1200</td>
<td>C64x+</td>
<td>9600</td>
<td>1200</td>
<td>64 KB</td>
<td>2048 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6457-1200</td>
<td>C64x+</td>
<td>9600</td>
<td>1200</td>
<td>64 KB</td>
<td>2048 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6472-700</td>
<td>C64x+</td>
<td>33600</td>
<td>700</td>
<td>32KB L1P, 32KB L1D</td>
<td>4416KB (less 768K)</td>
<td>768 KB</td>
<td></td>
</tr>
<tr>
<td>TMS320C6474-1200</td>
<td>C64x+</td>
<td>28800</td>
<td>1200</td>
<td>32KB L1P, 32KB L1D</td>
<td>3072 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6670</td>
<td>C66x</td>
<td>153000</td>
<td>1000, 1200</td>
<td>32KB L1P, 32KB L1D</td>
<td>256 KB * 4</td>
<td>2048 KB</td>
<td></td>
</tr>
<tr>
<td>TMS320C6672</td>
<td>C66x</td>
<td>80000</td>
<td>1000, 1250</td>
<td>32KB L1P, 32KB L1D</td>
<td>128 KB *4</td>
<td>4096 KB</td>
<td></td>
</tr>
<tr>
<td>TMS320C6674</td>
<td>C66x</td>
<td>160000</td>
<td>1000, 1250</td>
<td>32KB L1P, 32KB L1D</td>
<td>256 KB * 4</td>
<td>4096 KB</td>
<td></td>
</tr>
<tr>
<td>TMS320C6678</td>
<td>C66x</td>
<td>320000</td>
<td>1000, 1250</td>
<td>32KB L1P, 32KB L1D</td>
<td>512 KB * 8</td>
<td>4096 KB</td>
<td></td>
</tr>
<tr>
<td>TMS320C6701-167</td>
<td>C67x</td>
<td>334</td>
<td>167</td>
<td>128 KB</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6711D-200</td>
<td>C67x</td>
<td>400</td>
<td>200</td>
<td>8 KB</td>
<td>64 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6711D-250</td>
<td>C67x</td>
<td>500</td>
<td>250</td>
<td>8 KB</td>
<td>64 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6713B-300</td>
<td>C67x</td>
<td>600</td>
<td>300</td>
<td>8 KB</td>
<td>256 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6727B-350</td>
<td>C67x+</td>
<td>700</td>
<td>350</td>
<td>32 KB</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6742</td>
<td>C67x+</td>
<td>1600</td>
<td>200</td>
<td>64 KB</td>
<td>64 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6743</td>
<td>C67x+</td>
<td>1600, 3000</td>
<td>200, 375</td>
<td>64 KB</td>
<td>128 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6745</td>
<td>C67x+</td>
<td>3000, 3648</td>
<td>375, 456</td>
<td>64 KB</td>
<td>256 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6746</td>
<td>C67x+</td>
<td>3000, 3648</td>
<td>375, 456</td>
<td>64 KB</td>
<td>256 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6747</td>
<td>C67x+</td>
<td>3000, 3648</td>
<td>375, 456</td>
<td>64 KB</td>
<td>256 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6748</td>
<td>C67x+</td>
<td>3000, 3648</td>
<td>375, 456</td>
<td>64 KB</td>
<td>256 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320C6A8168</td>
<td>C674x ARM Cortex-A8</td>
<td>12000</td>
<td>1500</td>
<td>32KB L1P, 32KB L1D</td>
<td>256 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320DM642-720</td>
<td>C64x+ ARM9</td>
<td>5760</td>
<td>720</td>
<td>32 KB</td>
<td>128 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320DM643-700</td>
<td>C64x+</td>
<td>5600</td>
<td>700</td>
<td>32KB L1P, 32KB L1D</td>
<td>128 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320DM6446-810</td>
<td>C64x+ ARM9</td>
<td>6480</td>
<td>810</td>
<td>32KB L1P, 32KB L1D</td>
<td>64 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320DM6467-594</td>
<td>C64x+ ARM9</td>
<td>4752</td>
<td>594</td>
<td>32KB L1P, 32KB L1D</td>
<td>128 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320DM6467-729</td>
<td>C64x+ ARM9</td>
<td>5832</td>
<td>729</td>
<td>32KB L1P, 32KB L1D</td>
<td>128 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320DM6467T-1000</td>
<td>C64x+ ARM9</td>
<td>8000</td>
<td>1000</td>
<td>32KB L1P, 32KB L1D</td>
<td>128 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320DM648-1100</td>
<td>C64x+ ARM9</td>
<td>8800</td>
<td>1100</td>
<td>32KB L1P, 32KB L1D</td>
<td>512 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TMS320DM8168</td>
<td>C674x ARM Cortex-A8</td>
<td>12000</td>
<td>1000</td>
<td>32KB L1P, 32KB L1D</td>
<td>256 KB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VCE6467T</td>
<td>C64x+ ARM9</td>
<td>8000</td>
<td>1000</td>
<td>32KB L1P, 32KB L1D</td>
<td>128 KB</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
d. If \((B1 \neq 0)\) then \(B2 = B5 \times B6\)  

(10 pts)

e. Load an *unsigned* constant \((19ABCh)\) into register A6.  

(5 pts)

f. Load A7 with the contents of mem1 and post increment the selected pointer.  

*Basically, we want you to load the value 0x10 (at memory address mem1) into register A7.*

```
mem1: 0x10

16-bit wide memory

\[ \rightarrow A7 \]
```
Chapter 1 Exam Scoring

Points Earned (Questions #1-5): ______/100

Grade (circle one):
90-100 A
80-89 B
0-79 C
(no one likes Ds or Fs!)
Page left intentionally blank.
Lab 2 – Overview

To begin Lab 2, we need to prepare our lab workstation by setting up Code Composer Studio (CCS). After this is accomplished, you can complete the main exercises and optional exercises.

Main Exercises

Lab 2 consists of four parts:

A. Prepare your lab workstation
   Setup CCS preferences as needed for this workshop.

B. Build and debug C code using the Debug configuration
   A dot-product (sum-of-products) function provides a simple, but important, algorithm to familiarize us with compiling and debugging C code within Code Composer Studio. Build options and configurations, command line interface, breakpoints, performance profiling, and using the Watch Window are some of the various features explored.

C. Use the Release configuration to quickly optimize C code
   Once your C code has been debugged and is working, the next step is to optimize with the compiler’s optimizer. Using the profiler, we’ll contrast the efficiency of the compiler’s optimizer.

D. Benchmark using the Profiler tool
   Parts B and C used the simple clock-oriented benchmarking methodology. Part D introduces the Profiler Setup and Viewer windows. The profiling interface will be further explored as we examine the tuning tools later in the workshop.

Optional Exercises

Three optional exercises are available. The optional exercises are provided for those of you who finish the main exercises early; they extend the learning of the concepts presented in this chapter. If you do not get the chance to complete them during the assigned lab time, please feel free to work on them before or after class, or take them home (take-home solutions will be provided).

- Lab2e – Customize Your Workspace
- Lab2f – Using GEL
- Lab2g – Graphing Data
C64x, C64+, C671x, or C672x Exercises?

We support four processor types in these workshop lab exercises. Please see the specific callouts for each processor as you work. Overall, there are very little differences between the procedures.

Lab Exercises

- Which processor do you want to use in lab?
- We provide instructions and solutions for the C64x, C64x+, C671x and C672x.
- We try to callout the few differences in lab steps as explicitly as possible.
Lab 2a: Prepare Lab Workstation

The computers used in TI’s classrooms and dedicated workshops may be configured for one of ten different courses. The last class taught may have been DSP/BIOS, C2000 or C5000 workshop. To provide a consistent starting point for all users, we need to have you complete a few steps to reset the CCS environment to a known starting point.

Computer Login

1. If the computer is not already logged-on, check to see if the log-on information is posted on the workstation. If not, please ask your instructor.

CCS Setup

Code Composer Studio (CCS) can be used with various TI processors – such as the C6000 and C5000 families – and each of these has various target-boards (simulators, EVMs, DSKs, and XDS emulators). Code Composer Studio must be properly configured using the CCS_Setup application.

In this workshop, you should initially configure CCS for the processor that you selected. Use one of the following:

- **C64xx CPU Cycle Accurate Simulator, Little Endian**
- **C64x+ CPU Cycle Accurate Simulator, Little Endian**
- **C67xx CPU Cycle Accurate Simulator, Little Endian**
- **C672x CPU Simulator, Little Endian (located in the C67xx family in Setup CCStudio)**

Between you and your lab partner, pick the processor that best meets your needs. In any case, the learning objectives will be the same whichever target you choose.

2. Start the CCS Setup utility using its desktop icon:

![CCS Setup Icon]

**Note:** Be aware there are two CCS icons, one for setup, and the other to start the CCS application. You want the **CCS Setup** C6000 icon.

If you cannot find the desktop icon shortcut, try looking for it under the Windows Start menu:

- **Start** → **Programs** → **Texas Instruments** → **Code Composer Studio 3.3** → **Setup Code Composer Studio 3.3**

If all else fails, you should be able to find the program itself at:

- `C:\CCStudio_v3.3\cc\bin\cc_setup.exe`
3. When you open CC_Setup you should see a screen similar to this:

![Code Composer Studio Setup](image)

4. Clear the previous configuration.

Before you select a new configuration you should delete the previous configuration if one exists. Click the Remove All button. CC_Setup will ask if you really want to do this, choose “Yes” to clear the configuration.

![Erase existing system configuration?](image)
5. Select a new configuration from the list by selecting the appropriate Family, Platform, and Endianness filters. Select the appropriate simulator from the list and click the “<<Add” button.

If you want to experiment with the C64x devices in this workshop, please choose the **C64xx CPU Cycle Accurate Simulator, Little Endian** simulator and click **Add**:

![C64xx CPU Cycle Accurate Simulator, Little Endian](image1)

If you want to experiment with the C64x devices in this workshop, please choose the **C64x+ CPU Cycle Accurate Simulator, Little Endian** simulator and click **Add**:

![C64x+ CPU Cycle Accurate Simulator, Little Endian](image2)
If you want to experiment with the C67x devices in this workshop, please choose the **C67xx CPU Cycle Accurate Sim, Little Endian** simulator and click **Add**.

If you want to experiment with the C672x devices in this workshop, please choose the **C672x CPU Simulator, Little Endian** simulator and click **Add**.

Note: The C672x CPU Simulator is located in the **C67xx Family** in CCS Setup and not in the C672x Family.
6. Save and Quit the *System Configuration* dialog.
7. Select “Yes” to start CCS upon exiting CCS setup.

---

**Set CCS – Customize Options**

There are a few option settings that need to be verified before we begin. Otherwise, the lab procedure may be difficult to follow.

- Disable open Disassembly Window upon load
- Go to main() after build
- Program load after build
- Clear breakpoints when loading a new program
- Set CCS Titlebar information

8. Open the Options → Customize Dialog.
9. Set **Debug Properties**

Here are a couple options that can help make debugging easier.

- Unless you want the *Disassembly Window* popping up every time you load a program (which annoys many folks), deselect this option.

- Many find it convenient to choose the “Perform Go Main automatically”. Whenever a program is loaded the debugger will automatically run thru the compilers initialization code to your main() function.
10. Set Program Load Options

On the “Program/Project/CIO” tab, select the two following options:

- Load Program After Build
- Clear All Breakpoints When Loading New Programs

By default, these options are not enabled, though a previous user of your computer may have already enabled them.

Conceptually, the CCS Integrated Development Environment (IDE) is made up of two parts:

- **Edit** (and Build) programs
  
  Uses editor and code gen tools to create code.

- **Debug** (and down Load) programs
  
  Communicates with processor/simulator to download and run code.

The Load Program After Build option automatically loads the program (.out file) created when you build a project. If you disabled this automatic feature, you would have to manually load the program via the File → Load Program menu.

**Note:** You might even think of IDE as standing for Integrated Debugger Editor, since those are the two basic modes of the tool.
11. CCS Title Bar Properties

CCS allows you to choose what information you want displayed on its titlebar.

**Note:** To reach this tab of the “Customize” dialog box, you may have to scroll to the right using the arrows in the upper right corner of the dialog.

- We have chosen the “Board Name”, “Current Project”, and “Currently loaded program”.
  - The first item allow you to quickly confirm the chosen target (simulator, DSK, etc.).
  - The other two let us quickly determine which project is active and what program we have loaded. Notice how these correlate to the two parts of CCS: Edit and Debug.
- For our convenience we have also enabled *Display full path* and *Close all windows on Project Close*.

*Now you're done with the Workstation Setup, please continue with the Lab2b exercise ...*
Lab 2b: Using CCS with the Debug Configuration

The dot-product equation (sum-of-products) provides a simple, but important, function to familiarize us with compiling and debugging C code within Code Composer Studio.

Files in Project

| Lab2.PJT  | You create this! |
|Lab.TCF   | You create this, too. |
|MAIN.C    | Provided for you. |

main.c – Source Code

```c
/* MAIN.C                                     */
/* Prototype */
int dotp(short *m, short *n, int count);

/* Include Files */
#include "data.h"

/* Definitions */
#define COUNT 256

/* Declarations */
short a[COUNT] = {A_ARRAY};
short x[COUNT] = {X_ARRAY};
int y = 0;

/* Code */
main()
{
    y = dotp(a, x, COUNT);
}

int dotp(short *m, short *n, int count)
{
    int i;
    int sum = 0;
    for (i=0; i < count; i++)
    {
        sum = sum + m[i] * n[i];
    }
    return(sum);
}
```

data.h

```c
#define A_ARRAY 1,2,3,…,254,255,256
#define X_ARRAY 256,255,254,…,3,2,1
```
Create project file

1. Start CCS, if it’s not already open.

2. Create a new project called **lab2.pjt** in the `c:\op6000\labs\lab2` folder.

   **Project → New…**

   You will encounter the *Project Creation* dialog. Fill in the *Project Name* and *Location* as shown below. Be careful that you specify the path correctly. A common mistake is to add one too many `\lab2\` folders to the Location entry.

   a) Type in lab name
   b) Click […] and chose folder
   c) Verify target processor

   ![Project Creation dialog](image)

   Choose **TMS320C64XX** if you are using the C64x or C64x+ simulator.

3. View the newly created project in CCS by examining the *Project View* window.

   ![Project View](image)

   You may want to expand the **lab2.pjt** icon to observe the project contents. (Of course, it should be empty at this time.)
Create a TCF file

As was mentioned during the discussion, configuration database files (*.TCF) control a range of CCS capabilities. They are created by the Config Tool. In this lab, the TCF file will be used to automatically create the reset vector and perform memory management. More features of TCF files will be explored in later chapters.

4. Create a new TCF file (DSP/BIOS Configuration…) as shown below:

5. CCS asks you to select a template configuration file.

TI has configured a number of TCF template files to minimize your effort in customizing a configuration for your target platform. Pick one of these four TCF template files:

- ti.platforms.sim64xx
- ti.platforms.sim64Pxx
- ti.platforms.sim67xx
- ti.platforms.padk6727

depending upon which platform you are using.
6. After selecting the template file click on “OK”.

7. Since we used a generic template, let’s verify the Global Settings for our TCF file.

   Open the Global Settings properties per the figure below.
8. Edit the Global Settings. You’ll need to change the following:

- **Target Board Name:** Workshop (or whatever you want to call it)
- **DSP Speed in MHz:** 300 or 1000 (67xx = 300; 64x = 1000; 64x+ = 1000)
- **DSP Endian Mode:** little (make sure to keep little endian)
9. The final two TCF modifications involve changing the RTDX (real-time data transfer) mode and configuring dynamic memory. While we won’t be using RTDX, this step prevents an error from appearing each time a program is loaded.

Open the RTDX properties and select “Simulator” as the RTDX Mode:

If you were to port this project to run on a DSK (or other hardware target), then you change this setting to one of the other two settings:

- JTAG is the hardware emulation protocol used in most TI compatible emulators.
- HSRTDX stands for High-Speed JTAG and is only accessible when using the XDS560 emulator.
Since we will not be using dynamically allocated memory in any of our lab exercises the next step is required to reduce the memory footprint of our programs. Right click on the Memory Section Manager and select Properties. Then make certain that “No Dynamic Memory Heaps” is checked on the General tab.

10. Save your configuration file as lab.tcf to the c:\op6000\labs\lab2 directory.

**Note:** The “Save as type:” must be *Configuration Files (*.tcf, *.cdb)*

File → Save As…
Adding files to the project

You can add files to a project in one of three ways

- Select the menu **Project** → **Add files to Project**…
- Right-click the project icon in the Project Explorer window and select **Add files**…
- Drag and drop files from Windows Explorer onto the project icon

11. Using one of these methods, add the following files from `c:\op6000\labs\lab2` to your project:

   - `MAIN.C`
   - `LAB.TCF`
   - `LABCFG.CMD`

   When these files have been added, the project should look like:
Modify Build Options

The default *Debug* build configuration added to your new project is a good starting point. We recommend you add three items to this configuration.

12. First, add the –ss and –fs compiler options.

   Open the project’s build options: **Project→Build Options**
   
   - Select the –ss option on the *Feedback* page
   - Enter the directory to store *asm files* on the *Files* page

Note, the above screen captures are for a C64x system. The only thing you would see in a different system is that the –mv option should refer to the selected processor.

**IMPORTANT**- select the Basic Category on the Compiler Options tab and verify that the *Target Version* is set correctly for the processor that you chose when setting up CCS. The *Target Version* shown below is for the C64+ but yours may be different.
Modify the linker options.

13. Select the **Linker** tab of the *Build Options...* dialog box

![Linker tab of Build Options dialog box](image)

14. Change the name of the **Output Filename** (-o) to: `$\text{(Proj\_dir)\ debug\lab.out}$`

By default, when you create a new project, CCS names program after the project name. In most cases this works great. In our workshop, though, we wanted to use a generic output filename so that we won’t have to edit the linker options in each lab.

We encourage you to use a relative path: `$\text{(Proj\_dir)\ debug\*.out}$` which tells CCS to write the output files to a folder called “debug” which is a subdirectory of the projects folder.

15. Add the name of the **Map Filename** (-m) to: `$\text{(Proj\_dir)\ debug\lab.map}$`

- A map file is a report generated by the linker to describe its activity.
- If you do not specify a map filename, it will not be generated.
- By default, CCS does not create a map file. By specifying a map filename, CCS is notified to create the map file.

16. After the Linker options resembles the graphic above, select OK to save the values and close the dialog.

17. For good measure, save the changes you have made to the project (.pjt) file.

   ![Project Save](image)

   It’s always good practice to save the project file once in a while.
Building the program (.OUT file)

Now that all the files have been added to our project, it’s time to verify the build options and create the executable output program (that is, the .OUT file)

18. For easy debugging, use the Debug configuration; this should be the default. Verify by checking that Debug is in the Project Configurations drop-down box.

19. Build the program.

   Use the REBUILD ALL toolbar icon:

   or the Project → Rebuild All menu selection

Note the build progress information in the Build Output window that appears on the lower part of the CCS window. The build should complete with “0 Errors, 0 Warnings”.

20. Once the program builds without errors the lab.out program should be loaded automatically. Since you enabled the Program Load after Build option (step 10, pg. 2-9), CCS should automatically download the program to the simulator when the build is complete.

The yellow arrow indicates the position of the program counter. Once the program is loaded, it should be pointed to the beginning of main(). Setting the Perform Go Main Automatically option (step 9, pg 2-8) causes CCS to run to main after being loaded. If you don’t see this
arrow, then either the program wasn’t loaded properly, or the *Go Main* wasn’t performed. Of course, you can always run to main manually: **Debug→Go Main**

---

**Note:** Remember, the *Go Main* function tells CCS to run until it reaches the symbol `main`. If you invoke **Debug→Go Main** after the program counter has passed the `main`, the program will not be able to stop at `main`.

**Note:** If, for some reason, you must quit Code Composer before completing this lab you must remember to open the `lab2.pjt` project and load (**File→Load Program**) the `lab.out` executable file.

---

### Debug Code

Now that the program has been written, compiled, and loaded, it’s time to determine its logical correctness.

#### Watch Variables

21. Add *y* to the **Watch** window.

   Select *y* in the `main.c` window
   Right-click, and choose **Add To Watch Window**

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Type</th>
<th>Radix</th>
</tr>
</thead>
<tbody>
<tr>
<td>🗃️ y</td>
<td>0</td>
<td>int</td>
<td>doc</td>
</tr>
</tbody>
</table>

After adding a variable, the **Watch** window automatically opens and *y* is added to it. Alternatively, you could have opened the watch window, selected *y* and dragged it onto the **Watch 1** window.

22. Click on the **Watch Locals** tab.

   You’ll notice this is empty since main() doesn’t contain any local variables.
23. Single-step the debugger until you reach the dotp() function; it contains local variables.

Use toolbar -or- Debug menu

In 2 or 3 single-steps, you’ll notice that Watch Locals is updated:

![Watch Window]

Note: If a Watch window (other than the Watch Locals window) shows an error “unknown identifier” for a variable, don’t worry, it’s probably due to the variable’s scope. Local variables do not exist (and don’t have a value) until their function is called. Code Composer will add them to the watch window, but will indicate they aren’t valid until the appropriate function is reached.

Using the Command Window

Some of you may find it easier to use a keyboard than the mouse. To that end, CCS includes a Command-line window. Long time users of TI DSP tools will find these commands familiar.

24. Show the Command window (Tools→Command Window)

This opens up the Command window and docks it at the bottom of the CCS window. You may wish to resize or rearrange the windows, for your convenience. In fact, it may help to right-click inside the Build window and select Hide to give you more space.
25. To try out the Command window, let’s add a and x to the Watch window. The wa (watch add) command adds a variable to the watch window. Type the following into the Command textbox and hit the Execute button (or enter key):

    wa a

26. The Command window also represents one of the three automation methods provided within CCS. As a demonstration, we created a debugger command/log file called watch.txt. To invoke it, enter:

    take watch.txt

You should see a and x added to the Watch window. Like batch files or macros, this works especially well if you want to repeat a given sequence at a later time … or over and over.

<table>
<thead>
<tr>
<th>Note:</th>
<th>If you receive an error, “Cannot open file: “watch.txt”, it’s just that CCS cannot find the file. CCS looks in the path of the last file opened with File → Open, rather than the local path of the active project.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>There are two solutions:</td>
</tr>
<tr>
<td></td>
<td>1. Use the full path name: c:\op6000\labs\lab2\watch.txt</td>
</tr>
<tr>
<td></td>
<td>2. Open a file from the current project’s path. For example, use File → Open to open main.c. Since this file is already open, nothing really happens except making CCS use the proper default for our WATCH.TXT.</td>
</tr>
</tbody>
</table>

    Go ahead and try take watch.txt again.

27. Since both a and x were in our take file, and we had already added a to the Watch window, it shows up twice. Let’s remove one of them.

    Select a in the Watch window and hit the delete key

28. Click back over to the Watch Locals view.

29. In the Command window, try the step command.

    step <enter>

30. This should single-step the processor.

31. Try stepping multiple times.

    step 15 <enter>

    This performs 15 single-steps. You should be able to see the Watch Locals updated at each step (though it goes quickly).
Multiple Operations Toolbar

CCS has a feature that provides multi-operations from a toolbar. Let’s try to single-step our source code another eight times using this feature.

32. Verify the Multiple Operations toolbar is visible. It should look like:

![Multiple Operations Toolbar](image)

If you cannot find it, it can be opened from the View menu:

View → Debug Toolbars → Multiple Operations

33. Set the Multiple Operations values as shown in the proceeding step and execute.

Source Step Into
8
Execute

You should see it executing multiple single-steps, just as in step 31.

Run and Halt

34. Once you’ve had your fill of single-stepping, try running the processor:

Use toolbar -or- Debug:

- or- F5

35. What happens when the processor reaches the end of the main( ) function.
One of two things can happen upon exiting main().

- CCS stops the debugger.
- The processor keeps running.

Which option occurs for you depends upon a couple factors: how you build your program, how your code was written. Most embedded systems, though, are designed to never end. Through the use of a scheduler kernel or something like a while loop, they loop continuously while waiting for events (i.e. interrupts) to service.

36. By checking the status bar in the lower left corner, you can determine if the processor is still running. You should see one of these messages:

![Running](image)

or

![Halted](image)

**Running** with a *green* light means the CPU is running. **Halted** with a *red* light means it is executing.

37. If the processor is running, halt it:

Use Toolbar -or- **Debug → Halt** -or- **shift-F5**

You can minimize the Disassembly Window if it pops up.

### Sidebar: Connected / Disconnected from the DSP Target

You might have noticed the *plug connected* icon next to the running/halted status. This means that CCS is connected (i.e. talking to) the target.

When using the simulator, you should not have an issue with the target becoming disconnected. With a hardware target, such as a DSP Starter Kit (DSK) or your own hardware, this may not be the case. For example, what if the target was powered down while CCS was still running? Rather than crash, CCS signals you via the connected/disconnected icon.
Setting Software Breakpoints

You can force the program to halt execution by using a software breakpoint. Let's set one at the end of main() to guarantee that code execution stops.

38. Set a breakpoint at the end of main() to stop the processor automatically.

Click the cursor on the highlighted line below

Click the Add Breakpoint toolbar button:

```
/* Main Code */
main()
{
    y = dotp(a, x, 40);
}
```

Note: When selecting Toggle Break Pt, the break point will be added to whatever line contains the cursor. This is why we recommend clicking on the line as described above.

The code window should now appear as shown:

Alternatively, to set or remove a breakpoint, double-click on the spot where the red dot appears in the left column of the code window.

39. Before we can run our code to try out our breakpoint, we must get our Program Counter (PC) back to the address main. (That is, get it back to someone in code before the breakpoint.)

Debug → Restart

Note: If the breakpoint (red dot) or program-counter (yellow arrow) icons disappear after running or reset, clicking in the source window should cause them to be redrawn.

40. Run the code. It should stop at your breakpoint.

- or - F5 - or - Debug → Run
What’s the Dot-Product Result?
41. Check the value of $y$ in the watch window and write it below.

\[ y = \underline{\phantom{00000000}} \]

The answer should be: \( 0x002b2b00 \) or \( 2829056 \) decimal

Hopefully one of these values appears in the Watch window.

**Hint:** To change the format of a Watch window value, click on the Radix cell of the entry of interest. Then select the Property Page. Select the type you want from the Default Radix drop-down style box on the Property Page.

Since the default for $y$ is decimal, try hex.

Benchmark Code Performance

We define analyzing how long it takes code to execute code as benchmarking performance. In our example, we’re interested in benchmarking the dot-product function. There is more than one way of benchmarking code performance within CCS, we will start with the Clock method.

42. Before we begin, let’s restart our program. Make sure the processor is halted, then:

```
Debug \rightarrow Restart
```

By the way, if you want to free up some extra room, you can close the Command window (right-click on it and select close.)

43. Open the cycle clock.

```
Profiler \rightarrow Clock \rightarrow View
```

Look for the clock to appear in the lower right corner on the status bar. The balloon notice is also important, it reminds you how to zero out the Profile Clock.
44. Before we use the clock, we need to set another breakpoint. We need two breakpoints, one before and another after the `dotp()` function. These will enable us to calculate the number of clock cycles it takes to execute the function.

Add the additional breakpoint indicated below.

45. First, let’s run to the first breakpoint and clear the clock.

Notice the yellow arrow indicates that program execution stopped at the first breakpoint. Next, clear the profile Clock by double-clicking on it.

Once cleared, it should read zero:
46. Finally, run to the next breakpoint and record the clock value.

```
int y = 0;

/* Main Code */
main()
{
    y = dotp(a, x, COUNT);
}

int dotp(short *m, short *n, int count)
{
    int i:
```

How fast was your `dotp` function? ___________ clock cycles

Was it also 8750 cycles? Since future revisions of the compiler could alter performance, or if you used different options, the results might be different.

47. Copy your result to the **Results Comparison Table** on page 2-42.

48. Halt the processor if it’s still running.
Lab 2c: Benchmark the Release Build-Configuration

After you have verified your program works correctly, you most likely will want to improve its performance. Remember from the class discussion, the Release build configuration enables the optimizer.

Using the compiler’s optimizer is the easiest way to speed-up your code. During the next couple days, the workshop will highlight many additional optimization techniques. In this lab, though, we use the compiler’s optimizer to improve performance.

Activate and Modify the Release Configuration

49. Before we move on, let’s be save and save our project.

   Project → Save

50. Choose the Release build options (for optimization).

   Project → Configurations...

      Select the Release configuration and click the Set Active button, then close dialog

   Hint: You can use the convenient build configurations drop-down box to make Release active. We discussed this feature in step 18 (pg 2-22).

51. Per the discussion before the lab, there are some recommended additions to the default Release configuration. Now that the Release build-configuration is active, you can open up the Build Configurations dialog and make the following changes.

First, the Compiler:
Next, verify that the *Target Version* is set correctly for the processor that you selected:

![Build Options for lab2.pjt (Release)](image)

Then the linker:

![Basic Options](image)

When finished with the changes, click OK to accept the modifications and close the dialog.
Breakpoints (again), Run and Benchmark Release

52. Rebuild and load the program (as in step 19-20).

53. Once loaded, though, note that the breakpoints you set have become disabled. You can see this from the hollow round circles where your breakpoints used to be.

Note: When loading a new program, it is desirable to disable (or remove) any breakpoints from the previous program. Rarely, do the needs of one program match another. If you prefer to disable this feature, it can be turned off via Option → Customize → Program/Project/CIO.

Or you can verify this from the Breakpoint dialog.

Debug → Breakpoints

If you remember from the earlier discussion, breakpoints can only be set at function-level boundaries when the optimizer is enabled – which it is in the Release build configuration. You can go ahead and enable the second breakpoint in the dialog box, or by double-clicking on it in the source window margin.
To enable the first breakpoint, go ahead and set it as shown:

```c
int dotp(short *m, short *n, int count)
{
    int i;
    int sum = 0;

    for (i=0; i < count; i++)
    {
        sum = sum + m[i] * n[i];
    }
}
```

The beginning and ending of main() work fine for this example. If we had other code in main, we may have needed to move our breakpoints to the beginning and ending of dotp().

54. Once the breakpoints are re-enabled, make sure the execution (yellow) arrow is at the start of main() and follow the same Clock profiling procedure used earlier (steps 42-48).

How fast was `dotp()` this time? _________________ clock cycles

55. Copy this result to the Results Comparison Table on page 2-42.

    Halt the processor if it’s still running.

56. Does the code run faster using the compiler’s optimizer? ____________________________

57. Clear any breakpoints you set in the lab.

    You can use Debug → Breakpoints → Delete All or use the toolbar button:
Lab 2d: Benchmarking with the Profiler

Overview

The Clock provides a simple, non-intrusive (as it sits in the status bar) method of benchmarking. When examining a large algorithm or project, though, this method is tedious. To this end, the CCS Profiler tool automates the benchmarking procedure and provides you with a table of results.

The profiler consists of two windows: **Profiler Setup** and **Profiler Viewer**.

These windows are part the entire suite of tuning tools (which include Cache-Tune and Code-Size Tune, among others). All the windows that make up the CCS interface (including all the tuning tools) are often called the **Tuning Dashboard**. In this lab, we examine only the Profiler part of the Dashboard. In future chapters, you will explore the other tuning components.
Setup the Profiler

58. **Build and load** your lab using the **Debug** build-configuration.

59. **Set a breakpoint** at the end of main().

60. **Open the Profile Setup window.**

   Profile → Setup

61. **Enable function and loop profiling.** Set the Profile Setup window as shown.

   ![Profile Setup Window]

   **This is a three step process:**
   1. Select the code we want to profile:
      - Functions
      - Loops
   2. Select the items to profile on the custom tab.
   3. Click “Enable Profiling” toolbar button.

62. Open the Profile Viewer window.

   Profile → Viewer

   Whether or not there is anything in this window, it will be updated when we run the program in the next step.
63. Run (F5) your program. When the program halts (on the breakpoint at the end of main), review the results in the Profile View window.

Note, you will have to scroll down to find the data we are interested in.

dotp() cycle count

So, is the 8741 cycle count what we expected? Actually, it is very close. Here are the cycle counts we got when profiling our ‘debug’ code using the Clock. Notice, there is a slight difference depending upon where we placed our breakpoints (in the calling function, or just inside the function itself.

<table>
<thead>
<tr>
<th>Address Range</th>
<th>Symbol Name</th>
<th>SLR</th>
<th>Symbol Type</th>
<th>Access Count</th>
<th>cycle.CPU</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0:xcd44-0xcode8</td>
<td>dotp</td>
<td>21-32:main.c</td>
<td>function</td>
<td>1</td>
<td>8741</td>
<td></td>
</tr>
<tr>
<td>0:xcd60-0xcd44</td>
<td>main</td>
<td>16:19:main.c</td>
<td>function</td>
<td>1</td>
<td>8750</td>
<td></td>
</tr>
<tr>
<td>0:xc5c0-0xc8dc</td>
<td>CACHE_clean</td>
<td>441-484:cs1</td>
<td>cach...loop</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

**Count**

As expected, we only ran the dotp function once. Though, notice the loop ran 256 times (again, as expected).

**Totals**

We will examine the 8741 cycle count in the narrative below. Notice the Inclusive/Exclusive results. There is no difference for dotp. For main, though there is a big difference.

8741 cycles

8750 cycles

What do you think accounts for the difference?
What is the does *inclusive* and *exclusive* describe?

<table>
<thead>
<tr>
<th>Address Range</th>
<th>Symbol Name</th>
<th>Access Count</th>
<th>cycle.CPU: Incl. Total</th>
<th>cycle.CPU: Excl. Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>0:0xfc38-0xfcc8</td>
<td>c64cfg.s62:910:9...</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0:0xce44-0xcede8</td>
<td>dotp</td>
<td>1</td>
<td>8741</td>
<td>8741</td>
</tr>
<tr>
<td>0:0xcf00-0xce44</td>
<td>main</td>
<td>1</td>
<td>8750</td>
<td>9</td>
</tr>
<tr>
<td>0:0xc8c0-0xc8dc</td>
<td>CACHE_clean</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
**Profiler Setup – Ranges**

64. **Reduce profiler ranges.**

Since we are only looking at three of the functions/loops in the Profiler Viewer window, let’s reduce the “ranges” we wish to profile. To do this:

- Select the *Ranges* tab in the Profiler Setup window
- Select all the ranges except *main* and *dotp*
- Disable the selected ranges by clicking the space bar
  (alternatively, you disable/enable by dragging and dropping, or via a right-click menu)

65. **Save the profiler-configuration.**

So that you do not have to continue disabling the profiler for the functions we are not interested in, you can save the profiler-configuration that you just created. On the Profiler Setup window toolbar, select the *Save Profiler Configuration* button (as shown below).

*Note:* The functions we are not interested in come from other code modules. In this case, they are functions created or called by the TCF file.
Lab 2d: Benchmarking with the Profiler

Notice also, the *Load Profiler Configuration* button just to the left of the save button.

![Profile Setup](image)

**Note:** Now that you have this profiler configuration created, you will be able to use it for profiling code in many of the upcoming labs.

---

66. **Profile Release build-configuration.**

Let’s repeat the profiler again for the Release configuration.

- Make *Release* active
- Build (and load) program
- Set breakpoint at the end of main()
- Run
- Compare results with previous: ________________________________

---

67. **Here are our results:**

You might notice that the dotp function is gone. Why is this? ________________________________

---

<table>
<thead>
<tr>
<th>Address Range</th>
<th>Symbol Name</th>
<th>Symbol Type</th>
<th>Access Count</th>
<th>cycle.CPU: Incl. Total</th>
<th>cycle.CPU: Excl. Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x0380-0x03d0</td>
<td>main</td>
<td>function</td>
<td>13</td>
<td>76</td>
<td>76</td>
</tr>
<tr>
<td>0x0a20-0x0a38</td>
<td>main</td>
<td>loop</td>
<td>30</td>
<td>60</td>
<td>60</td>
</tr>
</tbody>
</table>

Again, your results may differ slightly from those above. If your cycle counts are drastically different, though, please consult with your instructor.

68. **Close the project** and any windows associated with it.

   _Project ➔ Close_
Lab 2 Summary

Let’s summarize our profile results.

Results Comparison Table

<table>
<thead>
<tr>
<th>Lab Step</th>
<th>Lab2 File</th>
<th>Build Configuration</th>
<th>Cycles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 46 (pg 2-31)</td>
<td>main.c</td>
<td>Debug</td>
<td></td>
</tr>
<tr>
<td>Step 54 (pg 2-35)</td>
<td>main.c</td>
<td>Release</td>
<td></td>
</tr>
</tbody>
</table>

End of Lab2

We highly recommend trying the first couple optional exercises, if time is still available.

Before going on, though, please let your instructor know when you have reached this point.
Optional Exercises

Optional exercises are additional labs that you can use to extend your knowledge of the ‘C6000 and CCS toolset. If you finish the main exercise early, you are welcome to begin working on these labs.

Optional 2e – Customize CCS

Add Custom Keyboard Assignment

While most CCS commands are available via hotkeys, you may find yourself wanting to modify CCS to better suit your personal needs. For example, to restart the processor, the default hotkey(s) are:

Debug → Restart

CCS lets you remap many of these functions. Let’s try remapping Restart.

1. Start CCS if it isn’t already open.
2. Open the CCS customization dialog.
   Option → Customize…
3. Choose the Keyboard tab in the customize dialog box.
4. Scroll down in the Commands list box to find Debug → Restart and select it.
   In CCS 3.3, you may notice a three-key shortcut has already assigned. Let's go ahead and assign another, easier to use key.
5. Click the Add button.
6. When asked to, “Press new shortcut key”, press:
   F4
   We already checked and this one isn’t assigned within CCS, by default.
7. Click OK twice to close the dialog boxes.
8. From now on, to Restart and Run the CPU, all you need to do is push F4 then F5.
Customize your Workspace

You may not find the default workspace for CCS as convenient as you’d like. If that’s the case, you can modify as needed.

9. Close CCS if it’s open, and then open CCS.

   This is forces CCS back to its default states (i.e. no breakpoints, profiling, etc.).

10. Move the toolbars around as you’d like them to be.

    For example, you may want to close the BIOS toolbar and then move the Watch toolbar upwards so that you free up another ½ inch of screen space.

11. If you want the Project and File open dialogs to default to a specific path, you need to open a project or file from that path.

12. Make sure you close any project or file from step 11.

13. Save the current workspace.

   **File → Workspace → Save Workspace As…**

   Save this file to a location you can remember. For example, you might want to save it to:

   C:\op6000\labs\`

14. Close CCS.

15. Change the properties of the CCS desktop icon.

    Right-click on the CCS desktop icon
    Add your workspace to the Target, as shown below

    ![CCStudio v3.3 Properties](image)

    This is where you put the path and name of your workspace file.

    If the name or path contains a space, you need to enclose the string in "quotes".

16. Open up CCS and verify it worked.
Optional Lab 2f - Using GEL Scripts

GEL stands for General Extension Language, a fancy name for a scripting tool. You can use GEL scripts to automate processes as you see necessary. We’ll be using a few of them in the lab in just a few minutes.

Using GEL Scripts

When debugging, you often need to fill memory with a known value prior to building and running some new code. Instead of constantly using the menu commands, let’s create a GEL (General Extension Language) file that automates the process. GEL files can be used to execute a string of commands that the user specifies. They are quite handy.

1. Start CCS and open project lab2.pjt, if it isn’t already open.
2. Create a GEL file (GEL files are just text files)
   File → New → Source File
3. Save the GEL file
   Save this file in the lab2 folder. Pick any name you want that ends in *.gel.
   File → Save
   We chose the name mygel.gel.
4. **Create a new menu item**

   Create a new menu item (that will appear in CCS menu “GEL”) called “My GEL Functions”.

   ```
   menuitem "My GEL Functions";
   ```

   You can access all of the pre-defined GEL commands by accessing:

   ```
   Help → Contents
   Select the Index tab and type the word “GEL”.
   ```

5. **Create a submenu item using hotmenu**

   The `menuitem` command that we used in the previous step will place the title “My GEL Functions” under the GEL menu in CCS. When you select this menu item, we want to be able to select two different operations. Submenu items are with the `hotmenu` command.

   Enter the following into your GEL file: (Don’t forget the semicolon – as with C, it’s important!)

   ```
   hotmenu HelloWorld ( )
   {
   GEL_OpenWindow("Fred", 0, 5);
   GEL_TextOut("Hello World\n","Fred",2,1,1);
   }
   ```

   HelloWorld doesn’t really do anything, but it’s an example of how you can write from a GEL script to the user interface.

6. **Create another submenu item to clear our arrays**

   Use the following commands to create a submenu item to clear the memory arrays. Again, you can look this up in the help index:

   ```
   hotmenu ClearArrays()
   {
   GEL_MemoryFill(a, 0, 128, 0x0);
   GEL_MemoryFill(x, 0, 128, 0x0);
   }
   ```

   The MemoryFill command requires the following info:

   - Address
   - Type of memory (data = 0)
   - Length
   - Memory fill pattern.

   This example will fill our arrays (a, x) with zeros.

   By the way, if our arrays each contain 256 elements, why did we use a fill length of 128?
7. **Add one more menu item to fill the arrays**

In this example, we want to ask the user to enter a value to write to each location in memory. Rather than using the `hotmenu` command, the `dialog` command allows us to query the user.

Enter the following:

```c
dialog FillArrays(fillVal "Fill Arrays with:\")
{
    GEL_MemoryFill(a, 0, 128, fillVal);
    GEL_MemoryFill(x, 0, 128, fillVal);
}
```

8. **Save then Load your new GEL file**

To use a GEL file, it must be loaded into CCS. When loaded, it shows up in the CCS Explorer window in the GEL folder.

File → Save
File → Load GEL and select your GEL file

9. **Let’s try out your first GEL script**

GEL → My GEL Functions → HelloWorld

10. **Show arrays in Memory window**

Without looking at the arrays, it will be hard to see the effect of our scripts. Let’s open two Memory windows to view a and x.

View → Memory...

A couple notes about memory windows:

- If you enter a symbol, for example a, and you receive an error stating it cannot be found, make sure the program (.out file) that contains the symbol has been loaded (File-Load Program).
- You may find that array a begins with symbol .bss rather than a. In this case, these two symbols share the same memory address, but only one can be displayed. (The .bss symbol will be discussed in Chapter 12.)
• C Style adds 0x in front of the number, TI Style doesn’t.

11. Now, try the other two GEL functions.

   GEL → My GEL Functions → ClearArrays
   GEL → My GEL Functions → FillArrays

   You can actually use this GEL script throughout the rest of the workshop. It is a very handy tool. Feel free to add or delete commands from your new GEL file as you do the labs.

12. Review loaded GEL files.

   Within the CCS Explorer window (on the left), locate and expand the GEL files folder. CCS lists all loaded GEL files here.

   **Hint:** If you modify a loaded GEL file, before you can use the modifications you must reload it. The easiest way to reload a GEL file:

   (1) Right-click the GEL file in the CCS Project Explorer window
   (2) Pick "Reload" from the right-click popup menu
Optional Lab 2g – Graphing Data with CCS

The optional lab uses sine-wave and filter functions to generate an output that’s easy to graph. After generating two sine waves and adding them, the filter demodulates one of the waveforms.

Create project

1. Close your Lab 2 project if it is still open.

2. Using Windows Explorer, COPY the following files from c:\op6000\labs\lab2 to c:\op6000\labs\lab2g. You can use several methods to perform the copy. We prefer the method where you select the files that you want to copy, select Copy (Ctrl + C) to copy them, then navigate to the destination and select Paste (Ctrl + V) to paste them.

Please make sure you COPY the files.

LAB2.PJT
C64.TCF, C64XP.TCF, C67.TCF or C672X.TCF
C64CFG.CMD, C64XPCFG.CMD, C67CFG.CMD, or C672XCFG.CMD

Note: Please make sure to copy the above files correctly. We want to make sure that you can come back to any lab folder and find the files for that lab. If you are not careful, it is easy to move files around and rather than copying them. Make sure to copy the correct files from and to the correct place. The .TCF and .CMD file that you chose to copy will depend on which processor you selected when setting up CCS.

3. While still inside Windows Explorer, make sure that you are in the c:\op6000\labs\lab2g directory.

4. Use Windows Explorer to rename the c:\op6000\labs\lab2g\lab2.pjt file to lab2g.pjt by right clicking on it and choosing rename.

5. Now go over to Code Composer Studio (or open it up if you closed it) and open lab2g.pjt.

PROJECT → OPEN

Choose c:\op6000\labs\lab2g\lab2g.pjt

You will receive an error indicating that main.c cannot be found.

Remove main.c file from the project by using one of the two methods listed below:

- Click “Remove” in the preceding dialog
- Select the files in the Project Explorer window and press the delete key
6. Go to the Project menu and click on Compile File. This will build the linker command file.

7. Add the following files to the project:

```
sinefilter.C  (provided for you)
lowcoefficients.C  (provided for you)
c672xcfg.cmd  (linker command file from the previous step)
```

8. Build and load the project.

**Setup graph windows**

Let’s setup three graph windows:

- **buffer1[]**: Sinegen-output / Filter-input
  - Buffer used for graphing data.
  - Graph should show a sinusoid with an obvious carrier.

- **buffer2[]**: Filter output
  - Buffer used for graphing data.
  - Graph should appear as a 1KHz sine-wave (using LowCoefficients.C)

- **filtbuff[]**: Buffer used by the filter.
  - It stores the 80 term delay line for the filter.
  - Watch as the data slides across the window.

9. Setup graph windows as shown:

   **View → Graph → Time/Frequency**

   Setup three graphs with the following properties:
Setup breakpoint for animation

10. Setup up the following breakpoint:

```c
short filter(short newValue)
{
    short i;
    short filterlength=80;
    int sum=0;

    filtbuff[0] = newValue;

    for (i=(filterlength-1);i>=0;i--)
    {
        sum += ((int)filtbuff[i] * (int)coef[i])>>15;
        filtbuff[i+1] = filtbuff[i];
    }

    return(sum);
}
```

11. Save the current window layout as a Workspace:

   _File_ → _Workspace_ → _Save Workspace As:_

   Give it a name such as _lab2g.wks_

12. _Restart_ then _Run_.

    The program should run to your breakpoint.

Look at the Data Visually

13. _Animate_ your code.

    Use _ɔɔɔ_ _-or-_ _Debug_ → _Animate_ _-or-_ ≠

    You should see the graphs updating.

14. Now go to the Dual Sine Generator graph (_buffer1_), _RIGHT-CLICK_ the right button of the mouse in this window and select _PROPERTIES_. Change the display type to _FFT Magnitude_.

15. Also, change the Filter Output graph (_buffer2_) to _FFT Magnitude_.

    Notice that Dual Sine Generator graph (_buffer1_) has two spikes at 1Khz and 2Khz while Filter Buffer graph (_buffer2_) should only have a single spike at 1Khz. The filter removes one of the frequencies.
Optional Exercises

Other things to try in Lab 2g ...

- Try out the workspace saved earlier:
  - Quit Code Composer
  - Start Code Composer
  - Load LAB2g.WKS

Isn’t that easier than opening up all those graphs again?

- Change the filter coefficients:
  - Delete LowCoefficients.C from the project
  - Add HighCoefficients.C to the project
  - Rebuild the program and animate it again.
    Now buffer2 should only have a 2KHz spike.
Lab2h - Using CCSv4

Introduction

Our goal with Lab2h is to replicate a big part of our earlier lab exercise, but using the new CCStudio version 4 (CCSv4).

We’ll explore:

- Workspaces
- Perspectives
- Creating a CCS managed-make project
- Debug/Release compiler options
- DSP/BIOS 5.xx Configuration Files (.tcf)
- Target Configuration Files (i.e. CCS Setup)
Lab Topics

Lab2h - Using CCSv4

Lab Topics................................................................................................................................................. 2-1

Open CCSv4........................................................................................................................................... 2-2

Creating a New CCSv4 Project ................................................................................................................... 2-3

New Project Wizard.................................................................................................................................... 2-4

Adding files to the Project .......................................................................................................................... 2-5

Build ... and try to Run .............................................................................................................................. 2-6

Verify, Build ... and Run ............................................................................................................................ 2-7

Start the Debugger ..................................................................................................................................... 2-8

Breakpoint and Run ................................................................................................................................... 2-9

Clock your code .......................................................................................................................................... 2-10

Profile your code ........................................................................................................................................ 2-11

Build Code for Release .............................................................................................................................. 2-12

Fix the Release Build Configuration .......................................................................................................... 2-13

Test Updated Release Build Config’s Performance ...................................................................................... 2-14
Open CCSv4

1. Find the appropriate icon on the desktop to open CCSv4.

2. Select a workspace – we used (and recommend for this class) C:\op6000\workspace.

In Eclipse (i.e. CCSv4) a workspace is the repository for project information. The best analogy I can come up with is the iTunes database – which is the repository for all the metadata about your music and video. That is, the song files can exist within the iTunes database folder, or elsewhere on your drive. In any case, though, the iTunes database holds the information on what you have and where it’s located.

Some users prefer to create a separate workspace for each project; others prefer to have all their projects in a single workspace - it’s mostly a style preference. For this lab, we recommend following our directions ... we suspect that after you’ve used Eclipse/CCSv4 for a little while, you’ll figure out which way you like best.

3. Click the cube ...

   If your workspace is new, you will need to click the cube to start the IDE where you’ll edit and debug your programs.
Creating a New CCSv4 Project

New Project Wizard

Conceptually, projects are very similar between CCSv3.3 and CCSv4. Practically, there’s quite a few differences. What has changed the most is that the project settings are stored in fashion created by the Eclipse IDE community – a set of xml files. Thankfully, TI has created a straightforward new project wizard that works quite well … as long as you don’t move thru it too fast and miss an important setting or two.

4. **Create a new CCS project titled lab2h – locating it in the lab2h_ccsv4 folder.**

   File → New → CCS Project

   Fill out the resulting dialog as shown, then hit Next >.

   By default, CCS chooses the workspace to store your new project. However, we want to put our project (and it’s files) into our labs project folder.

   So, make sure you uncheck the “Use default location” checkbox and enter the project name “lab2h”. Then, browse to the directory: C:\op6000\labs\lab2h

5. **Choose the Project Type and default Build Configurations.**
6. Select **Next** – as there are **no Add'l Project Settings**.

   On this screen, just click **Next**, as there are no additional project settings.

   ![New CCS Project](image)

   **Additional Project Settings**

   Define the inter-project dependencies, if any.

6. Select **Next** – as there are no Add'l Project Settings.

   On this screen, just click **Next**, as there are no additional project settings.

7. **Select Project Settings … then hit **Next** !!!**

   We are now at one of the critical and most useful capabilities of CCSv4. We can apply a number of settings on a *per-project* basis, such as: Compiler/Code-gen tools version, Endianess, target configuration (not in this dialog, but we’ll show you this soon).

   Older versions of CCS (e.g. CCSv3.3) required you to set these on a global basis in the CCS Configuration Manager (which we think was much less convenient).

   ![New CCS Project](image)

   **Project Settings**

   Select the project settings.

   **Output type:** Executable

   **Device Variant:** Generic C674x Device

   Pick the device type based on C6000 generation you are using in this workshop

   ![New CCS Project](image)

   **Device Variant:** Generic C674x Device

   Pick the device generation appropriate for your needs … then hit **Next**.

   **Note:** If you aren’t using BIOS, Codec Engine, XDC or any example program from TI, you could click **Finish**, but since we’re using the BIOS configuration file to simplify our device configuration (i.e. reset/interrupt vectors), we want to choose **Next**.
Creating a New CCSv4 Project

8. Select a project template – we’ll use: DSP/BIOS v5.xx Empty Example.
   This sets up the correct paths to the BIOS libraries and configuration tools.

   ![Screenshot of CCSv4 project template selection]

   Finally, you can click Finish when you’re done selecting the Empty Example.

Adding files to the Project

Adding Source Files

9. Add the program source files to your new project.

   Right-click on the project and choose the Add Files to Project... menu command.

   Add the following two files to the project from our earlier lab exercise:

   - main.c
   - data.h

   You can find these files in:
   - C:\op6000\labs\lab2

Note: What’s the difference between Link and Add?

   CCSv3.3 only supported linking – where file was only referenced from it’s original location. In CCSv4, though, adding a file copies it into the project’s directory (which is what we want to do for this example lab).
Adding TCF File

10. Create a new BIOS Configuration file (.tcf) and add it to the project.

Conceptually, this is similar to the step we performed earlier in the lab exercise for CCSv3.3, though you’ll notice the new tcf file dialog is a bit different.

File → New → DSP/BIOS v5.x Configuration File

11. Name the file lab.tcf and locate it in the project’s folder.

You may need to Browse to select the project’s path. The project path may look like lab2h or /lab2h.

Once complete, click Next >

12. Specify a platform to build for:

You may remember that we needed to pick the appropriate TCF seed file in our CCSv3.3 project.

Similarly, in CCSv4, we’ll choose the platform we are building for, then the wizard will import that file (you can see the results if you look at the tcf file’s javascript code).

You need to pick the platform appropriate for your lab selection. Four platforms are shown here, the other two you might need to use include:

- C672x use: ti.platforms.padk6727
- C674x use: ti.platforms.evm6748

Select Next >
13. Deselect unnecessary BIOS components:

This last step of the .tcf wizard is not really that big of deal. It just gives you the opportunity to remove some components of DSP/BIOS if you’re not planning to use them.

In our case, we won’t be using these BIOS modules. You can easily enable (or disable) these modules later on by editing the .tcf file (either graphically or textually). In our case, this will just save us a small amount of additional code space.
Build … and try to Run

14. Build your program.

Since we are using the same code as earlier, we shouldn’t get any build errors.

15. Let’s try to debug our project. Click the Debug button.

This button should:
- **Start the debugger**
- **Connect to the target platform (simulator, in our case)**
- **Load the program**

But in this case, you should actually see it provide the following error dialog:

This error is telling us that we don’t have a Target board/simulator configured for your project. Remember back to CCSv3.3 when we had to run **CCS Setup** before we could use CCS? In that case, CCS Setup set the default target board for use with all CCS projects – if you wanted to change boards, you had to re-run **CCS Setup**.

In CCSv4, the target configuration is available on a per-project basis. Even more than that, you can actually have more than one target configuration, then switch between them, as needed.

CCSv4 uses a Target Configuration File (.ccxml) to specify a target board. They can be copied from project-to-project; referenced from a common location; or, you can specify a workspace default.

In our case, we’re going to create a new .ccxml file and add it to our project.
Create a Target Configuration File

16. Create a Target Configuration File (.ccxml).

If you clicked “Yes” to the previous dialog box, you’re all ready to create a new target configuration file.

On the other hand, if you clicked “No”, then you’ll need to start the New Target Configuration File wizard: File → New → Target Configuration File

However you get there, you should see the following file dialog:

We recommend you choose a meaningful name. In our case, we chose to call it:

\(<\text{CPU core name}>\_\text{Simulator.ccxml}\)

and place it into the lab folder (rather than a shared location). Again, this is one of those user style-choice decisions.

Click Finish when complete.

17. Edit the .ccxml file.

Once you finish the previous step, you’ll notice the .ccxml file is immediately opened for you to edit. Once again, it should look very similar to the CCS Setup dialog used for CCSv3.3.

**Note:** Please choose the same simulator you selected when configuring CCSv3.3.
Verify, Build … and Run

18. Verify your project files.
At this point, your project should look something like this. (Though, your .ccxml file may be named differently.)

19. Build your program again

Start the Debugger

20. Click the ‘bug’ again to start the debugger.
This time, you shouldn’t have any problems getting the debugger to run.

How do I know the debugger is running?
Look for two things:
1. The display should switch to the Debug perspective.

   Eclipse perspectives provide a way to organize windows, toolbars, etc. Two of the default perspectives are Debug and C/C++. (The latter is convenient for editing code.) Look up perspectives in the CCS (or Eclipse) help for more info.

2. The Debug window.

   The Debug window provides visibility to the target board; including a call stack of code running on the target.

   We recommend you explore the Debug toolbar. Find these icons, which we’ll be using:
   - Run
   - Halt
   - Terminate All
   - Step Into (and Assembly Step Into)
   - Restart
Verify, Build … and Run

**Breakpoint and Run**

21. Set a breakpoint at the end of main (as we did in the CCSv3.3 version of the lab).

22. Run to the breakpoint and check the result for $y$ – is it correct?

   You can check the result by hovering over $y$.
   Alternatively, you can add it to the *Watch* window.

| **Hint:** | If you haven’t used Eclipse before, you may be tempted to click the **RED** button to halt your code. Unfortunately, the RED button is for *Terminate All*. This will actually stop and close the debugger.

   If, on the other hand, your goal was to just halt the code so that you could examine a variable – or something along those lines – then you should click the **Yellow Halt** button. |

**Clock your code**

23. Restart your program (using the *Restart* toolbar command).

24. Enable the clock.

   Target → Clock → Enable

   You should see the clock appear in the bottom status bar, similar to the clock in CCSv3.3. While this clock has some additional capabilities, we’ll use it as we did in the earlier lab to simply count clock cycles. (And remember, double-click the clock to reset it to 0.)

25. Run again to the breakpoint and record the number of cycles.

   Debug Build Configuration: ___________________________________________________

**Profile your code**

26. Open the profile settings dialog.

   Tools → Profile → **Setup Profile Data Collection**

   - View Function Profile Results
   - View Code Coverage Results
   - View Data Structure Profiling Results

   Open Profile Data File…
   Process CodeGen Code Coverage
27. **Configure the profiler to:** Profile all Functions for CPU Cycles

   Just click the appropriate *checkbox* and then *Save*.

28. **Then we need to open the window to view the profiler’s results:**

   Tools → Profile → View Function Profile Results

29. **Restart the CPU, then Run.**

   When the breakpoint is reached, you should see the cycles displayed in the profiler results window.

   . Debug (cycles): _____________________________________________________________
Build Code for Release

30. Return to the Edit/Build mode to rebuild our code with the Release (optimized) options.
   The easiest way to do this is to Terminate the debug session. (Red button)

31. Switch the project to the Release configuration.

32. As previously, build, run, and profile (or clock) the code.

   **Hint:** If you click the Debug button, it should build a program (if necessary) and then start the debugger.

   **Note:** If you Terminate a debugging session, you will need to Re-Activate the profiler if you want to continue using it. Just open up the Profiler Settings dialog and click the Activate button.

33. What performance did you get for Release?
   - Release (cycles): ____________________________________________________________

34. Why isn’t the performance as good as we got with CCSv3.3?
   - __________________________________________________________
   - __________________________________________________________
Fix the Release Build Configuration

You may, or may not, have noticed that the default Release build configuration is not set optimally. Let’s correct this and re-benchmark our code.

35. Right-click on the project and select Build Properties.

36. Change the Debugging Model and Optimization Level options (as shown below).
   - What they were set to before making this change?  
     Debugging Model: ______________
     Optimization Level: ____________
37. You may also want to keep the generated assembly code (–k option).
   Hint: Look for the Assembly Options section under the C6000 Compiler.

38. Close the dialog and save the options.

Test Updated Release Build Config’s Performance

39. Re-build and re-profile the code.
   With the options set as we discussed in class, what is the performance … and how does it compare to our previous (CCSv3.3) results?
   
   . Release (cycles): ________________________________________________
   . How does it compare? ____________________________________________
   . ______________________________________________________________
Chapter 3 – Exam

You have approximately 10 minutes to complete the exam. Afterwards, the instructor will debrief each question while your neighbor grades your exam. Have fun!

- Exam is open mind, open book, open eyes. Sharing answers, cheating, asking the instructor questions, anything to get the highest grade possible is completely acceptable, encouraged, and expected.
- Good luck.

Student Name: ____________________________________________________________

1. Pipeline
   a. Name the three primary pipeline stages. ❑ (15 pts)

   ______________________________________________________________________
   ______________________________________________________________________
   ______________________________________________________________________
   ______________________________________________________________________
   ______________________________________________________________________
   ______________________________________________________________________

   b. Why did TI choose to make program fetches (PF pipeline stage) four cycles in length? ❑ (10 pts)

   ______________________________________________________________________
   ______________________________________________________________________
   ______________________________________________________________________
   ______________________________________________________________________
   ______________________________________________________________________

   c. Why are pipeline stages of a load (E1-E5) similar to the phases of a program fetch (PG-DP)? ❑ (10 pts)

   ______________________________________________________________________
   ______________________________________________________________________
   ______________________________________________________________________
   ______________________________________________________________________
2. Pipeline
What is a Fetch Packet (FP)? Execute Packet (EP)?

__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________

3. Insert the proper # NOPs in the following code:

```
start:   LDH .D1 *A0, A1
         MPY .M1 A1, A2, A3
         ADD .L1 A1, A2, A4
         LDB .D1 *A5, A6
         LDW .D1 *A7, A8
         MPY .M1 A6, A9, A10
         ADD .L1 A9, A10, A11
         B .S1 start
```
4. Coding

(20 pts) Add the contents of mem1 to A5.

\[
\begin{array}{|c|}
\hline
\text{x16 mem} \\
\hline
\text{mem1} & 10h \\
\hline
\hline
\text{A5} & 7h \\
\hline
\end{array}
\]

Grading your Exam

Scoring Chapter 3 Exam

Points Earned (Questions # 1 - 4): ______/100

Grade (circle one): 90-100 A  
80-89 B  
0-79 C  
(no one likes Ds or Fs!)
Lab Introduction

Lab2 used C to call and compute the dot product of two arrays. In this lab, you will use Lab2’s C setup and initialization but create a separate assembly routine (called from C) that solves the dot product algorithm:

\[ Y = \sum_{n=1}^{256} a(n) \times x(n) \]

In Chapter’s 6-8, you will use well-defined methods to optimize the dot-product routine to get to the 80 cycle loop benchmark discussed in Chapter 3. (We might not get that fast in this chapter, but we’ll learn how to do it in assembly.)

This project includes the following files:

- LAB4.PJT: copy from LAB2.PJT and rename
- MAIN.C: copy from LAB2 folder
- DOTP_ASM.ASM: dot-product routine created by you
- LAB.TCF: copy from LAB2 folder
- LABCFG.CMD: copy from LAB2 folder
- PROFILER.INI: copy from LAB2 folder
- DATA.H: provided for you
Creating the Project

1. Make sure that there are no open projects in Code Composer Studio. If there are, close them.

2. Using Windows Explorer, COPY the following files from C:\op6000\labs\lab2 to C:\op6000\labs\lab4. You can use several methods to perform the copy. We prefer the method where you select the files that you want to copy, select Copy (Ctrl + C) to copy them, then navigate to the destination and select Paste (Ctrl + V) to paste them. Please make sure to pick COPY.

   LAB2.PJT  
   MAIN.C  
   DATA.H  
   LAB.TCF  
   LABCFG.CMD  
   PROFILER.INI  

Note: Please make sure to COPY the above files correctly. We want to make sure that you can come back to any lab folder and find the files for that lab. If you are not careful, it is easy to move files around and rather than copying them. Make sure to copy the correct files from and to the correct place.

3. While still inside Windows Explorer, make sure that you are in the C:\op6000\labs\lab4 directory.

4. Use Windows Explorer to rename the C:\op6000\labs\lab4\lab2.pjt file to lab4.pjt by right clicking on it and choosing rename.

5. Now go over to Code Composer Studio (or open it up if you closed it) and open lab4.pjt.

   PROJECT → OPEN  

   Navigate to C:\op6000\labs\lab4 and double click on lab4.pjt.

6. Now that we've converted our project from Lab 2, let's create a new ASM file for the assembly dot-product routine. Create a new source file and save it to the Lab 4 subdirectory as dotp_asm.asm.

   FILE → NEW → SOURCE FILE  
   FILE → SAVE AS...  

7. Add dotp_asm.asm to your lab4.pjt:

   PROJECT → ADD FILES TO PROJECT...
8. The Project View in CCS should look something like this depending on your processor:

If it doesn't, double-check your work or ask the instructor for help.

**Edit Source Files**

9. Open `main.c` and comment out (or delete) the `dotp()` function.

10. We're going to need to use arguments passed to us from `main()` to solve the dot-product equation using assembly code. Fill in the blanks below with the registers that the compiler uses to pass/return arguments:

   - Use the three values “passed” by the function call: `a, x, count`

   
   ```
   y = dotp(a, x, COUNT);
   int dotp(short *m, short *n, int count)
   ```

<table>
<thead>
<tr>
<th>Input Variable</th>
<th>C Passes Input Argument in Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>m</td>
<td></td>
</tr>
<tr>
<td>n</td>
<td></td>
</tr>
<tr>
<td>count</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Function Return</th>
<th>Register Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return Value</td>
<td></td>
</tr>
<tr>
<td>Return Address</td>
<td></td>
</tr>
</tbody>
</table>
11. In `dotp_asm.asm`, write the assembly code to solve the dot-produce equation. If you'd like you can use the space below to write the code down before typing it into the computer.

```

```

---

**Build and Run**

12. Using the `Debug` build configuration, rebuild all files by clicking on.

13. Open the CPU Registers window. This makes it easier to debug assembly code. Especially helpful when you need to check the final answer in the next step.

   **View → Registers → Core Registers**

   -or- use the toolbar button

   The CPU Registers window is the easiest way to track register values.

   **Hint:** If you use the `Watch` window to view registers, you need to enter the register name with a capital letter; e.g. A5 (not a5).

14. Set a breakpoint on the closing brace of `main()` to stop the execution of the processor.

15. Verify correct operation.

   As before, the answer should still be **0x002b2b00** (2,829,056 decimal).
Benchmark ASM Code

The Clock

One way to benchmark ASM code, is to use the Profile Clock.

16. Reset the CPU or Restart the program, then go to main() if you are not taken there automatically.

17. Open the Profiling Clock so that you can benchmark the function.

   Profile → Clock → View

   You should now see the Clock down in the lower right-hand corner of CCS:

   ![Profile Clock](image)

   Double click on the icon to reset.

18. Run until you reach the breakpoint at the end of main().

19. How many cycles did dotp() require? ______________ cycles

20. How does this compare to the benchmark that we got for C code in Lab 2 using the Optimize configuration?

__________________________________________________________________________
__________________________________________________________________________
The Profile View

Another way to benchmark ASM code is to use the Profile View (along with Profile Setup) that we used back in Lab2.

21. Reset the CPU or Restart the program, then go to main() if you are not taken there automatically.

22. Open the Profile Setup window.

   Profile → Setup

23. Load the profiler configuration you saved previously.
   
   Use the Load Profiler Configuration button just to the left of the save button.

   ![Profile Setup window]

   PROFILER.INI was the name we suggested for saving the profiler configuration.

24. Make sure that the Enable/Disable Profiling button is turned on to enable profiling.

25. Open the Profile Viewer.

   Profile → Viewer

26. Run until you reach the breakpoint at the end of main().

27. Find the row for the function in dotp_asm.asm. You may have to scroll down to find this row.

   ![Profile Viewer table]

   Note: your numbers may vary slightly from those shown above.

   There should only be one entry for dotp_asm.asm:##:##$. The first number is the line number for the start of the range and the second number is for the end of the range that was profiled for the ASM function.

   How do these numbers compare with those that you obtained in step 19 using the Profile Clock?

___________________________________________________________________________
___________________________________________________________________________
28. Would it be nice to see a symbol associated with the assembly function so that it looks more like a C function in the profiler? This can be done by adding two new directives: .asmfunc and .endasmfunc to your ASM file like this:

```asm
.dotp .asmfunc

/* A6 = original counter value
 * B0 = working Y value
 * B4 = address of x
 */
.sect ".text" ; What section is this put
 ; so the linker can find

._dotp:

... zero B0 ; initialize y=0
 mv A6, A2 ; set up counter
 loop ldh *A4++, A0 ; put the value of a into
     ldh *B4++, A1 ; put the value of x into
     mpy A0, A1, A3 ; a * x --> product
     nop 4
     add A3, B0, B0 ; product + previous Y = Y
     sub A2,1,A2
     [A2] b loop ; repeat loop counter times
     nop 5

     mv B0, A4 ; store return value

     b B3 ; return to main
     nop 5

.endasmfunc
```

29. Using the Debug build configuration, rebuild all files by clicking on.

30. Reset the CPU or Restart the program, then go to main() if you are not taken there automatically.

31. Run until you reach the breakpoint at the end of main().
32. Take a look at the Profile Viewer. Notice that it lists the function with the dotp symbol instead of using the cryptic file reference.

The .asmfunc and .endasmfunc make the function “visible” to the profiler and allow you to assign a more meaningful name to an ASM function. If you’d like more information on these directives, please see the online help.
Command Window

Now that we've written and debugged some assembly code, let's explore how to use one of CCS's other features, the Command Window.

33. Open the Command Window.

**Tools → Command Window**

and execute the following commands by typing them into the Command Window.

- **restart** Restarts the processor
- **go dotp** Runs to the dotp label

34. Single-step into your routine. Using the CPU Registers window, observe that your “count” register is (or gets) set to 0x00000100 (256 decimal).

35. Set a breakpoint within your ASM dotp subroutine. Do this by double-clicking on the gray left-hand column next to a line in the subroutine. Alternatively, you can use the Command window. To demonstrate this, here’s a clip of our solution’s assembly code.

```
_dotp: 
  zero B0 ; initialize y=0
  mv A6, A2 ; set up counter in cond. reg
loop 
  ldh *A4++, A0 ; put the value of a into A0
  ldh *B4++, A1 ; put the value of x into A1
```

It’s easy to add a breakpoint using any label (with the ba command). In our case, the label “loop” is part of the loop (it’s the top of the loop).

```
ba loop
```

36. Run until the counter is equal to five. In the Command window, type the following and hit the Execute button.

```
run A2 > 5
```

**Note:** If you didn’t use A2 as your count register, replace A2 in the above command with the register you chose.

The run command is conditional. This run example says, “run while A2 > 5”. When running, every time the debugger hits a breakpoint it evaluates the expression. If still true, it automatically begins running again.

37. Save all of your work and close any open projects.

End of Lab 4 Exercise
Exercise Solutions

Mixing C and Assembly

Why Bother with Assembly?
- Total flexibility
- Understand how compiler works
- Understand how processor works

Calling Assembly from C

//Parent.C
int child(int, int);
int x = 7, y, w = 3;
void main (void)
{
    y = child(x, 5);
}

//Child.C
int child(int a, int b)
{
    return(a + b);
}

:Child.ASM
.global _child
_child:
    add a4,b4,a4
    bb 3
    nop 5
    ; end of subroutine

Accessing Global Variables from ASM

//Parent.C
int child2(int, int);
int x = 7, y, w = 3;
void main (void)
{
    y = child2(x, 5);
}

:Child2.ASM
.global _child2
.global _w
_child2:
    mvkl _w , A1
    mvkh _w , A1
    ldw *A1, A0

- Use _underscore when accessing C variables/labels
- Declare global labels
- Advantages of declaring variables in C?
  - Declaring in C is easier
  - Compiler does variable init ( int w = 3 )
Lab 5a – Writing Linear Assembly

Lab 5a introduces us to the easier method of programming with assembly mnemonics, Linear Assembly. This is a rather simple lab, but it allows us to quickly practice using the assembler directives required by the assembly optimizer.

Optional: Lab 5b gives you a chance to try calling one linear assembly routine from another. If you have time, try this optional exercise.

Overview

Similar to Chapter 4, our goal is to write the dot-product function. This time you don’t need to worry about delay-slots (hence, NOPs), functional units, register names, etc.

Essentially, you will use the same project file as in Chapter 4. Just replace the assembly dot-product with a linear-assembly dot-product.

<table>
<thead>
<tr>
<th>LAB5a.PJT</th>
<th>copy from LAB4.PJT</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOTP.SA</td>
<td>you create this</td>
</tr>
<tr>
<td>MAIN.C</td>
<td>copy from LAB4 folder</td>
</tr>
<tr>
<td>LAB.TCF</td>
<td>copy from LAB4 folder</td>
</tr>
<tr>
<td>LABCFG.CMD</td>
<td>copy from LAB4 folder</td>
</tr>
<tr>
<td>PROFILER.INI</td>
<td>copy from LAB4 folder</td>
</tr>
<tr>
<td>DATA.H</td>
<td>provided for you</td>
</tr>
</tbody>
</table>

Create Project

Note: If you did not complete the Optional Lab 4 exercise you should copy the above files from C:\op6000\solutions for (your selected processor)\lab4 to C:\op6000\labs\lab5a.

1. Using Windows Explorer, COPY the following files from C:\op6000\labs\lab4 to C:\op6000\labs\lab5a. Please make sure to COPY these files.

   LAB4.PJT
   MAIN.C
   LAB.TCF
   LABCFG.CMD
   PROFILER.INI

Note: Please make sure to copy the above files correctly. We want to make sure that you can come back to any lab folder and find the files for that lab. If you are not careful, it is easy to move files around instead of copying them. Please make sure to copy the correct files from and to the correct place.

2. While still inside Windows Explorer, make sure that you are in the C:\op6000\labs\lab5a directory.

3. Rename the C:\op6000\labs\lab5a\lab4.pjt file to lab5a.pjt.
4. Now go over to Code Composer Studio (or open it up if you closed it) and open lab5a.pjt.

   **PROJECT → OPEN**

   Navigate to C:\op6000\labs\lab5a and double click on lab5a.pjt.

5. We didn't copy the dotp_asm.asm file from Lab 4, but it is still listed in the project. Therefore, CCS cannot find the file in the project directory. You should receive an error that looks something like this:

   ![Error Message]

   Remove the file from the project by clicking on **Remove**.

6. Create a new source file and save it to the Lab5a subdirectory as dotp.sa.

   **FILE → NEW → SOURCE FILE**

   **FILE → SAVE AS…**

7. Add dotp.sa to your lab5a.pjt:

   **PROJECT → ADD FILES TO PROJECT…**

**Edit Source Files**

8. Make sure the dotp() function is still commented out or deleted from the main.c source file.

9. Add the following code to dotp.sa. (You can either type in the following code or cut-and-paste it from the supplied "dotp template.sa" file.)

   ```
   .global _dotp
   _dotp:
   zero y
   loop:
   ldh *ap++, a
   ldh *xp++, x
   mpy a, x, prod
   add prod, y, y
   sub cnt, 1, cnt
   [cnt] b loop
   ```

   Notice, this code is similar to the assembly code used in Chapter 4.
10. Well, you’ve created most of the linear assembly file. Did you already notice something is missing? Please add the required assembler directives. (Turn the page if you need a hint.)

You should also add these assembler directives:

```assembly
.cproc <arg>, <arg>, <arg>
.reg <arg>, <arg>, <arg>, <arg>
.return <arg>
.endproc
```

**Build, Run, and Profile (Debug)**

11. Build the project using the **Debug** options.

12. Verify that the code works.
   - Run to the end of `main()` and check your answer. What’s the value of `y`?
     
     \[ y = \] ______________

13. Reset or Restart the program, then go to `main()`.

14. Use one of the Profiling Methods, either the Profile Clock or the Profile Setup/Viewer, to benchmark the Linear Assembly `dotp` function.

15. Run until you reach the end of `main()`.

16. How many cycles did `dotp()` require? ______________ cycles

**Using Optimization**

Once you’ve verified that the code works, go back and reconfigure the options to enable optimization.

17. Rebuild your code with the **Release** configuration that we modified back in Lab 2.

18. Profile the **Release** configuration.
   
   \[ Dotp \text{ cycle count: } \] ______________
   
   \[ y = \] ______________
19. How does this compare with your previous results?

<table>
<thead>
<tr>
<th>Dot-product Version</th>
<th>Cycles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lab2 (Debug options)</td>
<td></td>
</tr>
<tr>
<td>Lab2 (Optimize options)</td>
<td></td>
</tr>
<tr>
<td>Lab4 (standard assembly)</td>
<td></td>
</tr>
<tr>
<td>Lab5a (step 16: Debug options)</td>
<td></td>
</tr>
<tr>
<td>Lab5a (step 18: Release options)</td>
<td></td>
</tr>
</tbody>
</table>

Did the compiler beat either standard or linear assembly code?
(We'll find out why in Chapter 7.)

**Viewing Memory**

There are many methods of looking at data in memory using CCS. Earlier we used the *Watch* and *Core CPU Registers* windows to view results. You can also open a *Memory* window to examine your system's memory.

20. Open a memory window to view array x[].

*View → Memory...*
The Open Property Window icon is used to display the properties for the memory window.

- Set the address to a. Notice, that CCS also displays the hex address.
- Track Expression, when not disabled, tells CCS that you want to continue to watch “a”, even if the symbol’s address changes on subsequent builds. Note: Normally do not check “disabled”.
- Select the 16-bit format using the drop down box, since our data is 16 bits wide.
21. Change Memory window’s format to 16-Bit Hex – C Style
   Use the drop-down selection list

22. What is the difference between the TI and C styles?
   _______________________________________________________________________
   Many users prefer the TI style since it takes up less space.

23. In the Memory window, what is the first value of x: 0x________________
    x[0] should equal 0x0100 (or 256 decimal).

24. Now, change the Memory window of x to display:
    8-bit Hex – TI Style

25. What are the first two values for x? 0x________ 0x________

26. If the 16 bit value is 0x0100, why does the first byte contain 0x00 and the second byte
    contain 0x10?
    _______________________________________________________________________

27. Go ahead and try a couple other formats, just to see how they appear:
    32-bit Hex – TI Style
    16-bit Unsigned Int

    By changing the format, are we in any way changing the actual values in memory? Why?
    _______________________________________________________________________
    When would you choose to use one format over the another? _________________________

28. Close the project.

Before going on, let your instructor know when you have reached this point.
Optional: Lab 5b - Calls in Linear Assembly

The goal is replace the main() C function with one written in Linear Assembly.

Files in Lab

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAB5b.PJT</td>
<td>copy from LAB5a.PJT</td>
</tr>
<tr>
<td>GLOBALS.C</td>
<td>create from MAIN.C</td>
</tr>
<tr>
<td>MAIN5b.SA</td>
<td>create from scratch</td>
</tr>
<tr>
<td>DOTP.SA</td>
<td>copy from Lab 5a folder</td>
</tr>
<tr>
<td>LAB.TCF</td>
<td>copy from Lab 5a folder</td>
</tr>
<tr>
<td>LABCFG.CMD</td>
<td>copy from Lab 5a folder</td>
</tr>
<tr>
<td>PROFILER.INI</td>
<td>copy from Lab 5a folder</td>
</tr>
</tbody>
</table>

Create Project

1. COPY the following files from C:\op6000\labs\lab5a to C:\op6000\labs\lab5b. Please make sure to COPY these files.

<table>
<thead>
<tr>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAB5a.PJT</td>
</tr>
<tr>
<td>MAIN.C</td>
</tr>
<tr>
<td>DOTP.SA</td>
</tr>
<tr>
<td>LAB.TCF</td>
</tr>
<tr>
<td>LABCFG.CMD</td>
</tr>
<tr>
<td>PROFILER.INI</td>
</tr>
</tbody>
</table>

2. While still inside Windows Explorer, make sure that you are in the C:\op6000\labs\lab5b directory.

3. Rename the C:\op6000\labs\lab5b\lab5a.pjt file to lab5b.pjt.

4. In CCS, open lab5b.pjt.

5. Open main.c and save it as globals.c.

   FILE → SAVE AS...

   We'll edit this file in the upcoming steps.

6. Remove main.c from the project.

7. Create a new source file and save it to the Lab5b subdirectory as main5b.sa.

8. Add globals.c and main5b.sa to your lab5b.pjt.

Edit Source Files

9. Modify globals.c by commenting out (or deleting) the function main().

   Don’t delete the global variable definitions, though.

10. What does our new linear assembly main function need to do?
### Hint:
Did you mention passing arguments in your answer above? If not, don't forget that this is an important step for calling `dotp()`. You might want to refer back to page 5-11 in your Student Notes to see how to do this.

11. Go ahead and type-in your new `main()` function into `main5b.sa`.

### Build and Run

12. Build the project for Debug -- without optimization.

#### Hint:
If you have trouble building your program with the linear assembly version of main(), here's a troubleshooting tip. The most common error is trying to pass C variables from the `main5b.sa` routine. For example you **cannot** use the following:

\[
\text{.call result = _dotp(a, x, count)}
\]

where `a`, `x`, and `count` are C variables. Remember that this is assembly code (albeit, easy assembly code). The `.call` statement requires *registers* as arguments (e.g. registers declared with `.reg`).

13. Reset and go to `main()`. Do you reach it? _________________________________________


15. **Save** all of your work and **close** any open projects.

**Congratulations!** You have called one linear assembly routine from another.
Lab 7

Using Linear Assembly, optimize your dot-product algorithm using WORD-WIDE optimization; that is, replace LDH with LDW and use both MPY and MPYH.

**Lab 7a:** (OPTIONAL) Optimize your dot-product routine using LDW in place of LDH (using Linear Assembly)

**7b.** Use LDDW's and the DOTP2 instruction

**7c.** (OPTIONAL) Try writing the LDW version of the dot-product using Standard Assembly (rather than Linear Asm)

**LAB7a.PJT**  
DOTP.SA  
MAIN.C  
LAB.TCF  
LABCFG.CMD  
PROFILER.INI  
DATA.H

**Note:** Please make sure to copy the above files correctly.

2. While still inside Windows Explorer, make sure that you are in the C:\op6000\labs\lab7a directory, then …
3. Rename the C:\op6000\labs\lab7\lab5a.pjt file to lab7a.pjt.

4. Now go over to Code Composer Studio (or open it up if you closed it) and open lab7a.pjt.

5. Open DOTP.SA and modify it to implement the LDW optimization; i.e. load two shorts (as words) and process them both per loop.

6. Rebuild (using Debug options) your project and verify proper operation.

7. Profile this new routine: ______________ cycles using Debug

8. Rebuild, Run, and Profile your code with the Release configuration.
   How fast is your LDW based routine with optimization turned on? ______________ cycles
   How does this compare with DOTP.SA from Lab 5a? How about Lab 4? ______________

9. What is the size of your DOTP.SA routine in Lab 7a? ________________

10. Close the project when completed.

   **If you still have time left, please move on to Lab 7b.**
Lab 7b

Once you’ve got the LDW version of the dot-product running, try implementing the algorithm on the ‘C64x or C64x+ using the DOTP2 instruction. Like Lab 5a, implement this lab in linear assembly.

Change to C64x Simulator

1. Since this is a ‘C64x based lab, we need to reconfigure the CCS setup. Launch CCS Setup:

   File → Launch Setup

2. When setup opens, the “Import Configuration” window appears. Follow the procedure found at the start of Lab 2. These are the basic steps:
   - Clear the previous system configuration (button on right).
   - Scroll through the list to find C64xx CPU Cycle Accurate Sim, Ltl Endian. Select this item and click Import
   - Quit and save CCS Setup. When asked, allow CCS Setup to restart CCS for you.

Create Project

3. Using Windows Explorer, COPY the following files from C:\op6000\labs\lab7a to C:\op6000\labs\lab7b. Please make sure to COPY these files.

   LAB7a.PJT
   MAIN.C
   DOTP.SA
   PROFILER.INI
   LAB.TCF  If you were doing 67xx labs don’t copy this file, we’ll create it.
   LABCFG.CMD  If you were doing 67xx labs don’t copy this file, we’ll create it.

4. Rename the LAB7a.PJT to LAB7b.PJT. Save it in the C:\op6000\labs\lab7b folder. You may need to remove the floating-point TCF and CMD files from the project when you first start CCS.

5. Create LAB.TCF file based on the ti.platforms.sim64xx.tci template.

   FILE → NEW → DSP/BIOS Configuration...

6. Choose the ti.platforms.sim64xx.tci template file.

7. Modify the RTDX Mode and Dynamic Memory Heaps (as you did for the C67.tcf file in Lab 2 – Step 9).

8. Save the new .tcf file as lab.tcf to the C:\op6000\labs\lab7b folder.

9. Open up the project build options and change the target processor by using the –mv6400 switch.

10. Select LAB.TCF in the Project Explorer window. Click on: Project → Compile File to create the linker command file.
11. If they are not already included, add the following files to your LAB7b.PJT project:
   LAB.TCF, LABCFG.CMD

12. Replace the MPY/MPYH instructions in DOTP.SA with DOTP2 instructions.
   
   ______________________ How many results are you calculating per loop when using DOTP2?

13. Build using Debug and validate your answer.

14. Use the Release configuration to rebuild and profile with optimization.

15. Rebuild with full optimization and benchmark your new routine: ________________ cycles.

   How does this compare with DOTP.SA from Lab 7a? ________________

16. How does it compare with earlier results?

   ___________________________________________________________.

17. Are these the results that you expected using DOTP2? Can you think of any other way to
    improve this benchmark? If so, give it a try.

   ___________________________________________________________.

18. Save all of your work and close any open projects.

19. When finished with Lab 7b, change the CCS setup back to the original floating-point
    simulator that you were using. Make sure you reset the CCS Environment Options as
    explained in Lab 2 so your program will automatically build and load.
Optional - Lab 7c

Try implementing the most optimized dotp procedure that you can in standard assembly (.ASM) rather than Linear Assembly (.SA). Remember, linear assembly uses special directives and labels that are not available to standard assembly. In standard assembly you must use registers, define memory setups, and include nops where necessary.

Procedure

1. Copy the following files from `C:\op6000\labs\lab7a` to `C:\op6000\labs\lab7c`. Please make sure to COPY these files.
   
   LAB7a.PJT  
   MAIN.C  
   LAB.TCF  
   LABCFG.CMD  
   PROFILER.INI  

2. Create the file **DOTP_ASM.ASM**.

3. Open **LAB7C.PJT** and remove any files that CCS complains about.

4. Add the **DOTP_ASM.ASM** file to your **LAB7c.PJT** project.

5. Edit **DOTP_ASM.ASM** to implement the optimizations that you feel will give you the most optimized code.

6. Rebuild using **Debug** and validate your answer.

7. Benchmark your routine and fill in the following table.

<table>
<thead>
<tr>
<th>Dot-product Version</th>
<th>Cycles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lab 4</td>
<td></td>
</tr>
<tr>
<td>(standard assembly, LDH)</td>
<td></td>
</tr>
<tr>
<td>Lab 7a</td>
<td></td>
</tr>
<tr>
<td>(linear assembly, using LDW)</td>
<td></td>
</tr>
<tr>
<td>Lab 7b</td>
<td></td>
</tr>
<tr>
<td>(linear assembly, using DOTP2)</td>
<td></td>
</tr>
<tr>
<td>Lab 7c</td>
<td></td>
</tr>
<tr>
<td>(standard assembly, LDW)</td>
<td></td>
</tr>
</tbody>
</table>

8. Which method seems to give you the best results? Why?

9. Save all of your work and close any open projects.
Page left intentionally blank.
Lab 9

There are three different groups of instructions for Lab 9a and Lab 9b depending on your choice of processor. You will find directions for navigating through these groups of instructions on the following page.

Lab 9a investigates the effects of Alias Disambiguation, Balancing Resources on the A and B sides of the processor, and Packed Data Optimization.

Lab 9b looks at the benefit of performing Program Level Optimization.

Lab 9c provides an opportunity to use the Compiler Consultant. This lab is based on a tutorial included in the Help section of Code Composer Studio. The tutorial requires using the C64x processor so it will be necessary to switch to it for this lab.
C64x
Lab9a: Go to page 9 - 4
Lab9b: Go to page 9 - 15
Lab9c: Go to page 9 - 61

C64xp
Lab9a: Go to page 9 - 18
Lab9b: Go to page 9 - 29
Lab9c: Go to page 9 - 61

C67
Lab9a: Go to page 9 - 32
Lab9b: Go to page 9 - 43
Lab9c: Go to page 9 - 61
C672x

Lab9a: Go to page 9 - 46
Lab9b: Go to page 9 - 57
Lab9c: Go to page 9 - 61
Lab 9a for 'C64x

We're going to explore using other pragmas and tools that we discussed in this chapter to maximize the efficiency of some more C code.

Save a Copy of Lab9a

Before we get started, we want to save a copy of the files that we will be working with. We want you to do this, so that you know that we aren't trying to do anything "tricky".

1. Use Windows Explorer to copy C:\op6000\labs\lab9a folder to C:\op6000\labs\lab9b.

Load Project and Set Compiler Options

2. If Code Composer Studio is not already running, start it.

3. Open the lab9a64 project found in folder C:\op6000\labs\lab9a\lab9a64.pjt.

4. Expand this project and make sure it contains the following files:
   - wvs.c
   - main.c
   - lnk.cmd
   - C:\CCStudio\c6000\cgtools\lib\rts6400.lib

5. Make sure the Build Configuration is set to Debug.

6. Build, load, & run your program to main (go main if not taken there automatically).
Set up Profiler

7. Open the Profile Setup window and click on the Custom tab at the bottom of the window. The Custom tab allows you to configure exactly what simulation events are captured by the profiler.

8. Click on the plus sign next to the cycle entry.

9. Click the box next to the CPU entry under cycle.
The cycle:CPU event counts the number of cycles executed by the CPU while ignoring memory and cache effects.

10. Click on the Enable/Disable All Functions icon in the Profile Setup window to enable the profiling of all functions.

11. Enable profiling by clicking on the icon.
12. Open the Profile Viewer.
   
   Profile → Viewer

13. Run the code.
14. Record the Incl Total (Cycle Count) for the \texttt{wvs} function for Lab9a in the table on p. 9-17 under “No Optimization”.

\begin{center}
\begin{tabular}{|c|c|c|c|c|c|c|c|}
\hline
Address Range & Symbol Name & SLR & Symbol Type & Access Count & cycle:CPU: Incl. Total & cycle:CPU: Excl. Total \\
\hline
0x4000-0x419c & \texttt{wvs} & 11-23 & \texttt{wvs.c} & function & 1 & 2990 & 590 \\
\hline
\end{tabular}
\end{center}

\textbf{Optimizing the Code}

15. Open the \texttt{wvs.c} file. This C code is a vector summation of two weighted vectors. We will be using this code throughout this lab.
16. Change the Build Configuration to \textit{Release}.
17. Rebuild the code.
18. Run the code. Record the number of cycles from the Profile Viewer in the table on page 9-17.
19. Open the \texttt{wvs.asm} file in the \texttt{C:/op6000/labs/lab9a/Release_64} directory.

This file is available because of the \texttt{-k} compiler option we set.

The .asm file contains software pipeline information. Scroll down through this file and find the Software Pipeline Information Comments. Do you see “Searching for a software pipeline schedule at \ldots \texttt{ii = 11}?"

\(\texttt{ii=11}\) stands for iteration interval equals 11. This implies that each iteration of the loop takes eleven cycles, or that there are eleven cycles per loop iteration.

\textbf{Record the number of "Cycles per Iteration" for \textit{Optimize} in the table on page 9-17.}

With 8 resources available every cycle on such a small loop, we would expect this loop to do better than this.

\textbf{Q. Why did the loop start searching for a software pipeline at \texttt{ii=11} (for an 11 cycle loop)?}

\textbf{A.} Because 3 pointers are used in this function (\texttt{xptr}, \texttt{yptr}, \& \texttt{zptr}). If all the pointers point to a different location in memory, there is no dependency. However since all three pointers are passed into lab9a, there is no way for the compiler to be sure they don’t alias, or point to the same location. This is a memory alias disambiguation problem. The compiler must be conservative to guarantee correct execution. Unfortunately, the requirement for the compiler to be conservative can have dire effects on the performance of your code.

We know from looking at the calling function in main, that in fact, these pointers all point to separate arrays in memory. However, from the compiler’s local view of lab9a, this information is not available.

\textbf{Q. How can you pass more information to the compiler to improve its performance?}
Solving Alias Disambiguation Problems

A special option in the compiler, -mt, tells the compiler to ignore alias disambiguation problems like the one described at the beginning of this lab. Try using this option to rebuild the original lab and look at the results.

20. Turn on the –mt compiler option.

   Project → Build Options → Compiler tab → Advanced Category.

   Pull down Aliasing menu and select No Bad Alias Code (-mt) and then press OK.

21. Rebuild, Reload, & Go Main.

22. Hide the Build window.

23. Run the code.

24. Record the Incl Total (Cycle Count) of wvs( ) in the table on p. 9-17 under “–mt options”.
25. **Record the number of "Cycles per Iteration" for Release in the table on page 9-17 under "-mt options".**

   Open the `wvs.asm` file. Under the Global File Parameters, the following line implies that –mt was used:
   
   ```
   ;* Memory Aliases : Presume not aliases (optimistic)
   ```
   
   The compiler now knows that there aren't supposed to be any aliases in this project. What if some functions had aliases and others didn't? We need something that is a little more specific.

**Adding a Restrict Qualifier**

26. Open the Build Options for the `Release` configuration and remove the –mt option.

27. Now open the `wvs.c` file.

   Because we know that xptr & yptr are actually separate arrays in memory from w_sum, we can declare that nothing else points to these objects. To do this, we must add a restrict type qualifier.

   Modify the function definition to be as follows:
   
   ```c
   void wvs(short * restrict xptr, short * restrict yptr, short *zptr, short *w_sum, int N)
   ```
   
   Save and close `wvs.c`.

28. We must also modify `main.c` to reflect this function definition. Open `main.c` and change the external statement to read:

   ```c
   extern void wvs(short * restrict, short * restrict, short *, short *, int);
   ```

   Save and close `main.c`.

29. Rebuild, Reload, & Go Main.

30. Run the code.

31. Record the Incl Total (Cycle Count) of lab9a in the table on p. 9-17 under “Restrict Qualifier”.

32. Open `wvs.asm` and scroll down to the Software Pipeline Information.

   **Q.** How many cycles is the Software Pipelined Loop now? ________________

   Now the loop carried dependency bound is zero. By simply passing more information to the compiler, we allowed it to improve an 11-cycle loop to a 2-cycle loop.

   Record the number of cycles per iteration in the table on page 9-17.
33. Scroll down to the Software Pipeline Information until you see

```c
;* Loop Carried Dependency Bound (^) : 0
;* ii = 2 Schedule found with 6 iterations in parallel
```

This indicates that a 2-cycle loop was found, which is similar to using the -mt compiler option. However, the `restrict` keyword is function specific and gives the user more control.

**Q.** How can we optimize our code more?

**Balance the Resources**

34. Let’s analyze the feedback to determine what improvements could be made. Open `wvs.asm`.

Scroll down to the Software Pipeline Information. The first iteration interval (ii) attempted was two cycles because the Partitioned Resource Bound is two. We can see the reason for this if we look below at the .D unit and the .T address paths. This loop requires two loads (from `xptr` and `y.ptr`) and one store (to `w_sum`) for each iteration of the loop.

Each memory access requires a .D unit for address calculation, and a .T address path to send the address out to memory. Because the C6000 has two .D units and two .T address paths available on any given cycle (A side and B side), the compiler must partition at least two of the operations on one side (the A side). That means that these operations are the bottleneck in resources (highlighted with an *) and are the limiting factor in the Partitioned Resource Bound. The feedback in `wvs.asm` shows that there is an imbalance in resources between A and B side due, in this case, to an odd number of operations being mapped to two sides of the machine.

**Q.** Is it possible to improve the balance of resources?

**A.** One way to balance an odd number of operations is to unroll the loop. Now, instead of three memory accesses, you will have six, which is an even number. You can only do this if you know that the loop counter is a multiple of two; otherwise, you will incorrectly execute too few or too many iterations. In main, `LOOPCOUNT` is defined to be 40, which is a multiple of two, so you are able to unroll the loop.

**Q.** Why did the compiler not unroll the loop?

**A.** In the limited scope of `wvs.c`, the loop counter is passed as a parameter to the function. Therefore, it might be any value from this limited view of the function. To improve this scope you must pass more information to the compiler. One way of doing this is with a `MUST_ITERATE` pragma.
35. Open wvs.c and insert a MUST_ITERATE pragma above the for loop that says the loop always iterates in multiples of 4s but always iterates at least 40 times. It should look like this:

```
#pragma MUST_ITERATE (40, , 4);
```

Unrolling a loop can incur some minor overhead in loop setup. The compiler does not unroll loops with small loop counts because unrolling may not reduce the overall cycle count. If the compiler does not know what the minimum value of the loop counter is, it will not automatically unroll the loop. Again, this is information the compiler needs but does not have in the local scope of wvs.c. You know that LOOPCOUNT is set to 40, so you can tell the compiler that N is greater than some minimum value. The MUST_ITERATE pragma passes these two valuable pieces of information.

36. Save & close wvs.c. Close any open files. Leave the Profile Viewer open.

37. Rebuild, Reload, & Go Main.

38. Run the code.

39. Record the Incl Total (Cycle Count) of wvs() in the table on p. 9-17 under “MUST_ITERATE”.

Remember, no code was altered in this lab. Only additional information was passed via the MUST_ITERATE pragma. We simply guarantee the compiler that the trip count (in this case the trip count is N) is a multiple of four and that the trip count is greater than or equal to 40. The first argument for MUST_ITERATE is the minimum number of times the loop will iterate. The second argument is the maximum number of times the loop will iterate. The trip count must be evenly divisible by the third argument, the factor.

**Note:** Choose a trip count large enough to tell the compiler that it is more efficient to unroll the loop. Always specify the largest minimum trip count that is safe.
Open the *wvs.asm* file. Notice the following things in the Software Pipeline information feedback:

**Loop Unroll Multiple: 4x**
This loop has been unrolled by a factor of four.

**ii=5 Schedule found with 3 iterations in parallel**
You can tell by looking at the .D units and .T address paths that this 5-cycle loop comes after the loop has been unrolled because the resources show a total of six memory accesses. Therefore, our new effective loop iteration interval is 5/4 or 1.25 cycles. The "3 iterations in parallel" means that the loop is working on 3 different results at the same time. This doesn't have any bearing on our performance.

**Minimum Safe Trip Count: 2 (after unrolling)**
This is because we specify the count of the original loop to be greater than or equal to forty and a multiple of four and after unrolling, the loop count has to be even.

Therefore, by passing information without modifying the loop code, compiler performance improves from a 11-cycle loop to 2 cycles and now to 1.25 cycles.

Record the number of cycles per iteration in the table on page 9-17.

Q. Is this the lower limit?
**Packed Data Optimization Increases Memory Bandwidth**

The last optimization produced a 5-cycle loop that performed 4 iterations of the original vector sum of two weighted vectors. This means that each iteration of our loop now performs eight memory accesses, eight multiplies, four adds, four shift operations, a decrement for the loop counter, and a branch. You can see this in the feedback of `wvs.c`.

40. Open `wvs.asm`.

The six memory accesses appear as .D and .T units. The four multiplies appear as .M units. The two shifts and the branch show up as .s units. The decrement and the two adds appear as .LSD units.

By analyzing this part of the feedback, we can see that resources are most limited by the memory accesses; hence, the reason for an asterisk highlighting the .D units and .T address paths.

**Q.** Does this mean that we cannot make the loop operate any faster?

**A.** Further insight into the ‘C6000 architecture is necessary here.

The C62x fixed-point device loads and/or stores 32 bits every cycle. In addition, the C67x floating-point and the C64x fixed-point device loads two 64-bit values each cycle. In our example, we load four 16-bit values and store two 16-bit values every five cycles. This means we only use 16 bits of memory access every cycle. Because this is a resource bottleneck in our loop, increasing the memory access bandwidth further improves the performance of our loop.

In the unrolled loop generated from the MUST_ITERATE pragma, we load four consecutive 16-bit elements with LDNDWs from both the xptr and yptr array.

**Q.** Why not use an aligned LDDW to load one 64-bit element, with the resulting register pair load containing the first element in one-half of the lower 32-bit register and the second element in the other half and the third and fourth in the other register?

**A.** This is called Packed Data optimization. Four 16-bit loads are effectively performed by one single 64-bit load instruction.

**Q.** Why didn’t the compiler do this automatically in the MUST_ITERATE code?

**A.** Again, the answer lies in the amount of information the compiler has access to from the local scope of the program.

In order to perform a LDDW (64-bit load) on the C64x cores, the address must be aligned to a double word-address; otherwise, incorrect data would be loaded. An address is double word-aligned if the lower three bits of the address are zero. Unfortunately, in our example, the `wvs()` function does not have knowledge as to the xptr and yptr address values. Therefore, the compiler is forced to be conservative and assume that these pointers might not be aligned. Once again, we can pass more information to the compiler, this time via the `_nassert` statement.
41. Open \textit{wvs.c}. Add the following piece of code on the first line:

\begin{verbatim}
#define DWORD_ALIGNED(x) (_nassert((int) (x) & 0x7) == 0))
\end{verbatim}

Also add DWORD_ALIGNED definitions for \texttt{xptr} \& \texttt{yptr} after the short \texttt{w1,w2;} statement.

\begin{verbatim}
DWORD_ALIGNED(xptr);
DWORD_ALIGNED(yptr);
\end{verbatim}

By asserting that \texttt{xptr} and \texttt{yptr} addresses “anded” with 0x7 are equal to zero, the compiler knows that they are double word aligned. This means the compiler can perform LDDW and packed data optimization on these memory accesses.

\textbf{Hint:} If you need would like a refresher on how \texttt{DATA\_ALIGN} and \_nassert() are working together to produce optimal code, refer back to the material on page 9-19 of the Student Notes.

42. Save and close \textit{wvs.c}.

43. Rebuild, Reload, \& Go Main.

44. Run the code.

45. Record the Incl Total (Cycle Count) of \texttt{wvs()} in the table on p. 9-17 under “_nassert (double word-aligned)”.

46. Open \textit{wvs.asm}.

Success! The compiler has fully optimized this loop. You can now achieve 4 iterations of the loop every three cycles for .75 cycle per iteration throughout.

The .D and .T resources now show 3 (two LDDWs and four STHs for four iterations of the loop).

47. Close \textit{lab9a64.pjt} and any files associated with it.

\textit{Move on to Lab9b for the ‘C64x}
Lab9b for 'C64x

Program Level Optimization

Now we have learned how to pass information to the compiler. This increased the amount of information visible to the compiler from the local scope of each function.

Q. Is this necessary in all cases?

A. No, not in all cases. First, if this information already resides locally inside the function, the compiler has visibility here and restrict and MUST_ITERATE statements are not usually necessary. For example, if xptr and yptr are declared as local arrays, the compiler does not assume a dependency with w_sum. If the loop count is defined in the function or if the loop is simply described to be from one to forty, the MUST_ITERATE pragma is not necessary.

Second, even if this type of information is not declared locally, the compiler can still have access to it in an automated way by giving it a program level view.

The C6000 compiler provides two valuable switches, which enable program level optimization: -pm and -op2. When these two options are used together, the compiler can automatically extract all of the information we passed in Lab9a.

1. Make sure that all files from lab9a are closed.

2. We are now going to use the copy of the Lab 9a files that you made at the beginning of that lab. Navigate to the C:\op6000\labs\lab9b folder.

3. Rename the C:\op6000\labs\lab9b\lab9a64.pjt to C:\op6000\labs\lab9b\lab9b64.pjt.

4. Open the lab9b64.pjt file.

5. Change to the Release configuration.
6. To tell the compiler to use program level optimization (–pm and –op2), enter the following:

   Project → Build Options → Compiler tab → Basic Category

   Open Program Level Optimization drop-down menu.
   Select No External Func/Var Refs. Press OK.

   ![Build Options for lab9b64.pjt (Release)](image)

   This adds –pm and –op2 to the command line.

7. Rebuild, Reload, & Go Main.

8. If the Profile Viewer closed with lab9a64.pjt, reopen it.
   Profile → Viewer

9. Run the code.

10. Record the Incl Total (Cycle Count) of wvs( ) in the table on page 9-17 under “Program Level Opt (–pm & –op2)”.

11. Now try to open \textit{wvs.asm} to get the Cycles per Iteration. Can you find the file where it should be? ______________________________________

\textbf{Note:} Remember that –pm combines all of your files into one file before compiling. Therefore there is not a \textit{wvs.asm} file.

12. Open \textit{main.asm} in the \texttt{C:\op6000\labs\lab9b\Release_64} directory and find the \textit{wvs()} function. Use the Software Pipelined Information embedded in the file to record the "Cycles per Iteration" under Program Level Opt.

13. Compare the improvements in the following table:

\begin{center}
\begin{tabular}{|l|l|l|}
\hline
\textbf{Optimization Method} & \textbf{Incl Tot/Cycle Count} & \textbf{Cycles per Iteration} \\
\hline
No Optimization & & N/A \\
Release & & \\
-mt option & & \\
Restrict Qualifier & & \\
MUST\_ITERATE & & \\
_nassert (double word-aligned) & & \\
Program Level Opt (-pm & -op2) & & \\
\hline
\end{tabular}
\end{center}

14. \textbf{Save} your work and \textbf{close} the Lab 9b project.

\textit{End of Lab9b for 'C64x, move on to Lab9c on page 9 - 61}
Lab 9a for 'C64x+

We're going to explore using other pragmas and tools that we discussed in this chapter to maximize the efficiency of some more C code.

Save a Copy of Lab9a

Before we get started, we want to save a copy of the files that we will be working with. We want you to do this, so that you know that we aren't trying to do anything "tricky".

1. Use Windows Explorer to copy C:\op6000\labs\lab9a folder to C:\op6000\labs\lab9b.

Load Project and Set Compiler Options

2. If Code Composer Studio is not already running, start it.

3. Open the lab9a64p project found in folder C:\op6000\labs\lab9a\lab9a64p.pjt.

4. Expand this project and make sure it contains the following files:
   - wvs.c
   - main.c
   - lnk.cmd
   - C:\CCStudio\c6000\cgtools\lib\rts64plus.lib

5. Make sure the Build Configuration is set to Debug.

6. Build, load, & run your program to main (go main if not taken there automatically).
**Set up Profiler**

7. Open the Profile Setup window and click on the *Custom* tab at the bottom of the window. The Custom tab allows you to configure exactly what simulation events are captured by the profiler.

8. Click on the plus sign next to the cycle entry.

9. Click the box next to the CPU entry under cycle.
The cycle:CPU event counts the number of cycles executed by the CPU while ignoring memory and cache effects.

10. Click on the Enable/Disable All Functions icon in the Profile Setup window to enable the profiling of all functions.

11. Enable profiling by clicking on the icon.

12. Open the Profile Viewer.

Profile → Viewer

13. Run the code.

14. Record the Incl Total (Cycle Count) for the \textit{wvs} function for Lab9a in the table on p. 9-31 under “No Optimization”.

\textbf{Optimizing the Code}

15. Open the \textit{wvs.c} file. This C code is a vector summation of two weighted vectors. We will be using this code throughout this lab.

16. Change the Build Configuration to \textit{Release}.

17. Rebuild the code.

18. Run the code. Record the number of cycles from the Profile Viewer in the table on page 9-31.
19. Open the \texttt{wvs.asm} file in the \texttt{C:\op6000\labs\lab9a\Release_64p} directory.

This file is available because of the \texttt{-k} compiler option we set.

The .asm file contains software pipeline information. Scroll down through this file and find the Software Pipeline Information Comments. Do you see “Searching for a software pipeline schedule at \ldots \texttt{ii = 11}”?

\texttt{ii=11} stands for iteration interval equals 11. This implies that each iteration of the loop takes eleven cycles, or that there are eleven cycles per loop iteration.

\textbf{Record the number of "Cycles per Iteration" for \textit{Optimize} in the table on page 9-31.}

With 8 resources available every cycle on such a small loop, we would expect this loop to do better than this.

\textbf{Q.} Why did the loop start searching for a software pipeline at \texttt{ii=11} (for an 11 cycle loop)?

\textbf{A.} Because 3 pointers are used in this function (xptr, yptr, & zptr). If all the pointers point to a different location in memory, there is no dependency. However since all three pointers are passed into lab9a, there is no way for the compiler to be sure they don’t alias, or point to the same location. This is a memory alias disambiguation problem. The compiler must be conservative to guarantee correct execution. Unfortunately, the requirement for the compiler to be conservative can have dire effects on the performance of your code.

We know from looking at the calling function in main, that in fact, these pointers all point to separate arrays in memory. However, from the compiler’s local view of lab9a, this information is not available.

\textbf{Q.} How can you pass more information to the compiler to improve its performance?
Solving Alias Disambiguation Problems

A special option in the compiler, -mt, tells the compiler to ignore alias disambiguation problems like the one described at the beginning of this lab. Try using this option to rebuild the original lab and look at the results.

20. Turn on the **–mt** compiler option.

   **Project → Build Options → Compiler tab → Advanced Category.**

   Pull down *Aliasing* menu and select *No Bad Alias Code (-mt)* and then press OK.

21. Rebuild, Reload, & Go Main.

22. Hide the Build window.

23. Run the code.

24. Record the Incl Total (Cycle Count) of wvs( ) in the table on p. 9-31 under **“–mt options”**.
25. Record the number of "Cycles per Iteration" for Release in the table on page 9-31 under "-mt options".

Open the wvs.asm file. Under the Global File Parameters, the following line implies that –mt was used:

; * Memory Aliases : Presume not aliases (optimistic)

The compiler now knows that there aren't supposed to be any aliases in this project. What if some functions had aliases and others didn't? We need something that is a little more specific.

**Adding a Restrict Qualifier**

26. Open the Build Options for the Release configuration and remove the –mt option.

27. Now open the wvs.c file.

Because we know that xptr & yptr are actually separate arrays in memory from w_sum, we can declare that nothing else points to these objects. To do this, we must add a restrict type qualifier.

Modify the function definition to be as follows:

```c
void wvs(short * restrict xptr, short * restrict yptr, short *zptr, short *w_sum, int N)
```

Save and close wvs.c.

28. We must also modify main.c to reflect this function definition. Open main.c and change the external statement to read:

```c
extern void wvs(short * restrict, short * restrict, short *, short *, int);
```

Save and close main.c.

29. Rebuild, Reload, & Go Main.

30. Run the code.

31. Record the Incl Total (Cycle Count) of lab9a in the table on p. 9-31 under “Restrict Qualifier”.

32. Open wvs.asm and scroll down to the Software Pipeline Information.

**Q.** How many cycles is the Software Pipelined Loop now? ________________

Now the loop carried dependency bound is zero. By simply passing more information to the compiler, we allowed it to improve an 11-cycle loop to a 2-cycle loop.

Record the number of cycles per iteration in the table on page 9-31.
33. Scroll down to the Software Pipeline Information until you see

```c
/* Loop Carried Dependency Bound (^) : 0

: * ii = 2 Schedule found with 6 iterations in parallel
```

This indicates that a 2-cycle loop was found, which is similar to using the -mt compiler option. However, the `restrict` keyword is function specific and gives the user more control.

Q. How can we optimize our code more?

**Balance the Resources**

34. Let’s analyze the feedback to determine what improvements could be made. Open `wvs.asm`.

Scroll down to the Software Pipeline Information. The first iteration interval (ii) attempted was two cycles because the Partitioned Resource Bound is two. We can see the reason for this if we look below at the .D unit and the .T address paths. This loop requires two loads (from xptr an yptr) and one store (to w_sum) for each iteration of the loop.

Each memory access requires a .D unit for address calculation, and a .T address path to send the address out to memory. Because the C6000 has two .D units and two .T address paths available on any given cycle (A side and B side), the compiler must partition at least two of the operations on one side (the A side). That means that these operations are the bottleneck in resources (highlighted with an *) and are the limiting factor in the Partitioned Resource Bound. The feedback in `wvs.asm` shows that there is an imbalance in resources between A and B side due, in this case, to an odd number of operations being mapped to two sides of the machine.

Q. Is it possible to improve the balance of resources?

A. One way to balance an odd number of operations is to unroll the loop. Now, instead of three memory accesses, you will have six, which is an even number. You can only do this if you know that the loop counter is a multiple of two; otherwise, you will incorrectly execute too few or too many iterations. In main, LOOPCOUNT is defined to be 40, which is a multiple of two, so you are able to unroll the loop.

Q. Why did the compiler not unroll the loop?

A. In the limited scope of `wvs.c`, the loop counter is passed as a parameter to the function. Therefore, it might be any value from this limited view of the function. To improve this scope you must pass more information to the compiler. One way of doing this is with a MUST_ITERATE pragma.
35. Open \texttt{wvs.c} and insert a MUST ITERATE pragma above the for loop that says the loop always iterates in multiples of 4s but always iterates at least 40 times. It should look like this:

\begin{verbatim}
#pragma MUST_ITERATE (40, , 4);
\end{verbatim}

Unrolling a loop can incur some minor overhead in loop setup. The compiler does not unroll loops with small loop counts because unrolling may not reduce the overall cycle count. If the compiler does not know what the minimum value of the loop counter is, it will not automatically unroll the loop. Again, this is information the compiler needs but does not have in the local scope of \texttt{wvs.c}. You know that LOOPCOUNT is set to 40, so you can tell the compiler that \( N \) is greater than some minimum value. The MUST ITERATE pragma passes these two valuable pieces of information.

36. Save & close \texttt{wvs.c}. Close any open files. Leave the Profile Viewer open.

37. Rebuild, Reload, & Go Main.

38. Run the code.

39. Record the Incl Total (Cycle Count) of \texttt{wvs()} in the table on p. 9-31 under “MUST ITERATE”.

Remember, no code was altered in this lab. Only additional information was passed via the MUST ITERATE pragma. We simply guarantee the compiler that the trip count (in this case the trip count is \( N \)) is a multiple of four and that the trip count is greater than or equal to 40. The first argument for MUST ITERATE is the minimum number of times the loop will iterate. The second argument is the maximum number of times the loop will iterate. The trip count must be evenly divisible by the third argument, the factor.

\textbf{Note:} Choose a trip count large enough to tell the compiler that it is more efficient to unroll the loop. Always specify the largest minimum trip count that is safe.
Open the *wvs.asm* file. Notice the following things in the Software Pipeline information feedback:

**Loop Unroll Multiple: 4x**
This loop has been unrolled by a factor of four.

**ii=5 Schedule found with 3 iterations in parallel**
You can tell by looking at the .D units and .T address paths that this 5-cycle loop comes after the loop has been unrolled because the resources show a total of six memory accesses. Therefore, our new effective loop iteration interval is $5/4$ or 1.25 cycles. The "3 iterations in parallel" means that the loop is working on 3 different results at the same time. This doesn't have any bearing on our performance.

**Minimum Safe Trip Count: 2 (after unrolling)**
This is because we specify the count of the original loop to be greater than or equal to forty and a multiple of four and after unrolling, the loop count has to be even.

Therefore, by passing information without modifying the loop code, compiler performance improves from a 11-cycle loop to 2 cycles and now to 1.25 cycles.

Record the number of cycles per iteration in the table on page 9-31.

Q. Is this the lower limit?
Packed Data Optimization Increases Memory Bandwidth

The last optimization produced a 5-cycle loop that performed 4 iterations of the original vector sum of two weighted vectors. This means that each iteration of our loop now performs eight memory accesses, eight multiplies, four adds, four shift operations, a decrement for the loop counter, and a branch. You can see this in the feedback of \textit{wvs.c}.

40. Open \textit{wvs.asm}.

The six memory accesses appear as .D and .T units. The four multiplies appear as .M units. The two shifts and the branch show up as .s units. The decrement and the two adds appear as .LSD units.

By analyzing this part of the feedback, we can see that resources are most limited by the memory accesses; hence, the reason for an asterisk highlighting the .D units and .T address paths.

Q. Does this mean that we cannot make the loop operate any faster?

A. Further insight into the ‘C6000 architecture is necessary here.

The C62x fixed-point device loads and/or stores 32 bits every cycle. In addition, the C67x floating-point and the C64x fixed-point device loads two 64-bit values each cycle. In our example, we load four 16-bit values and store two 16-bit values every five cycles. This means we only use 16 bits of memory access every cycle. Because this is a resource bottleneck in our loop, increasing the memory access bandwidth further improves the performance of our loop.

In the unrolled loop generated from the MUST_ITERATE pragma, we load four consecutive 16-bit elements with LDNDWs from both the xptr and yptr array.

Q. Why not use an aligned LDDW to load one 64-bit element, with the resulting register pair load containing the first element in one-half of the lower 32-bit register and the second element in the other half and the third and fourth in the other register?

A. This is called Packed Data optimization. Four 16-bit loads are effectively performed by one single 64-bit load instruction.

Q. Why didn’t the compiler do this automatically in the MUST_ITERATE code?

A. Again, the answer lies in the amount of information the compiler has access to from the local scope of the program.

In order to perform a LDDW (64-bit load) on the C64x cores, the address must be aligned to a double word-address; otherwise, incorrect data would be loaded. An address is double word-aligned if the lower three bits of the address are zero. Unfortunately, in our example, the \textit{wvs()} function does not have knowledge as to the xptr and yptr address values. Therefore, the compiler is forced to be conservative and assume that these pointers might not be aligned. Once again, we can pass more information to the compiler, this time via the _nassert statement.
41. Open wvs.c. Add the following piece of code on the first line:

```c
#define DWORD_ALIGNED(x) (_nassert(((int) (x) & 0x7) == 0))
```

Also add DWORD_ALIGNED definitions for xptr & yptr after the short w1,w2; statement.

```c
DWORD_ALIGNED(xptr);
DWORD_ALIGNED(yptr);
```

By asserting that xptr and yptr addresses “anded” with 0x7 are equal to zero, the compiler knows that they are double word aligned. This means the compiler can perform LDDW and packed data optimization on these memory accesses.

**Hint:** If you need would like a refresher on how DATA_ALIGN and _nassert() are working together to produce optimal code, refer back to the material on page 9-19 in the Student Notes.

42. Save and close wvs.c.

43. Rebuild, Reload, & Go Main.

44. Run the code.

45. Record the Incl Total (Cycle Count) of *wvs()* in the table on p. 9-31 under “_nassert (double word-aligned)”.

46. Open wvs.asm.

Success! The compiler has fully optimized this loop. You can now achieve 4 iterations of the loop every three cycles for .75 cycle per iteration throughout.

The .D and .T resources now show 3 (two LDDWs and four STHs for four iterations of the loop).

47. Close *lab9a64p.pjt* and any files associated with it.

**Move on to Lab9b for the ‘C64xp**
Lab9b for 'C64xp

Program Level Optimization

Now we have learned how to pass information to the compiler. This increased the amount of information visible to the compiler from the local scope of each function.

Q. Is this necessary in all cases?

A. No, not in all cases. First, if this information already resides locally inside the function, the compiler has visibility here and restrict and MUST_ITERATE statements are not usually necessary. For example, if xptr and yptr are declared as local arrays, the compiler does not assume a dependency with w_sum. If the loop count is defined in the function or if the loop is simply described to be from one to forty, the MUST_ITERATE pragma is not necessary.

Second, even if this type of information is not declared locally, the compiler can still have access to it in an automated way by giving it a program level view.

The C6000 compiler provides two valuable switches, which enable program level optimization: -pm and -op2. When these two options are used together, the compiler can automatically extract all of the information we passed in Lab9a.

1. Make sure that all files from lab9a are closed.

2. We are now going to use the copy of the Lab 9a files that you made at the beginning of that lab. Navigate to the C:\op6000\labs\lab9b folder.

3. Rename the C:\op6000\labs\lab9b\lab9a64p.pjt to C:\op6000\labs\lab9b\lab9b64p.pjt.

4. Open the lab9b64.pjt file.

5. Change to the Release configuration.
6. To tell the compiler to use program level optimization (–pm and -op2), enter the following:

   Project → Build Options → Compiler tab → Basic Category

   Open Program Level Optimization drop-down menu. Select **No External Func/Var Refs**. Press OK

   ![Build Options for lab9a64p.pjt (Release)](image)

   This adds –pm and –op2 to the command line.

7. Rebuild, Reload, & Go Main.

8. If the Profile Viewer closed with `lab9a64p.pjt`, reopen it.

   Profile → Viewer

9. Run the code.

10. Record the Incl Total (Cycle Count) of `wvs()` in the table on page 9-31 under “Program Level Opt (-pm & -op2)”. 

11. Now try to open wvs.asm to get the Cycles per Iteration. Can you find the file where it should be? ______________________________________

**Note:** Remember that –pm combines all of your files into one file before compiling. Therefore there is not a wvs.asm file.

12. Open main.asm in the C:\op6000\labs\lab9b\Release_64p directory and find the wvs( ) function. Use the Software Pipelined Information embedded in the file to record the "Cycles per Iteration" under Program Level Opt.

13. Compare the improvements in the following table:

### Optimization Comparison Table for the ‘C64xp

<table>
<thead>
<tr>
<th>Optimization Method</th>
<th>Incl Tot/Cycle Count</th>
<th>Cycles per Iteration</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Optimization</td>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td>Release</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-mt option</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Restrict Qualifier</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MUST_ITERATE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>_nassert</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(double word-aligned)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Program Level Opt</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(-pm &amp; -op2)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

14. Save your work and close the Lab 9b project.

*End of Lab9b for 'C64x, move on to Lab9c on page 9 - 61*
Lab 9a for 'C67x

We're going to explore using other pragmas and tools that we discussed in this Chapter to maximize the efficiency of some more C code.

**Save a Copy of Lab9a**

Before we get started, we want to save a copy of the files that we will be working with. We want you to do this, so that you know that we aren't trying to do anything "tricky".

1. Use Windows Explorer to copy `C:\op6000\labs\lab9a` folder to `C:\op6000\labs\lab9b`.

**Load Project and Set Compiler Options**

2. Open the `lab9a67` project found in folder `C:\op6000\labs\lab9a\lab9a67.pjt`.

3. Expand this project and make sure it contains the following files:
   - wvs.c
   - main.c
   - lnk.cmd
   - `C:\CCStudio\c6000\cgtools\lib\rts6700.lib`

4. Make sure the Build Configuration is set to `Debug`.

5. Build, load, & run your program to main (go main if not taken there automatically).
**Set up Profiler**

6. Open the Profile Setup window and click on the *Custom* tab at the bottom of the window.

   The Custom tab allows you to configure exactly what simulation events are captured by the profiler.

7. Click on the plus sign next to the *cycle* entry.

8. Click the box next to the *CPU* entry under cycle.
The cycle:CPU event counts the number of cycles executed by the CPU while ignoring memory and cache effects.

9. Click on the Enable/Disable All Functions icon in the Profile Setup window to **enable** the profiling of all functions.

10. Enable profiling by clicking on the icon.

11. Open the Profile Viewer.

   Profile → Viewer

12. Run the code.

13. Record the Incl Total (Cycle Count) for the wvs function for Lab9a in the table on p. 9-45 under “No Optimization”.

   ![Profile Viewer](image)

### Optimizing the Code

14. Open the wvs.c file. This C code is a vector summation of two weighted vectors. We will be using this code throughout this lab.

15. Change the Build Configuration to **Release**.

16. Rebuild the code.

17. Run the code. Record the number of cycles from the Profile Viewer in the table on page 9-45.
18. Open the wvs.asm file in the C:\op6000\labs\lab9a\Release_67 directory.

This file is available because of the –k compiler option we set.

The .asm file contains software pipeline information. Scroll down through this file and find the Software Pipeline Information Comments. Do you see “Searching for a software pipeline schedule at … ii = 10”?

ii=10 stands for iteration interval equals 10. This implies that each iteration of the loop takes ten cycles, or that there are ten cycles per loop iteration.

**Record the number of "Cycles per Iteration" for Release in the table on page 9-45.**

With 8 resources available every cycle on such a small loop, we would expect this loop to do better than this.

**Q.** Why did the loop start searching for a software pipeline at ii=10 (for an 10 cycle loop)?

**A.** Because 3 pointers are used in this function (xptr, yptr, & zptr). If all the pointers point to a different location in memory, there is no dependency. However since all three pointers are passed into lab9a, there is no way for the compiler to be sure they don’t alias, or point to the same location. This is a memory alias disambiguation problem. The compiler must be conservative to guarantee correct execution. Unfortunately, the requirement for the compiler to be conservative can have dire effects on the performance of your code.

We know from looking at the calling function in main, that in fact, these pointers all point to separate arrays in memory. However, from the compiler’s local view of lab9a, this information is not available.

**Q.** How can you pass more information to the compiler to improve its performance?
Solving Alias Disambiguation Problems

A special option in the compiler, -mt, tells the compiler to ignore alias disambiguation problems like the one described at the beginning of this lab. Try using this option to rebuild the original lab and look at the results.

19. Turn on the –mt compiler option.

   Project → Build Options → Compiler tab → Advanced Category.

   Pull down Aliasing menu and select No Bad Alias Code (-mt) and then press OK.

20. Rebuild, Reload, & Go Main.

21. Hide the Build window.

22. Run the code.

23. Record the Incl Total (Cycle Count) of wvs( ) in the table on p. 9-45 under “-mt options”.


24. Record the number of "Cycles per Iteration" for Release in the table on page 9-45 under "-mt options".

Open the wvs.asm file. Under the Global File Parameters, the following line implies that –mt was used:

;* Memory Aliases : Presume not aliases (optimistic)

The compiler now knows that there aren't supposed to be any aliases in this project. What if some functions had aliases and others didn't? We need something that is a little more specific.

**Adding a Restrict Qualifier**

25. Open the Build Options for the Release configuration and remove the –mt option.


   Because we know that xptr & yptr are actually separate arrays in memory from w_sum, we can declare that nothing else points to these objects. To do this, we must add a restrict type qualifier.

   Modify the function definition to be as follows:

   ```
   void wvs(short * restrict xptr, short * restrict yptr, short *zptr, short *w_sum, int N)
   ```

   Save and close wvs.c.

27. We must also modify main.c to reflect this function definition. Open main.c and change the external statement to read:

   ```
   extern void wvs(short * restrict, short * restrict, short *, short *, int);
   ```

   Save and close main.c.

28. Rebuild, Reload, & Go Main.

29. Run the code.

30. Record the Incl Total (Cycle Count) of lab9a in the table on p. 9-45 under “Restrict Qualifier”.

31. Open wvs.asm and scroll down to the Software Pipeline Information.

   Q. How many cycles is the Software Pipelined Loop now? __________________

   Now the loop carried dependency bound is zero. By simply passing more information to the compiler, we allowed it to improve an 10-cycle loop to a 2-cycle loop.

   Record the number of cycles per iteration in the table on page 9-45.
32. Scroll down to the Software Pipeline Information until you see

```c
;* Loop Carried Dependency Bound (^) : 0
;* ii = 2 Schedule found with 5 iterations in parallel
```

This indicates that a 2-cycle loop was found, which is similar to using the -mt compiler option. However, the `restrict` keyword is function specific and gives the user more control.

**Q. How can we optimize our code more?**

**Balance the Resources**

33. Let’s analyze the feedback to determine what improvements could be made. Open `wvs.asm`.

Scroll down to the Software Pipeline Information. The first iteration interval (ii) attempted was two cycles because the Partitioned Resource Bound is two. We can see the reason for this if we look below at the .D unit and the .T address paths. This loop requires two loads (from `xptr` and `y.ptr`) and one store (to `w_sum`) for each iteration of the loop.

Each memory access requires a .D unit for address calculation, and a .T address path to send the address out to memory. Because the C6000 has two .D units and two .T address paths available on any given cycle (A side and B side), the compiler must partition at least two of the operations on one side (the A side). That means that these operations are the bottleneck in resources (highlighted with an *) and are the limiting factor in the Partitioned Resource Bound. The feedback in `wvs.asm` shows that there is an imbalance in resources between A and B side due, in this case, to an odd number of operations being mapped to two sides of the machine.

**Q. Is it possible to improve the balance of resources?**

**A.** One way to balance an odd number of operations is to unroll the loop. Now, instead of three memory accesses, you will have six, which is an even number. You can only do this if you know that the loop counter is a multiple of two; otherwise, you will incorrectly execute too few or too many iterations. In main, `LOOPCOUNT` is defined to be 40, which is a multiple of two, so you are able to unroll the loop.

**Q. Why did the compiler not unroll the loop?**

**A.** In the limited scope of `wvs.c`, the loop counter is passed as a parameter to the function. Therefore, it might be any value from this limited view of the function. To improve this scope you must pass more information to the compiler. One way of doing this is with a `MUST_ITERATE` pragma.
34. Open \texttt{wvs.c} and insert a MUST_ITERATE pragma above the for loop that says the loop always iterates in multiples of 4s but always iterates at least 40 times. It should look like this:

\begin{verbatim}
#pragma MUST_ITERATE (40, , 4);
\end{verbatim}

Unrolling a loop can incur some minor overhead in loop setup. The compiler does not unroll loops with small loop counts because unrolling may not reduce the overall cycle count. If the compiler does not know what the minimum value of the loop counter is, it will not automatically unroll the loop. Again, this is information the compiler needs but does not have in the local scope of \texttt{wvs.c}. You know that LOOPCOUNT is set to 40, so you can tell the compiler that N is greater than some minimum value. The MUST_ITERATE pragma passes these two valuable pieces of information.

35. Save & close \texttt{wvs.c}. Close any open files. Leave the Profile Viewer open.

36. Rebuild, Reload, & Go Main.

37. Run the code.

38. Record the Incl Total (Cycle Count) of \texttt{wvs()} in the table on p. 9-45 under “MUST_ITERATE”.

Remember, no code was altered in this lab. Only additional information was passed via the MUST_ITERATE pragma. We simply guarantee the compiler that the trip count (in this case the trip count is N) is a multiple of four and that the trip count is greater than or equal to 40. The first argument for MUST_ITERATE is the minimum number of times the loop will iterate. The second argument is the maximum number of times the loop will iterate. The trip count must be evenly divisible by the third argument, the factor.

\textbf{Note:} Choose a trip count large enough to tell the compiler that it is more efficient to unroll the loop. Always specify the largest minimum trip count that is safe.
Open the *wvs.asm* file. Notice the following things in the Software Pipeline information feedback:

**Loop Unroll Multiple:** 2x
This loop has been unrolled by a factor of two.

**ii=3 Schedule found with 5 iterations in parallel**
You can tell by looking at the .D units and .T address paths that this 3-cycle loop comes after the loop has been unrolled because the resources show a total of six memory accesses. Therefore, our new effective loop iteration interval is 3/2 or 1.5 cycles. The "5 iterations in parallel" means that the loop is working on 5 different results at the same time. This doesn't have any bearing on our performance.

**Minimum Safe Trip Count:** 4 (after unrolling)
This is because we specify the count of the original loop to be greater than or equal to forty and a multiple of four and after unrolling, the loop count has to be even.

Therefore, by passing information without modifying the loop code, compiler performance improves from a 10-cycle loop to 2 cycles and now to 1.5 cycles.

Record the number of cycles per iteration in the table on page 9-45.

Q. Is this the lower limit?
Packed Data Optimization Increases Memory Bandwidth

The last optimization produced a 3-cycle loop that performed 2 iterations of the original vector sum of two weighted vectors. This means that each iteration of our loop now performs six memory accesses, four multiplies, two adds, two shift operations, a decrement for the loop counter, and a branch. You can see this in the feedback of wvs.c.

39. Open wvs.asm.

The six memory accesses appear as .D and .T units. The four multiplies appear as .M units. The two shifts and the branch show up as .s units. The decrement and the two adds appear as .LSD units.

By analyzing this part of the feedback, we can see that resources are most limited by the memory accesses; hence, the reason for an asterisk highlighting the .D units and .T address paths.

Q. Does this mean that we cannot make the loop operate any faster?
A. Further insight into the ‘C6000 architecture is necessary here.

The C62x fixed-point device loads and/or stores 32 bits every cycle. In addition, the C67x floating-point and the C64x fixed-point device loads two 64-bit values each cycle. In our example, we load four 16-bit values and store two 16-bit values every five cycles. This means we only use 16 bits of memory access every cycle. Because this is a resource bottleneck in our loop, increasing the memory access bandwidth further improves the performance of our loop.

In the unrolled loop generated from the MUST_ITERATE pragma, we load two consecutive 16-bit elements with LDHs from both the xptr and yptr array.

Q. Why not use an aligned LDDW to load one 64-bit element, with the resulting register pair load containing the first element in one-half of the lower 32-bit register and the second element in the other half and the third and fourth in the other register?
A. This is called Packed Data optimization. Four 16-bit loads are effectively performed by one single 64-bit load instruction.

Q. Why didn’t the compiler do this automatically in the MUST_ITERATE code?
A. Again, the answer lies in the amount of information the compiler has access to from the local scope of the program.

In order to perform a LDDW (64-bit load) on the C67x cores, the address must be aligned to a double word-address; otherwise, incorrect data would be loaded. An address is double word-aligned if the lower three bits of the address are zero. Unfortunately, in our example, the wvs( ) function does not have knowledge as to the xptr and yptr address values. Therefore, the compiler is forced to be conservative and assume that these pointers might not be aligned. Once again, we can pass more information to the compiler, this time via the _nassert statement.
40. Open wvs.c. Add the following piece of code on the first line:

```c
#define DWORD_ALIGNED(x) (_nassert(((int) (x) & 0x7) == 0))
```

Also add DWORD_ALIGNED definitions for xptr & yptr after the short w1,w2; statement.

```c
DWORD_ALIGNED(xptr);
DWORD_ALIGNED(yptr);
```

By asserting that xptr and yptr addresses “anded” with 0x7 are equal to zero, the compiler knows that they are double word aligned. This means the compiler can perform LDDW and packed data optimization on these memory accesses.

**Hint:** If you need would like a refresher on how DATA_ALIGN and _nassert() are working together to produce optimal code, refer back to the material on page 9-19 in the Student Notes.

41. Save and close wvs.c.

42. Rebuild, Reload, & Go Main.

43. Run the code.

44. Record the Incl Total (Cycle Count) of \textit{wvs()} in the table on p. 9-45 under “\_nassert (double word-aligned)”.

45. Open wvs.asm.

   Success! The compiler has fully optimized this loop. You can now achieve 4 iterations of the loop every four cycles for 1 cycle per iteration throughout.

   The .D and .T resources now show 3 (two LDDWs and four STHs for four iterations of the loop).

46. Close \textit{lab9a67.pjt} and any files associated with it.

**Move on to Lab9b for the ‘C67x**
Lab9b for 'C67x

Program Level Optimization

Now we have learned how to pass information to the compiler. This increased the amount of information visible to the compiler from the local scope of each function.

Q. Is this necessary in all cases?

A. No, not in all cases. First, if this information already resides locally inside the function, the compiler has visibility here and restrict and MUST_ITERATE statements are not usually necessary. For example, if xptr and yptr are declared as local arrays, the compiler does not assume a dependency with w_sum. If the loop count is defined in the function or if the loop is simply described to be from one to forty, the MUST_ITERATE pragma is not necessary.

Second, even if this type of information is not declared locally, the compiler can still have access to it in an automated way by giving it a program level view.

The C6000 compiler provides two valuable switches, which enable program level optimization: `-pm` and `-op2`. When these two options are used together, the compiler can automatically extract all of the information we passed in Lab9a.

1. Make sure that all files from lab9a are closed.

2. We are now going to use the copy of the Lab 9a files that you made at the beginning of that lab. Navigate to the `C:\op6000\labs\lab9b` folder.

3. Rename the `C:\op6000\labs\lab9b\lab9a67.pjt` to `C:\op6000\labs\lab9b\lab9b67.pjt`.

4. Open the `lab9b67.pjt` file.

5. Change to the Release configuration.
6. To tell the compiler to use program level optimization (–pm and -op2), enter the following

   Project → Build Options → Compiler tab → Basic Category

   Open Program Level Optimization drop-down menu.
   Select No External Func/Var Refs. Press OK

   ![Build Options for lab9b67.pjt (Release)](image)

   This adds –pm and –op2 to the command line.

7. Rebuild, Reload, & Go Main.

8. If the Profile Viewer closed with lab9a67.pjt, reopen it.

   Profile → Viewer

9. Run the code.

10. Record the Incl Total (Cycle Count) of wvs( ) in the table on page 9-45 under “Program Level Opt (-pm & -op2)”.
11. Now try to open *wvs.asm* to get the Cycles per Iteration. Can you find the file where it should be? ____________________________

**Note:** Remember that –pm combines all of your files into one file before compiling. Therefore there is not a *wvs.asm* file.

12. Open *main.asm* in the C:\op6000\labs\lab9b\Release_67 directory and find the *wvs()* function. Use the Software Pipelined Information embedded in the file to record the "Cycles per Iteration" under Program Level Opt.

13. Compare the improvements in the following table:

**Optimization Comparison Table for ‘C67x**

<table>
<thead>
<tr>
<th>Optimization Method</th>
<th>Incl Tot/Cycle Count</th>
<th>Cycles per Iteration</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Optimization</td>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td>Release</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-mt option</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Restrict Qualifier</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MUST_ITERATE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>_nassert (double word-aligned)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Program Level Opt (-pm &amp; -op2)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

14. Save your work and **close** the Lab9b project.

**15. End of Lab9b for 'C67x, move on to Lab9c on page 9 - 61**
Lab 9a for 'C672x

We're going to explore using other pragmas and tools that we discussed in this Chapter to maximize the efficiency of some more C code.

Save a Copy of Lab9a

Before we get started, we want to save a copy of the files that we will be working with. We want you to do this, so that you know that we aren't trying to do anything "tricky".

47. Use Windows Explorer to copy \C:\op6000\labs\lab9a folder to \C:\op6000\labs\lab9b.

Load Project and Set Compiler Options

48. Open the lab9a67p project found in folder \C:\op6000\labs\lab9a\lab9a67p.pjt.

49. Expand this project and make sure it contains the following files:
   • wvs.c
   • main.c
   • lnk.cmd

50. Make sure the Build Configuration is set to Debug.

51. Build, load, & run your program to main (go main if not taken there automatically).
Set up Profiler

52. Open the Profile Setup window and click on the Custom tab at the bottom of the window.

The Custom tab allows you to configure exactly what simulation events are captured by the profiler.

53. Click on the plus sign next to the cycle entry.

54. Click the box next to the CPU entry under cycle.
The cycle:CPU event counts the number of cycles executed by the CPU while ignoring memory and cache effects.

55. Click on the Enable/Disable All Functions icon in the Profile Setup window to enable the profiling of all functions.

56. Enable profiling by clicking on the icon.

57. Open the Profile Viewer.

58. Run the code.

59. Record the Incl Total (Cycle Count) for the \texttt{wvs} function for Lab9a in the table on p. 9-45 under “No Optimization”.

\begin{table}[h]
\centering
\begin{tabular}{|c|c|c|c|c|c|c|c|}
\hline
Address Range & Symbol Name & SLR & Symbol Type & Access Count & cycle:CPU: Incl & cycle:CPU: Excl \\
\hline
0x0x00-0x0000 & main & 48-52.C & function & 1 & 120 & 0 \\
0x0x00-0x0000 & wvs & 10-23.C & function & 1 & 103 & 103 \\
\hline
\end{tabular}
\end{table}

\textbf{Optimizing the Code}

60. Open the \texttt{wvs.c} file. This C code is a vector summation of two weighted vectors. We will be using this code throughout this lab.

61. Change the Build Configuration to \textit{Release}.

62. Rebuild the code.

63. Run the code. Record the number of cycles from the Profile Viewer in the table on page 9-45.
64. Open the wvs.asm file in the C:\op6000\labs\lab9a\Release_67p directory.

   This file is available because of the –k compiler option we set.

   The .asm file contains software pipeline information. Scroll down through this file and find
   the Software Pipeline Information Comments. Do you see “Searching for a software pipeline
   schedule at … ii = 10”?

   ii=10 stands for iteration interval equals 10. This implies that each iteration of the loop takes
ten cycles, or that there are ten cycles per loop iteration.

   **Record the number of "Cycles per Iteration" for Release in the table on page 9-45.**

   With 8 resources available every cycle on such a small loop, we would expect this loop to do
   better than this.

   **Q.** Why did the loop start searching for a software pipeline at ii=10 (for an 10 cycle loop)?

   **A.** Because 3 pointers are used in this function (xptr, yptr, & zptr). If all the pointers point to
   a different location in memory, there is no dependency. However since all three pointers
   are passed into lab9a, there is no way for the compiler to be sure they don’t alias, or point
   to the same location. This is a memory alias disambiguation problem. The compiler must
   be conservative to guarantee correct execution. Unfortunately, the requirement for the
   compiler to be conservative can have dire effects on the performance of your code.

   We know from looking at the calling function in main, that in fact, these pointers all point
   to separate arrays in memory. However, from the compiler’s local view of lab9a, this
   information is not available.

   **Q.** How can you pass more information to the compiler to improve its performance?
**Solving Alias Disambiguation Problems**

A special option in the compiler, -mt, tells the compiler to ignore alias disambiguation problems like the one described at the beginning of this lab. Try using this option to rebuild the original lab and look at the results.

65. Turn on the **–mt** compiler option.

   *Project → Build Options → Compiler tab → Advanced Category.*

   Pull down *Aliasing* menu and select *No Bad Alias Code (-mt)* and then press OK.

66. Rebuild, Reload, & Go Main.

67. Hide the Build window.

68. Run the code.

69. Record the Incl Total (Cycle Count) of wvs( ) in the table on p. 9-45 under “–mt options”.

---

9 - 50  
*C6000 Optimization Workshop - Advanced C Topics for Code Speed*
70. **Record the number of "Cycles per Iteration" for Release in the table on page 9-45 under "-mt options".**

Open the `wvs.asm` file. Under the Global File Parameters, the following line implies that –mt was used:

```asm
;* Memory Aliases : Presume not aliases (optimistic)
```

The compiler now knows that there aren't supposed to be any aliases in this project. What if some functions had aliases and others didn't? We need something that is a little more specific.

**Adding a Restrict Qualifier**

71. Open the Build Options for the **Release** configuration and remove the –mt option.

72. Now open the `wvs.c` file.

Because we know that `xptr` & `y.ptr` are actually separate arrays in memory from `w_sum`, we can declare that nothing else points to these objects. To do this, we must add a restrict type qualifier.

Modify the function definition to be as follows:

```c
void wvs(short * restrict xptr, short * restrict yptr, short *zptr, short *w_sum, int N)
```

Save and close `wvs.c`.

73. We must also modify `main.c` to reflect this function definition. Open `main.c` and change the external statement to read:

```c
extern void wvs(short * restrict, short * restrict, short *, short *, int);
```

Save and close `main.c`.

74. Rebuild, Reload, & Go Main.

75. Run the code.

76. Record the Incl Total (Cycle Count) of lab9a in the table on p. 9-45 under “Restrict Qualifier”.

77. Open `wvs.asm` and scroll down to the Software Pipeline Information.

**Q.** How many cycles is the Software Pipelined Loop now? ______________

Now the loop carried dependency bound is zero. By simply passing more information to the compiler, we allowed it to improve an 10-cycle loop to a 2-cycle loop.

Record the number of cycles per iteration in the table on page 9-45.
78. Scroll down to the Software Pipeline Information until you see

* Loop Carried Dependency Bound (^) : 0
*: ii = 2 Schedule found with 5 iterations in parallel

This indicates that a 2-cycle loop was found, which is similar to using the -mt compiler option. However, the restrict keyword is function specific and gives the user more control.

Q. How can we optimize our code more?

**Balance the Resources**

79. Let’s analyze the feedback to determine what improvements could be made. Open wvs.asm.

Scroll down to the Software Pipeline Information. The first iteration interval (ii) attempted was two cycles because the Partitioned Resource Bound is two. We can see the reason for this if we look below at the .D unit and the .T address paths. This loop requires two loads (from xptr an yptr) and one store (to w_sum) for each iteration of the loop.

Each memory access requires a .D unit for address calculation, and a .T address path to send the address out to memory. Because the C6000 has two .D units and two .T address paths available on any given cycle (A side and B side), the compiler must partition at least two of the operations on one side (the A side). That means that these operations are the bottleneck in resources (highlighted with an *) and are the limiting factor in the Partitioned Resource Bound. The feedback in wvs.asm shows that there is an imbalance in resources between A and B side due, in this case, to an odd number of operations being mapped to two sides of the machine.

Q. Is it possible to improve the balance of resources?

A. One way to balance an odd number of operations is to unroll the loop. Now, instead of three memory accesses, you will have six, which is an even number. You can only do this if you know that the loop counter is a multiple of two; otherwise, you will incorrectly execute too few or too many iterations. In main, LOOPCOUNT is defined to be 40, which is a multiple of two, so you are able to unroll the loop.

Q. Why did the compiler not unroll the loop?

A. In the limited scope of wvs.c, the loop counter is passed as a parameter to the function. Therefore, it might be any value from this limited view of the function. To improve this scope you must pass more information to the compiler. One way of doing this is with a MUST_ITERATE pragma.
80. Open wvs.c and insert a MUST_ITERATE pragma above the for loop that says the loop always iterates in multiples of 4s but always iterates at least 40 times. It should look like this:

```
#pragma MUST_ITERATE (40, , 4);
```

Unrolling a loop can incur some minor overhead in loop setup. The compiler does not unroll loops with small loop counts because unrolling may not reduce the overall cycle count. If the compiler does not know what the minimum value of the loop counter is, it will not automatically unroll the loop. Again, this is information the compiler needs but does not have in the local scope of wvs.c. You know that LOOPCOUNT is set to 40, so you can tell the compiler that N is greater than some minimum value. The MUST_ITERATE pragma passes these two valuable pieces of information.

81. Save & close wvs.c. Close any open files. Leave the Profile Viewer open.

82. Rebuild, Reload, & Go Main.

83. Run the code.

84. Record the Incl Total (Cycle Count) of wvs() in the table on p. 9-45 under “MUST_ITERATE”.

Remember, no code was altered in this lab. Only additional information was passed via the MUST_ITERATE pragma. We simply guarantee the compiler that the trip count (in this case the trip count is N) is a multiple of four and that the trip count is greater than or equal to 40. The first argument for MUST_ITERATE is the minimum number of times the loop will iterate. The second argument is the maximum number of times the loop will iterate. The trip count must be evenly divisible by the third argument, the factor.

**Note:** Choose a trip count large enough to tell the compiler that it is more efficient to unroll the loop. Always specify the largest minimum trip count that is safe.
Open the wvs.asm file. Notice the following things in the Software Pipeline information feedback:

**Loop Unroll Multiple:** 2x
This loop has been unrolled by a factor of two.

**ii=3 Schedule found with 5 iterations in parallel**
You can tell by looking at the .D units and .T address paths that this 3-cycle loop comes after the loop has been unrolled because the resources show a total of six memory accesses. Therefore, our new effective loop iteration interval is 3/2 or 1.5 cycles. The "5 iterations in parallel" means that the loop is working on 5 different results at the same time. This doesn't have any bearing on our performance.

**Minimum Safe Trip Count: 4 (after unrolling)**
This is because we specify the count of the original loop to be greater than or equal to forty and a multiple of four and after unrolling, the loop count has to be even.

Therefore, by passing information without modifying the loop code, compiler performance improves from a 10-cycle loop to 2 cycles and now to 1.5 cycles.

Record the number of cycles per iteration in the table on page 9-45.

Q. Is this the lower limit?
**Packed Data Optimization Increases Memory Bandwidth**

The last optimization produced a 3-cycle loop that performed 2 iterations of the original *vector sum of two weighted vectors*. This means that each iteration of our loop now performs six memory accesses, four multiplies, two adds, two shift operations, a decrement for the loop counter, and a branch. You can see this in the feedback of `wvs.c`.

85. Open `wvs.asm`.

The six memory accesses appear as .D and .T units. The four multiplies appear as .M units. The two shifts and the branch show up as .s units. The decrement and the two adds appear as .LSD units.

By analyzing this part of the feedback, we can see that resources are most limited by the memory accesses; hence, the reason for an asterisk highlighting the .D units and .T address paths.

**Q.** Does this mean that we cannot make the loop operate any faster?

**A.** Further insight into the ‘C6000 architecture is necessary here.

The C62x fixed-point device loads and/or stores 32 bits every cycle. In addition, the C67x floating-point and the C64x fixed-point device loads two 64-bit values each cycle. In our example, we load four 16-bit values and store two 16-bit values every five cycles. This means we only use 16 bits of memory access every cycle. Because this is a resource bottleneck in our loop, increasing the memory access bandwidth further improves the performance of our loop.

In the unrolled loop generated from the MUST_ITERATE pragma, we load two consecutive 16-bit elements with LDHs from both the xptr and yptr array.

**Q.** Why not use an aligned LDDW to load one 64-bit element, with the resulting register pair load containing the first element in one-half of the lower 32-bit register and the second element in the other half and the third and fourth in the other register?

**A.** This is called Packed Data optimization. Four 16-bit loads are effectively performed by one single 64-bit load instruction.

**Q.** Why didn’t the compiler do this automatically in the MUST_ITERATE code?

**A.** Again, the answer lies in the amount of information the compiler has access to from the local scope of the program.

In order to perform a LDDW (64-bit load) on the C67x cores, the address must be aligned to a double word-address; otherwise, incorrect data would be loaded. An address is double word-aligned if the lower three bits of the address are zero. Unfortunately, in our example, the `wvs()` function does not have knowledge as to the xptr and yptr address values. Therefore, the compiler is forced to be conservative and assume that these pointers might not be aligned. Once again, we can pass more information to the compiler, this time via the _nassert statement.
86. Open \texttt{wvs.c}. Add the following piece of code on the first line:

\begin{verbatim}
#define DWORD_ALIGNED(x) (_nassert(((int) (x) & 0x7) == 0))
\end{verbatim}

Also add DWORD\_ALIGNED definitions for \texttt{xptr} & \texttt{yptr} after the short \texttt{w1,w2;} statement.

\begin{verbatim}
DWORD_ALIGNED(xptr);
DWORD_ALIGNED(yptr);
\end{verbatim}

By asserting that \texttt{xptr} and \texttt{yptr} addresses “anded” with \texttt{0x7} are equal to zero, the compiler knows that they are double word aligned. This means the compiler can perform LDDW and packed data optimization on these memory accesses.

\textbf{Hint: } If you need would like a refresher on how \texttt{DATA\_ALIGN} and \texttt{\_nassert()} are working together to produce optimal code, refer back to the material on page 9-19 in the Student Notes.

87. Save and close \texttt{wvs.c}.

88. Rebuild, Reload, & Go Main.

89. Run the code.

90. Record the Incl Total (Cycle Count) of \texttt{wvs()} in the table on p. 9-45 under “\texttt{\_nassert (double word-aligned)}”.

91. Open \texttt{wvs.asm}.

Success! The compiler has fully optimized this loop. You can now achieve 4 iterations of the loop every four cycles for \textbf{1} cycle per iteration throughout.

The .D and .T resources now show 3 (two LDDWs and four STHs for four iterations of the loop).

92. Close \texttt{lab9a67.pjt} and any files associated with it.

\textbf{Move on to Lab9b for the ‘C672x}
Lab9b for 'C672x

Program Level Optimization

Now we have learned how to pass information to the compiler. This increased the amount of information visible to the compiler from the local scope of each function.

Q. Is this necessary in all cases?

A. No, not in all cases. First, if this information already resides locally inside the function, the compiler has visibility here and restrict and MUST_ITERATE statements are not usually necessary. For example, if xptr and yptr are declared as local arrays, the compiler does not assume a dependency with w_sum. If the loop count is defined in the function or if the loop is simply described to be from one to forty, the MUST_ITERATE pragma is not necessary.

Second, even if this type of information is not declared locally, the compiler can still have access to it in an automated way by giving it a program level view.

The C6000 compiler provides two valuable switches, which enable program level optimization: `-pm` and `-op2`. When these two options are used together, the compiler can automatically extract all of the information we passed in Lab9a.

16. Make sure that all files from Lab9a are closed.

17. We are now going to use the copy of the Lab 9a files that you made at the beginning of that lab. Navigate to the `C:\op6000\labs\lab9b` folder.

18. Rename the `C:\op6000\labs\lab9b\lab9a67p.pjt` to `C:\op6000\labs\lab9b\lab9b67p.pjt`.


21. To tell the compiler to use program level optimization (–pm and -op2), enter the following

   Project → Build Options → Compiler tab → Basic Category

   Open Program Level Optimization drop-down menu.
   Select No External Func/Var Refs. Press OK

   ![Build Options for lab9b67.pjt (Release)](image)

   This adds –pm and –op2 to the command line.

22. Rebuild, Reload, & Go Main.

23. If the Profile Viewer closed with lab9a67.pjt, reopen it.

   Profile → Viewer

24. Run the code.

25. Record the Incl Total (Cycle Count) of wvs( ) in the table on page 9-45 under “Program Level Opt (-pm & -op2)”. 
26. Now try to open `wvs.asm` to get the Cycles per Iteration. Can you find the file where it should be? ____________________________________________________________________

**Note:** Remember that –pm combines all of your files into one file before compiling. Therefore there is not a `wvs.asm` file.

27. Open `main.asm` in the `C:\op6000\labs\lab9b\Release_67` directory and find the `wvs()` function. Use the Software Pipelined Information embedded in the file to record the "Cycles per Iteration" under Program Level Opt.

28. Compare the improvements in the following table:

**Optimization Comparison Table for ‘C67x**

<table>
<thead>
<tr>
<th>Optimization Method</th>
<th>Incl Tot/Cycle Count</th>
<th>Cycles per Iteration</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Optimization</td>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td>Release</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-mt option</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Restrict Qualifier</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MUST_ITERATE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>_nassert</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(double word-aligned)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Program Level Opt</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(-pm &amp; -op2)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

29. Save your work and close the Lab9b project.

*End of Lab9b for 'C67x, move on to Lab9c on page 9 - 61*
Lab9c - Compiler Consultant Introduction

In this lab, you will analyze a simple loop for optimization. The Compiler Consultant Tool analyzes your application and makes recommendations for changes to optimize the performance. The tool displays two types of information for the user: Compile Time Loop Information and Run Time Loop Information. Compile Time Loop Information is created by the compiler. Each time you compile or build your code, Consultant will analyze the code and create suggestions for different optimization techniques to improve code efficiency. These suggestions include compiler optimization switches and pragmas to insert into your code that give the compiler more application information. You then have the option of implementing the advice and building the project again. The Run Time Loop Information is data gathered by profiling your application. This run time loop information helps prioritize the advice.

Learning Objectives:
- Use the Compiler Consultant Tool to create optimization advice on a sample project loop
- Introduce the different kinds of advice used to optimize the project, including Options, Alias, Alignment and Trip Count Advice
- Implement the advice, and observe the effects

Application Objective:
This lab uses the consultant project to display different features of the Compiler Consultant Tool. You will analyze the example loop using the Compiler Consultant tool throughout the optimization process. After each optimization, new advice will appear based on the changes made. Each type of advice has specific steps associated with it. You will implement these steps and view the results. Optimization will continue until the Consultant Compiler Tool has determined that the loop has been fully optimized.
Getting Started with Consultant

In this lesson, you will analyze a project called consultant.pjt. You will use the Profile Viewer to analyze the project, and the Compiler Consultant Tool will present advice on how to optimize the loop. This lab is currently based on the ‘C64x simulator.

Change to ‘C64x Simulator

1. Since this is a ‘C64x based lab, we need to reconfigure the CCS setup. Launch CCS Setup:

   File → Launch Setup

2. When setup opens, the “Import Configuration” window appears. Follow the procedure found at the start of Lab 4. These are the basic steps:
   - Clear the previous system configuration (button on right).
   - Scroll through the list to find C64xx CPU Cycle Accurate Sim, Ltl Endian. Select this item and click Import
   - Quit and save CCS Setup. When asked, allow CCS Setup to restart CCS for you.

3. If Code Composer Studio is not running, start it.

4. Disable the Load Program after Build and Perform Go Main Automatically options.

   Option → Customize; Debug Properties Tab; uncheck Perform Go Main Automatically

   Option → Customize; Program Load Options Tab; uncheck Load Program after Build

5. Open consultant64.pjt from C:\op6000\labs\lab9c.
6. Open DoLoop.c for editing by double-clicking on it in the project view.

```c
#include "DoLoop.h"

void DoLoop(short *Input1, short *Input2, short * /* rest */

    int i, Vector1, Vector2;
    short Weight1 = Weights[0];
    short Weight2 = Weights[1];

    /*
     * ALIGNED_ARRAY(Input1);
     * ALIGNED_ARRAY(Input2);
     * ALIGNED_ARRAY(Output);
     *
     * #pragma MUST_ITERATE(,,2);
     */

    for (i = 0; i < LoopCount; i++)
        {
            Vector1 = Input1[i] * Weight1;
            Vector2 = Input2[i] * Weight2;
            Output[i] = (Vector1 + Vector2) >> 15;
        }
```

DoLoop() is called directly from main() one time. It contains only one loop. This loop is the focus of the tutorial.

7. Under the Project menu, choose Build Options...

8. In the Build Options dialog, click the Compiler tab.
9. Click on the Feedback item in the Category list.
10. Click on the checkbox Generate Compiler Consultant Advice (--consultant).

11. Your build options should resemble the following, although the path may change depending on your target:

12. Click OK to close the Build Options dialog.

13. From the Project menu, choose Rebuild All or click on the Rebuild All button.

14. From the Profile menu, choose Viewer.
15. Once the **Profile Viewer** window appears, click on the **Consultant** tab. The one line in the Profile Viewer represents the single loop in the Consultant tutorial.

![Profile Viewer Window]

16. Notice that the Estimated Cycles Per Iteration for the loop is currently 64 cycles, and the Estimated Start Cycles is zero. Also note that the loop has two pieces of Options advice, as indicated by the Advice Count column in the Profile Viewer. For information on the columns in Profile Viewer, consult the online help file.

**Options Advice Implementation**

In this part of the lab, you will analyze the options advice given by the Consultant Tool, and implement it for the consultant.pjt project.

17. Double click on the **Advice List** cell for the DoLoop row.

![Advice List Cell]
18. The Advice Window appears, and the **Consultant tab** displays advice for the DoLoop function. The **Analysis** of the DoLoop functions indicates that the software pipelining optimizations in the compiler are currently disabled. Also note the two pieces of **Options advice**.

![Advice Window](image)

19. Click on the link to the first piece of Options advice.
20. Read the advice offered in the suggested solution:

![Advice Window](image)

**Note:** Terminology in advice is often linked to the online help, as indicated by the online help icon:

The suggested solution indicates you should turn on the –o2 or –o3 compiler option. Before doing so, let's take a quick look at the second piece of advice.

21. Scroll back to the top of the Advice window with the scroll bar and click on the second piece of advice.

The second piece of Options advice states that we are compiling with the –g debug option turned on. As the advice notes, compiling with -g hurts performance. The advice suggests turning off the –g option.

22. Under the **Project** menu, choose **Build Options**.

23. In the **Build Options** dialog, click the **Compiler** tab.

24. Click on the **Basic** item in the **Category** list.

25. From the **Generate Debug Info** drop down list, choose **No Debug**.

26. From the **Opt Level** drop down list, choose **File (-o3)**.
27. Your build options should be similar to:

![Build Options dialog]

Note: We could have changed these options by switching over to the Release configuration, but then we would have had to add the --consultant option to Release to continue to get feedback from the compiler consultant.

28. Click OK to close the Build Options dialog.

29. From the Project menu, choose Build or click on the Incremental Build icon.

30. After the build, the advice in the Advice Window is no longer valid, so it clears the advice and informs the user that double clicking on the Advice Count column will refresh the advice.
31. In the Profile Viewer, click on the Consultant tab if it is not active. The default row height in the profile viewer only allows you to see one advice type in the Advice List column. To increase row height, place the mouse pointer on the solid horizontal line at the bottom of the top row in the Address Range column. Double-click on that line, and the row height will automatically resize to fit all the information.

32. Double-click on the Advice Count cell for the Loop with an Estimated Cycles Per Iteration of 11 to update the Advice Window for this loop. You can also increase the row heights for the two loops in the Profile Viewer again to see all the pieces of advice.

There are now five pieces of advice for the main loop in the profile viewer, two Alias and three Alignment. Before looking at the specifics on these advice topics, the next lesson will cover loop analysis.
Loop Analysis

Look at the Consultant tab of the Advice Window.

The Analysis for this loop indicates it has been duplicated. Loop duplication can occur when the compiler is unable to determine if one or more pointers are pointing at the same memory address as some other variable. Such pointers are called aliases. One version of the loop presumes the presence of aliases, the other version of the loop does not. The compiler generates code that checks, at runtime, whether certain aliases are present. Then, based on that check, the compiler executes the appropriate version of the loop. The copy of the loop presently displayed in the Advice Window executes when the runtime check for aliases indicates that aliases may be present.

33. Double-click on the Advice Count cell in Profile Viewer for the other row.
34. Look at the analysis of that loop. It has a similar note about a duplicated loop, but it presumes certain aliases are not present.

Further note the bullet about the alternate loop. This is a loop that is executed when a different runtime check for a minimum number of loop iterations has failed. This alternate loop is not software pipelined. For this reason, the alternate loop has no entry in the Profile Viewer.

This pseudo-code summarizes the relationship between the three variations of the loop.

```c
if (enough loop iterations) {
    if (aliases are present)
        loop #1
    else
        loop #2
} else
    alternate loop // not in profile viewer
```

35. We can profile the code to see which loop versions get selected when the code is executed. From the File menu, choose Load Program to start the program load.

36. Browse to C:\op6000\labs\lab9c\Debug_64 and double-click on consultant.out to load it.

37. From the Profile menu, choose Setup.

Profile → Setup
38. Select the Activities tab near the bottom of the window.

39. Check the icons at the top of the Profile Setup tool to determine if profiling is enabled. The Enable/Disable Profiling icon must be toggled on to enable profiling. Profiling may not be enabled if the program has started running or if it was explicitly disabled. Data will not be collected if profiling is not enabled.
40. Place a check next to **Collect Run Time Loop Information**.

This activity will count the cumulative total of CPU cycles, ignoring system effects, executed in each version of the loop. System effects that it ignores include things like cache misses, memory bank conflicts, off-chip memory access latency, etc.

**Note:** Your execution platform may not support collection of the event cycle.CPU, and so will not show the activity Collect Run Time Loop Information. In that case, choose the activity **Profile All Functions and Loops for Cycles** instead. This activity also counts the cumulative total of the CPU cycles, but includes system affects. Further, in addition to profiling all versions of the loop, it profiles each function. In the sections which follow, use the column cycle.Total:Excl.Total in place of cycle.CPU:Excl.Total. For more information on runtime profiling events access, see the online help file.

41. Run the program by choosing **Debug → Run** or **clicking on the Run Icon**.

42. Wait until the program halts. One indicator is the message **Halted** in the lower left corner:
43. In the **Profile Viewer**, click on the Consultant tab if it is not active, and hover the mouse over the column that starts with cycle.CPU to see that the full name of the column is "cycle.CPU:Excl.Total". You may have to scroll to the right to find this column.

![Profile Viewer Screenshot](image)

Note the loop with the 6 pieces of advice has 0 in the cycle.CPU:Excl.Total column. This means the loop for which the analysis states aliases are not present did not execute. The loop that did execute is the one for which aliases are presumed to be present. That is because the runtime check for aliases concluded that aliases may be present. In fact, there are no aliases among these pointers. The runtime check concluded that aliases may be present because it is too conservative; it was too cautious.

To clarify this point, please find the pseudo-code below with comments (in green) to indicate the actual path of execution.

```c
if (enough loop iterations)
{
    /* executes because there are enough loop iterations */
    if (aliases are present)
        /* executes because test for aliases is too conservative */
        loop #1 else
        /* does not execute */
        loop #2 } else
        /* does not execute */
        alternate loop // not in profile viewer
```

44. The loops are presently ordered, from highest to lowest, by the number of cycles executed. This is unlikely to happen in a real application. Typically, information from many loops is present, and sorting the loops is a good way to determine which to focus on first. *You can sort on any column by double-clicking on the column header.*

**Double click** multiple times to sort the rows, toggling between ascending and descending order.

45. We will now focus on the executed loop that currently takes 400 cycles. As we implement the alias and trip count advice for this loop, the compiler will no longer generate the other versions of the loop, and they will no longer appear in the Profile Viewer.

**Double click** on the **Advice Count** cell for the loop which takes 400 cycles.

There are five pieces of advice for the main loop, two Alias and three Alignment. We will first look at the Alias advice and solve it, before moving on to the Alignment advice.
**Alias Advice Implementation**

In this lesson, you will analyze the alias advice given by the Compiler Consultant Tool, and implement it for the consultant.pjt project.

46. In the **Consultant** tab of the **Advice Window**, click on the link to the first piece of **Alias** advice.
The problem statement indicates the compiler cannot determine if two pointers may point to the same memory location, and therefore cannot apply more aggressive optimizations to the loop. The Consultant Tool offers several suggestions to solve the problem.

The primary suggestion tells us to use the restrict qualifier on the Input1 pointer if the safety criteria can be met. Inspect the call to the function DoLoop, and notice that the array passed in as the argument for Input1 is the global array also named Input1. This array does not overlap any of the arrays passed in for the other arguments. This means that the memory referenced by the Input1 variable cannot be referenced by any other variable in the function. Therefore, the Input1 variable meets the safety criteria required for correct use of the restrict keyword. Before we apply the primary suggestion, let’s take a look at the alternate suggestions.

The first alternate suggestion indicates that using the restrict qualifier on the Output pointer could solve the problem. Finally, the second and third alternate suggestions indicate that restricting qualifying a local copy of the Output or Input1 pointer would also solve the problem.

47. Go back to the top of the advice window and click the link to the second piece of Alias advice. This piece of alias advice is similar to the first, except it mentions pointers Output and Input2.

48. Because there are two pieces of alias advice, one for Output and Input1, and the other for Output and Input2, restrict qualifying Output resolves both problems.
Click on the link that says **Output** in the **Problem** section of the **Advice Window** to open the DoLoop.c file on the line that declares Output as an argument passed in to the DoLoop function.

![Advice Window](image)

49. Modify the DoLoop.c to remove the C comment delimiters `/**/` around the restrict qualifier to the Output pointer parameter.

**Before:**

```c
void DoLoop(short *Input1, short *Input2, short * /*restrict*/ Output, short *Weights, int LoopCount)
```

---

**After:**

```c
void DoLoop(short *Input1, short *Input2, short * Output, short *Weights, int LoopCount)
```
50. Save the file with menu item **File→Save**, or **Control+S**.

51. In the **Project View**, open the Include folder and double-click on the **DoLoop.h** file.

52. Remove the C comment delimiters /**/ around the restrict qualifier to the Output pointer parameter.

   **Before:**

   ```c
   void DoLoop(short *Input1, short *Input2, short * /*restrict*/ Output,
               short *Weights, int LoopCount);
   ```

   **After:**

   ```c
   void DoLoop(short *Input1, short *Input2, short * restrict Output, short *
               Weights, int LoopCount);
   ```

53. Save the file with menu item **File→Save**, or **Control+S**.
54. Source changes are complete, so it is time to build. However, building the project removes the cycle count Profile Viewer data, because it will be invalid. The following steps show how to save Profile Viewer data.

In the Profile Viewer toolbar on the left, click the icon for **Save Current Data Set**.

55. Browse to C:\op6000\labs\lab9c\Debug_64.

56. Enter **run1** for the file name.

57. Select **Dataset (*.xml)** for the Save As type, and click **Save**.

To see this data again later, you can use the Load Data Set button in the Profile Viewer.

58. From the **Project** menu, choose **Build** or click on the **Build Icon**.

**Note:** The cycle count data remains in the Profiler tab of the Profile Viewer even after a build, and remains there until another round of profile data is collected.
59. In the Profile Viewer, click on the Consultant tab if it is not active, and **double-click on the Advice Count cell for DoLoop** to update the Advice Window for this loop. You can also increase the row height for the loop in the Profile Viewer again to see more information.

Notice that the Estimated Cycles Per Iteration for the loop has been reduced from 11 cycles to 2 cycles, while the Estimated Start Cycles has changed from zero cycles to 9 cycles.

There are now four pieces of advice, three Alignment and one Trip Count. We will look at the Alignment advice first and solve it before moving on to the Trip Count advice.
Alignment and Trip Count Advice Implementation

In this lesson, you will analyze the alignment and trip count advice given by the Consultant Tool, and implement it for the consultant.pjt project.

Alignment Advice

60. In the Consultant tab of the Advice Window, click on the link to the first piece of Alignment advice.
The problem statement indicates the compiler could access multiple elements of the Input1 array if it could verify that the array was aligned on a four or eight byte boundary. The suggestion recommends addressing three items: aligning the data, indicating the pointers are aligned, and unrolling the loop.

- The help entry on aligning data notes that arrays are automatically aligned on an 8-byte boundary for C64xx, and a 4-byte boundary for C62xx and C67xx. The function DoLoop receives the base address of an array for all three pointer arguments. So, no further steps are required to align the data.
- For indicating the pointer holds the base address of an array, the help entry suggests a macro. So, we have the macro in the header file DoLoop.h, as it is a more comprehensive solution than the simple _nassert given in the advice.
- For unrolling the loop, the advice suggests the use of the MUST_ITERATE pragma. For this simple case, we could indicate the multiple of loop iterations is 40. However, 2 is a more realistic loop count multiple.

The purpose of the MUST_ITERATE pragma is to tell the compiler about properties of the trip count of the loop. The trip count is the number of times the loop iterates. The syntax is:

```c
#pragma MUST_ITERATE([min, max, multiple]);
```

The arguments min and max are programmer-guaranteed minimum and maximum trip counts. The trip count of the loop must be evenly divisible by multiple. All arguments are optional. For information on the MUST_ITERATE argument, see the online help file.
The next two pieces of Alignment advice indicate the advice for Input1 is also applicable for the pointers Input2 and Output. This simple tutorial only calls DoLoop once. In a real application, every call to DoLoop must be inspected to insure that the base of an array is always passed to the pointers, and the loop iteration count is always a multiple of 2.

61. If the source file is not already open, click on the **source file name**
(C:\op6000\labs\lab9c\DoLoop.c) at the top of the Advice Window to bring up the DoLoop.c file in the Editor.

62. DoLoop.c already contains all of the indicated changes as comments. Remove the comment delimiters (/* */) from the ALIGN_ARRAY macro and the MUST_ITERATE pragma.

**Code After Changes:**

```
#include "DoLoop.h"

void DoLoop(short *Input1, short *Input2, short * restrict
...
  int i, Vector1, Vector2;
  short Weight1 = Weights[0];
  short Weight2 = Weights[1];

  ALIGN_ARRAY(Input1);
  ALIGN_ARRAY(Input2);
  ALIGN_ARRAY(Output);

  #pragma MUST_ITERATE[,2);

  ...
  for (i = 0; i < LoopCount; i++)
  {
    Vector1 = Input1[i] * Weight1;
    Vector2 = Input2[i] * Weight2;
    Output[i] = (Vector1 + Vector2) >> 15;
  }
```

63. Save the file with **File→Save** or **control+S**.

64. From the **Project** menu, choose **Build** or **click on the Build Icon**.
65. In the Profile Viewer, click on the Consultant tab if it is not active, and double-click on the DoLoop Advice Count column to update the Advice Window.

Notice that the Estimated Cycles Per Iteration for the loop improves to 1 cycle. The Estimated Start Cycles is now 13 cycles.

**Trip Count**

66. In the Advice Window, click on the link to the Trip Count advice.
The problem statement indicates the compiler has no guarantee about the trip count of the loop. The primary suggestion suggests the use of the MUST_ITERATE pragma to indicate that the loop iterates at least 6 times. The alternate advice suggests using the –mh compiler option. In our case, we know that the loop must iterate 40 times, so we will apply the MUST_ITERATE pragma. In a real application, every call to DoLoop must be inspected to insure a loop count of at least 40.

67. If the source file is not already open, click on the source file name (C:\op6000\labs\lab9\DoLoop.c) at the top of the Advice Window to bring up the DoLoop.c file in the Editor.
68. Add 40 as the first argument to the MUST_ITERATE pragma.

**Before:** #pragma MUST_ITERATE(,,2);

**After:**

```c
#include "DoLoop.h"

void DoLoop(short *Input1, short *Input2, short * restrict Output){
    int i, Vector1, Vector2;
    short Weight1 = Weights[0];
    short Weight2 = Weights[1];

    ALIGNED_ARRAY(Input1);
    ALIGNED_ARRAY(Input2);
    ALIGNED_ARRAY(Output);

    #pragma MUST_ITERATE(40,,2);

    ...
    for (i = 0; i < LoopCount; i++)
    {
        Vector1 = Input1[i] * Weight1;
        Vector2 = Input2[i] * Weight2;
    }
}
```

69. Save the file with **File→Save** or **control+S**.

70. From the **Project** menu, choose **Build** or **click on the Build Icon**.

71. In the **Profile Viewer**, click on the Consultant tab if it is not active, and double-click on the DoLoop **Advice Count** column to update the Advice Window.

The Estimated Cycles Per Iteration remains at 1 cycle, and the Estimated Start Cycles remains at 13.

But the alternate loop, for low trip counts, is eliminated. This saves a small amount of runtime overhead, and fair amount of code space.

The Advice Count is now 0, and we have reduced the total cycle time from an initial value of 64 * 40 = 2560 cycles to 13 + (1* 40) = 53 cycles, or roughly a 48X improvement.
Throughout this lab we have been applying compiler optimization changes that not only affected performance, but also affected the code size. Code size versus performance is a trade-off that only the designer can make. To help you evaluate code size versus performance for the DoLoop function, you can use the CodeSizeTune tool, which we will discuss in the next chapter.

For more information, see the application note *Introduction to Compiler Consultant.*

---

**Change back to the ‘C67x Simulator**

Now that we’re done with this lab, we need to reconfigure the CCS setup to use the ‘C67x Simulator for future labs. Launch CCS Setup:

File → Launch Setup

When setup opens, the “Import Configuration” window appears. Follow the procedure found at the start of Lab 4. These are the basic steps:

- Clear the previous system configuration (button on right).
- Scroll through the list to find *C67xx CPU Cycle Accurate Sim, Ltl Endian*. Select this item and click ADD.
- Quit and save CCS Setup. When asked, allow CCS Setup to restart CCS for you.

---

**Change back to the ‘C672x Simulator**

Now that we’re done with this lab, we need to reconfigure the CCS setup to use the ‘C64xp Simulator for future labs. Launch CCS Setup:

File → Launch Setup

When setup opens, the “Import Configuration” window appears. Follow the procedure found at the start of Lab 4. These are the basic steps:

- Clear the previous system configuration (button on right).
- Scroll through the list to find *C672x CPU Simulator, Ltl Endian*. Select this item and click ADD.
- Quit and save CCS Setup. When asked, allow CCS Setup to restart CCS for you.

---

**Change back to the ‘C64xp Simulator**

Now that we’re done with this lab, we need to reconfigure the CCS setup to use the ‘C67x Simulator for future labs. Launch CCS Setup:

File → Launch Setup

When setup opens, the “Import Configuration” window appears. Follow the procedure found at the start of Lab 4. These are the basic steps:

- Clear the previous system configuration (button on right).
- Scroll through the list to find *C64xx CPU Cycle Accurate Sim, Ltl Endian*. Select this item and click ADD.
- Quit and save CCS Setup. When asked, allow CCS Setup to restart CCS for you.
Lab 11

The goal of this lab is to get your program running on the system described by the following block diagram. This requires translating this block diagram into the Config Tool’s MEM manager. Then use CCS to translate our object files into the final .OUT file.

![Block Diagram](image)

Note: If using the C6416 CPU, please use EMIFA for the lab exercise.

Notice, three addresses have been left for you to determine. Using the appropriate memory map, you should be able to fill in these three missing addresses.

**LAB11 Project Files**

The files included in this project/lab.

<table>
<thead>
<tr>
<th>File</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAB11.PJT</td>
<td>copy from LAB2 folder</td>
</tr>
<tr>
<td>MAIN.C</td>
<td>copy from LAB2 folder</td>
</tr>
<tr>
<td>LAB.TCF</td>
<td>copy from LAB2 folder, we’ll edit this file</td>
</tr>
<tr>
<td>LABCFG.CMD</td>
<td>copy from LAB2 folder</td>
</tr>
<tr>
<td>PROFILER.INI</td>
<td>copy from LAB2 folder</td>
</tr>
<tr>
<td>DATA.H</td>
<td>provided for you</td>
</tr>
</tbody>
</table>
Change Simulator Model

1. Since this lab explores system events beyond just the CPU, we need to reconfigure CCS to use a different simulator model.

Note: At this time there is only one simulator for the C672x family. It is a CPU simulator which means that a flat memory model is assumed. In other words, the simulator does not comprehend the timing of the External Memory Interface. If you have been using the C672x for your lab exercises you will not need to change the simulator configuration for this lab. Cycle counts for external memory accesses will not be accurate but external memory can be simulated.

Also, the C6455 simulator is not currently working in the CCSv3.3, so we suggest that you switch over to the C6416 device simulator, as described below.

Launch CCS Setup, either from within CCS or using the desktop icon.

File → Launch Setup

2. When setup opens, follow the procedure found in Lab 2a. These are the basic steps:
   - Clear the previous system configuration with the Remove All button.
   - Use the Family, Platform, Endianness filters to locate one of these configurations
     - C6416 Device Cycle Accurate Simulator, Little Endian
     - C6713 Device Cycle Accurate Simulator, Little Endian
   - Select this appropriate entry and click Add
   - Save and Quit the CCS Setup.

3. Start CCS.
Define Your System’s Memory Map

4. Using the diagram above, along with the memory maps (Student Notes pages 11-8 to 11-10), fill in the table for the processor you selected. You can choose to use either the C6713 or the C6416 devices.

Which device did you choose? _________________________________________________

<table>
<thead>
<tr>
<th>Memory</th>
<th>CE Space</th>
<th>Starting/Base Address</th>
<th>Length (hex bytes)</th>
<th>Type of Space (code/data/both)</th>
</tr>
</thead>
<tbody>
<tr>
<td>L2 Internal Mem (ISRAM)</td>
<td>CE0</td>
<td>0x0000 0000</td>
<td>Both</td>
<td></td>
</tr>
<tr>
<td>SDRAM (64M Bytes)</td>
<td>CE0</td>
<td>0x0400 0000</td>
<td>Both</td>
<td></td>
</tr>
<tr>
<td>Flash (4M Byte)</td>
<td>CE1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FIFO (32KB)</td>
<td></td>
<td>4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The TCF templates each name the L2 memory object differently:
- C64.TCF uses ISRAM
- C67.TCF uses IRAM

In this lab, you may see us refer to the L2 memory segment using either name. In each case, please substitute the name appropriate for your target.

Hint: From a hardware perspective, it is easier to design the target board if each of these memories are placed into separate memory regions.

Here’s a little conversion aid:

<table>
<thead>
<tr>
<th>Decimal</th>
<th>Hex</th>
</tr>
</thead>
<tbody>
<tr>
<td>1K</td>
<td>400</td>
</tr>
<tr>
<td>16K</td>
<td>4000</td>
</tr>
<tr>
<td>32K</td>
<td>8000</td>
</tr>
<tr>
<td>64K</td>
<td>1000</td>
</tr>
<tr>
<td>256K</td>
<td>4000</td>
</tr>
<tr>
<td>1M</td>
<td>10000</td>
</tr>
<tr>
<td>4M</td>
<td>40000</td>
</tr>
<tr>
<td>16M</td>
<td>100000</td>
</tr>
<tr>
<td>64M</td>
<td>400000</td>
</tr>
</tbody>
</table>

Why is the FIFO only 4 bytes long? _____________________________________________
Create project

5. Close any previous projects that may be open within CCS.

6. Using Windows Explorer, *COPY* the following files from C:\op6000\labs\lab2 to C:\op6000\labs\lab11. Please make sure to *COPY* these files.

   LAB2.PJT
   MAIN.C
   DATA.H
   LAB.TCF
   LABCFG.CMD
   PROFILE.INI

**Note:** Please make sure to *copy* the above files correctly.

7. In Code Composer Studio, and open C:\op6000\labs\lab11\lab.pjt.

Modify TCF File

8. In the TCF window, expand the +System and +MEM – Memory Section Manager.
9. Before creating memory objects, **verify your answers**:

<table>
<thead>
<tr>
<th>Memory</th>
<th>CE Space</th>
<th>Starting/Base Address</th>
<th>Length (hex bytes)</th>
<th>Type of Space (code/data/both)</th>
</tr>
</thead>
<tbody>
<tr>
<td>L2 Internal Mem</td>
<td>CE</td>
<td>0x0000 0000</td>
<td>0x0010 0000</td>
<td>Both</td>
</tr>
<tr>
<td>C6416 (ISRAM)</td>
<td></td>
<td></td>
<td>0x0004 0000</td>
<td></td>
</tr>
<tr>
<td>SDRAM (64M Bytes)</td>
<td>CE0</td>
<td>0x8000 0000</td>
<td>0x0400 0000</td>
<td>Both</td>
</tr>
<tr>
<td>Flash (4M Byte)</td>
<td>CET</td>
<td>0x9000 0000</td>
<td>0x0040 0000</td>
<td>Both</td>
</tr>
<tr>
<td>FIFO (32KB)</td>
<td>CE2 or CE3</td>
<td>0xA0000000 or 0xB0000000</td>
<td>4</td>
<td>Data</td>
</tr>
</tbody>
</table>

- Why use all three different external CE regions?
- Why is FIFO length only 4 bytes?
- What extra EMIF capability does the C6414/15/16 provide?

**Note:** If these results are different from yours, you may want to consult with the instructor before moving on.
10. **Create/Modify MEM objects** as needed using the tables from step #4.

Essentially, each row of the table should be converted into a MEM object.

Here’s a few more guidelines/hints:

- **Add** a new MEM object by right-clicking on *MEM-Memory Section Manager* and choosing *Insert MEM*. (Hint: you need to add four MEM objects.)
- **Modify** a MEM object by right-clicking on the object and selecting *Properties*.
- **Rename** a MEM object by right-clicking on the object and selecting *Rename*.
- **Disable heap** for FIFO. For the others, don’t worry about the heap property checkbox in your MEM objects; since we won’t be using the heap in this lab.
- **Notice** that you can select whether *code* or *data* or *code/data* can be placed in a MEM object. This property field helps the Config Tool to perform some rudimentary validation when assigning DSP/BIOS objects to memory. In other words, it helps us to prevent mistakes.
11. Place Sections into MEM objects.
   - Right-click on MEM – Memory Section Manager and choose Properties
   - Edit the dialogs as shown below

**BIOS Data:**
- Place the .stack into fast, on-chip data memory – as this is where local variables reside.
- The others are of no great concern, at this time.

**BIOS Code:**
- All of these should reside in *initialized* (ROM-like) memory.

---

**Note:** If you place `.hwi_vec` into a section which does not include address 0 (e.g. if you place it into FLASH or SDRAM in our example), you should enable the *Generate RESET vector at address 0* option.

This option is a property of HWI – Hardware Interrupt Service Routine Manager in the TCF file.
Compiler Sections:

- It’s best if .bss can be located in fast, on-chip data memory – as this is where global and static variables reside.
- .CIO should be located in uninitialized (RAM-like) memory. Since it is not used for real-time data capture, it’s suggested that you locate it in off-chip, bulk storage.
- .far is often located in off-chip RAM, unless there is additional space available in on-chip memory that it will fit into. This section is discussed further in the next chapter.
- The remaining sections should be placed into initialized (ROM-like) memory.

Load Address:

- Leave this advanced feature disabled.

12. Click OK to close the MEM properties dialog. Then save the TCF file.
Build / Load / Run

14. Build and load the program. (Build with the Debug configuration.)

15. Set a breakpoint at the end of main.

16. Run the program and verify the result.
   
   You can use the Watch window to view y. Alternatively, try hovering the cursor over y in the code window and its value should appear in a tool-tip fashion.

View Memory

Let’s examine another great debugging tool, the Memory View window.

17. Start by selecting view memory and configuring it as shown.

   View → Memory...

   ![Memory Window Options](image)

   Where is location “a”? ____________________

   Did you need to know this address before you could use the Memory window?

   Thanks to symbolic debugging, all you need to know is the symbol (variable, array, etc.) that you’re interested in.

18. If you increase the size of the resulting memory view, you’ll notice you can see both a and x.

   - You can change the properties of a memory window by right-clicking it and choosing Properties.
   - Open multiple memory windows, giving them each a different title.
   - The ease by which you can choose the data size, makes it easy to view arrays with memory windows.

19. Close the lab11.pjt project.
Page left blank...
Lab 13

Lab 13 – Internal Mem. and Cache

◆ Lab 13a – Find Memory Bank Conflicts
   
   Uses C6416 device simulator for this part

◆ Lab 13b – Compare the performance:
   1. Code/Data Off-Chip with No Cache
   2. Code/Data Off-Chip with Cache
   3. Code/Data On-Chip

◆ Lab 13c – (Optional) Exploring CacheTune
Lab 13a – Removing Memory Bank Stalls

Getting Started

Setup CCS

1. Make sure CCS is configured to use the *C6416 Device Cycle Accurate Simulator, Little Endian*. If not, use CCS Setup to change the configured target to one of the above simulators. These simulators simulate L1P, L1D, L2, and various other peripherals including the EMIF.

Note: This lab is for C64x and C64x+ users only. The C67xx does not have the same memory architecture and its users don’t need to worry about memory bank stalls in L1D. So, if you have been doing the labs for the C67xx, you can skip this lab and move on to Lab13b. If you have been doing the C67xx labs and you would still like to do this lab, ask your instructor where you can get the C64x or C64x+ files that you will need.

Creating a Project

2. Copy the following files from C:\op6000\labs\lab7 to C:\op6000\labs\lab13a.

   LAB7.PJT
   MAIN.C
   DOTP.SA
   LAB.TCF
   LABCFG.CMD
   PROFILER.INI
   DATA.H

3. Use Windows Explorer to rename the C:\op6000\labs\lab13\lab7.pjt file to lab13a.pjt by right clicking on it and choosing rename.

4. Open lab13a.pjt inside CCS.

Build, Run, and Profile

5. Build your code using the *Debug* configuration.

6. Check the value of y to make sure that it is correct.

7. Rebuild your project using the *Release* configuration.

8. Re-enable the breakpoint at the end of main().

9. Open the Profile Setup window.

   Profile → Setup
10. Enable the *Profile all Functions and Loops for Total Cycles* option.

![Profile Setup](image)

11. Click on the **Enable/Disable Profiling** icon to enable profiling.

12. Open the Profile Viewer.

   ```
   Profile → Viewer
   ```

13. Run your code.

14. How many cycles does the `dotp()` function take? ___________________________

**Finding Memory Bank Conflicts**

Are any of these cycles being wasted on Memory Bank Conflicts? Would you like to find out?

15. In order to change the Profile Setup to detect Memory Bank Stalls, we need to disable profiling.

   Disable profiling by clicking on the Enable/Disable Profiling icon.
16. Click on the custom tab in the Profile Setup window.

17. Click on the + next to CPU to expand it. Use the same technique to expand the stall category, and then the mem category.

18. Click in the box next to bank_conflict to enable it. This will tell the profiler to count all Memory Bank Conflicts.
19. Now that we’ve changed the Profile Setup, we can re-enable profiling with 

20. Reset the CPU.

   Debug → Reset CPU

21. Reload your program which was built with the *Release* configuration.

   File → Reload Program

22. Run your code.

23. Take a look at the Profile Viewer. You should see two new columns that count the number of inclusive and exclusive Memory Bank Conflicts.

   How many Memory Bank Conflicts are there in the *dotp()* function? ________________

---

**Using Pragmas**

We’ll now use a pragma to get rid of these wasted cycles.

24. Open *main.c* for editing.

25. Find the global declarations for the *a* and *x* arrays.

26. Add a *DATA_MEM_BANK* pragma to make sure that *a* and *x* do not have any memory bank conflicts. If you need some help, try looking up the pragma in the help file.

   **Hint:** You should make sure that the *a* and *x* arrays go into *different* memory banks.
Build, Run, and Profile

27. Reset the CPU.

   Debug → Reset CPU


29. Load your code if it doesn’t load automatically.

30. Run your code.

31. Profile your project with the DATA_MEM_BANK pragma. Use the results to fill in the table below:

<table>
<thead>
<tr>
<th>Dot-product Version</th>
<th>Cycles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lab13a – Step 23 (Release options)</td>
<td></td>
</tr>
<tr>
<td>Lab13a – Step 31 (Release options w/pragma)</td>
<td></td>
</tr>
</tbody>
</table>

Did the DATA_MEM_BANK pragma have any effect on your code?

32. Save your project and close it.

End of Lab13a – Go on to Lab13b on page 13 - 7
Lab 13b – Using Cache Memory

This lab allows you to re-examine the modem code used in the CodeSize Tune lab, this time comparing the code execution time while varying where the code and data reside:

- Off-Chip Memory (with no caching)
- Off-Chip Memory (with L1 and L2 cache)
- On-Chip Memory (with L1 cache)

**Note:** This lab requires the use of a Device Simulator and since the C672x simulator assumes flat memory it cannot be used with this lab. If you have been doing C672x labs you should reconfigure CCS for the C6713 Device Cycle Accurate Simulator.

Part 1 – Code/Data off-chip with no cache

**Setup CCS**

1. Make sure CCS is configured to use the C6416 Device Cycle Accurate Simulator, Little Endian, or the C6713 Device Cycle Accurate Simulator, Little Endian. If not, use CCS Setup to change the configured target to the appropriate simulator. These simulators simulate L1P, L1D, L2, and various other peripherals including the EMIF.

**Preparing for the Lab**

2. We are going to use the memory configuration that you set up in Lab 11. Copy the following files from C:\op6000\labs\lab11 to C:\op6000\labs\lab13b.

   LAB.TCF
   LABCFG.CMD

**Note:** If you used the C672x simulator for Lab 11 you should copy the two files above from the appropriate Lab 11 solutions directory for the simulator you are currently using. If you need help ask your instructor.

3. Open the project named LAB13b_64.PJT or LAB13b_67.PJT in the C:\op6000\labs\lab13b folder.

   For your convenience, we have already created the project for you. After creating the project, we added our three source files, and told the linker to create a map file for us (-m option).

4. Open LAB.TCF.
5. Make sure all sections will be placed into off-chip memory except `.hwi` and `.hwi_vecs`.

Right-click on MEM-Memory Section Manager. Choose Properties and verify that every uninitialized section is placed into SDRAM. Leave the sections that are placed in FLASH in FLASH. Under the BIOS Code Tab, leave the `.hwi` and `.hwi_vecs` sections in ISRAM since these contain the reset vector. Here is how we placed our C compiler sections:

![MEM - Memory Section Manager Properties](image)

**Note:** Make sure to make the necessary change to the memory configuration under all three tabs: BIOS Data, BIOS Code, and Compiler Sections. Make sure to leave `.hwi` and `.hwi_vecs` in ISRAM.


7. Build and load your program.

8. Open the appropriate `lab.map` in either the `C:\op6000\labs\lab13b\Release_64` or `C:\op6000\labs\lab13b\Release_67` folder and verify all the code and data except `.hwi` and `.hwi_vecs` are in off-chip memory.
**Counting Cycles**

9. **Set a breakpoint to stop execution.**
   
   Place the breakpoint at the second bracket from the **end** of the MODEMTX.C file.

   /* For benchmarking purposes we will comment out the while loop and run
   a single execution of the modem data. */
   // while(item)
   // {
   /* get modem data, convert to constellation points, and add noise. */
   ReadNextData();
   /* run modem on new data */
   for( i = 0; i < BAUD_PER_LOOP; i++ )
   {
       ModemTransmitter(i, &g_ModemData.OutputBuffer[i*SAMPLES_PER_BAUD]);
   }
   item += 1;
   // }

**Note:** When a breakpoint is set on a C621x/C671x/C64x device, the corresponding cache line is invalided. This means that cache overhead will occur every time through the loop. It is important to keep this in mind when profiling short sections of code with cache.

10. Run to main if you are not already there.

    **Debug → Go Main**

11. Enable and display the clock.

    **Profile → Clock → View**

**Hint:** To clear the Clock value, just double-click on the Clock window.

12. **Run your program.**

    Your program should run from main and stop at the breakpoint (if you have been following the instructions). If you had not yet run to main, your cycle count will be larger since the processor will have counted all of the cycles while your system was initialized (.sysinit).

**Hint:** If you need to start running the code from the beginning, you should first perform a **GEL → Resets → Reset_and_EMIF_Setup**, then a **Debug → Restart**.
13. **Record the clock value** in the first column of table at the end of this lab (page 13-15).

14. **Perform a GEL Reset and initialize the EMIF for the next part of the lab.**

    \[\text{GEL} \rightarrow \text{Resets} \rightarrow \text{RESET\_and\_EMIF\_Setup}\]
    \[\text{or}\]
    \[\text{GEL} \rightarrow \text{Resets} \rightarrow \text{ClearBreakPts\_Reset\_EMIFset}\]

    **Note:** This Reset is necessary to flush the cache and make sure that the EMIF is properly setup from one part of the lab to the next.

---

**Part 2 – Code/Data (still) off-chip with Cache Enabled**

Part 1 of this lab did not use cache at all. In fact, L2 cache is not only disabled, but the MARS bits for all of the external memory are disabled. In Part 2, we will turn on some L2 cache as well as enable caching of external memory.

15. **Open lab.tcf if is not already open.**

16. **Before we can turn on the L2 Cache, we need to make room for it by decreasing the size of the internal L2 SRAM.** Change the properties of ISRAM so that it starts at 0x0 and is 768KB long. Here is what is should look like:

![ISRAM Properties](image)
17. Before we can turn on the L2 Cache, we need to make room for it by decreasing the size of the internal L2 SRAM. Change the properties of IRAM so that it starts at 0x0 and is 192KB long. Here is what it should look like:
18. **Enable L2 Cache. Make all external memory cacheable.**

Open TCF file. Expand System. Right-click on Global Settings. Choose Properties and select the 641x tab.

![Global Settings Properties](image)

The L2 configuration is probably obvious. Rather than being set as addressable SRAM memory (4-way cache (0k)), it’s now set to act as a 4-way cache using ¼ of the internal memory of a 'C6416.

By changing the MAR lsb’s to “1” (which is what happens when you put 0xFFFF into the MAR fields) you have told the cache and EMIF hardware that the external memory is allowed to be cached.

**Hint:** The MARX-X – bitmask used to initialize MARs TCF field name is misleading.
- These bit values are “enable” values (as are MAR lsb’s), rather than “mask” bits.
- Both L1 and L2 are affected by the MAR registers. When a region of memory is marked as uncacheable, it won’t be found in either cache. (Note, though, that MARs do not affect L1P on the C64x+ devices.)
- While the field name states “0-15”, I suspect that a value of “0x0001” would actually set the LSB of MAR0 (as opposed to MAR15).
19. **Enable L2 Cache. Make all external memory cacheable.**

Open TCF file. Expand System. Right-click on Global Settings. Choose Properties and select the 621x/671x tab.

![Global Settings Properties](image)

The L2 configuration is probably obvious. Rather than being set as addressable SRAM memory (SRAM), it’s now set to act as a 4-way cache using ¼ of the internal memory of a 'C6713.

By changing the MAR lsb’s to “1” (which is what happens when you put 0xFFFF into the MAR0-15 field) you have told the cache and EMIF hardware that the external memory is allowed to be cached.

**Hint:** The MARX-X – bitmask used to initialize MARs TCF field name is misleading.
- These bit values are “enable” values (as are MAR lsb’s), rather than “mask” bits.
- Both L1 and L2 are affected by the MAR registers. When a region of memory is marked as uncachable, it won’t be found in either cache.
- While the field name states “0-15”, I suspect that a value of “0x0001” would actually set the LSB of MAR0 (as opposed to MAR15).

### Counting “Part 2” Cycles

20. **Rebuild and load your program.**

21. **Go to main if you are not taken there automatically.**

22. **Set a breakpoint in the MODEMTX.C file, as before.** (see page 13-9, step 9) if it is not already there.

23. **Clear the clock by double-clicking on it.**

24. **Run your program.** It should stop at the breakpoint.

25. **Record the clock value** in the second column of table at the end of this lab (page 13-15).
26. Perform a GEL Reset and initialize the EMIF for the next part of the lab.

   GEL → Resets → RESET_and_EMIF_Setup

   or

   GEL → Resets → ClearBreakPts_Reset_EMIFset

Part 3 – Code/Data located on-chip with L1 cache

27. Open your lab.tcf file.

28. Open the Properties for the MEM – Memory Manager and place all of your software sections into the internal ISRAM segment. Make sure to change all three of the section tabs, BIOS Code, BIOS Data, and Compiler Sections.

29. Close the Memory Manager Properties dialog and then your TCF file.
Counting “Part 3” Cycles
30. Rebuild and load your program.
31. Go to main if you are not already there.
32. Clear the clock.
33. Run your program. It should stop at the breakpoint.
34. Record the clock value in the third column of Lab Results table below.

Lab Results

<table>
<thead>
<tr>
<th>Code/Data Linked External</th>
<th>Code/Data Linked External</th>
<th>Code/Data Linked Internal (ISRAM)</th>
</tr>
</thead>
<tbody>
<tr>
<td>L2 = SRAM (no L2 cache)</td>
<td>L2 = 4-Way (L2 cache enabled)</td>
<td>L2 = ⅓ SRAM / ⅓ CACHE</td>
</tr>
<tr>
<td>MAR’s = 0000 (L1 effectively disabled)</td>
<td>MAR’s = 0xFFFF (L1/L2 eff. enabled)</td>
<td>MAR’s = 0xFFFF (L1 effectively enabled)</td>
</tr>
</tbody>
</table>

35. Which memory configuration is fastest? How did cache affect the results?
________________________________________________________________________
________________________________________________________________________

36. Was there a big advantage to linking your code and data into on-chip memory?
________________________________________________________________________
________________________________________________________________________

37. When might it make good sense (and cents) to link data on-chip?
________________________________________________________________________
________________________________________________________________________

End of Lab13b – Go on to Lab13c on page 13 - 16
Lab Debrief

While your results may differ slightly from these, they should be similar.

**Lab14a Results – Memory Bank Conflicts**

<table>
<thead>
<tr>
<th>Dot-product Version</th>
<th>Cycles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lab15a – Step 20 (Release options)</td>
<td>365*</td>
</tr>
<tr>
<td>Lab15a – Step 28 (Release options w/pragma)</td>
<td>282</td>
</tr>
</tbody>
</table>

*Includes 104 Memory Bank Conflict stalls as detected by the simulator*
Lab 14b Results

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MAR’s = 0x0000</td>
<td>MAR’s = 0xFFFF</td>
<td>MAR’s = xxxx</td>
</tr>
<tr>
<td></td>
<td>L2 Cache = SRAM (off)</td>
<td>L2 Cache = 4-WAY (on)</td>
<td>L2 = ¼ Cache &amp; ¾ SRAM</td>
</tr>
<tr>
<td>C64</td>
<td>7,418,733* cycles</td>
<td>263,617 cycles</td>
<td>3,091 cycles</td>
</tr>
<tr>
<td>C67</td>
<td>1,240,004* cycles</td>
<td>1,162,345 cycles</td>
<td>4,150 cycles</td>
</tr>
</tbody>
</table>

35. Which configuration is fastest? How did cache affect the results?
   On-chip is fastest, though turning on the cache made a huge difference!

36. Was there an advantage to linking your code and data into on-chip memory?
   Yes.

37. When might it make good sense (and cents) to link data on-chip?
   As discussed earlier, when the EDMA is moving data from/to a peripheral.

* This large delta is caused by different External Memory Configurations.

Lab 14b Results

16 & 17. The base was set to 0x0 since that’s where L2 begins.

Why did we set the length to 0xC0000 or 0x30000?
¾ L2 is 768K bytes or 192Kb

This page intentionally left blank.
Lab Topics

**iUniversal Lab Exercise** .................................................................14-1

*Lab 14a – Creating a Universal Algo..................................................14-2*
  - Running the GenCodecPkg wizard..................................................14-2
  - Import Codec Library Project into CCSv4 .....................................14-5
  - Customizing the Code to Fit Your Algorithm ..................................14-6
  - Create a CCS Project for our Test Algorithm ...............................14-11
  - Setup the new RTSC Config Project ..............................................14-15
  - Setup the Algorithm Test Project ..................................................14-17
  - Run and Debug Algorithm ............................................................14-18

*Test Application Code.........................................................................14-19*

*Lab 14b – Creating a "server" for your algorithm .................................14-23*
  - Copy the necessary files into the VM shared folder .......................14-23
  - File management in Linux ............................................................14-23
  - Make the DSP Server ....................................................................14-24
  - Build and Test the app and algo ....................................................14-24
Lab 14a – Creating a Universal Algo

Running the GenCodecPkg wizard

2. Invoke GenCodecPkg wizard.

Option 1: From CCSv4

Add your Codec Engine installation directory to the "Tool Discovery Path". Go to

Window | Preferences | CCS | RTSC

and verify the package codec_engine_2_26_01_09 shows up in the window. If so, check the box next to it and exit the preferences.

If it’s not there:
   a. Add this package from the C:/TI directory.
   b. Close and save the dialog.
   c. Restart CCS. (At this point, it’s the easiest way to restart workspace).
   d. Then reopen the same dialog to check the checkbox for the codec engine, then close the dialog.

At this point, you will have a new "Tools | Codec Engine Tools | GenCodecPkg" menu item that will launch the wizard. Go ahead and startup the wizard.

Option 2: Create a simple makefile to invoke the wizard

```
# Paths to required dependencies
XDC_INSTALL_DIR := C:/ti/xdctools/xdctools_3_20_03_63
CE_INSTALL_DIR := C:/ti/codec_engine/codec_engine_2_26_01_09
XDAIS_INSTALL_DIR := $(CE_INSTALL_DIR)/cetools

# Create an XDCPATH variable
export XDCPATH = $(CE_INSTALL_DIR)/packages;$ (XDAIS_INSTALL_DIR)/packages

.PHONY : gencodecpkg
gencodecpkg:
   $(XDC_INSTALL_DIR)/xs ti.sdo.ce.wizards.gencodecpkg
```

From the command-line, start the wizard with: make gencodecpkg

   ![Codec Engine GenCodecPkg Wizard](image)

   a. Click 3rd option, "I want to create an algorithm from scratch".
   b. The XDAIS directory should already point to your XDAIS directory (frequently the 
      $(CE_INSTALL_DIR)/cetools directory if you're not using a SDK).
   c. Click Next.

   Sidenote

   When downloading the Codec Engine (stand-alone) from TI, you can
   choose either the standard or lite versions.

   The standard version contains an extra cetools directory which includes a
   number of additional packages which CE depends on – such as XDAIS.

   The SDK team has chosen to install the lite version; then they install all the
   other packages at the root level of the SDK directory.

- In the "Module" field enter the name of the algorithm you're creating: MIXER
- In the "Vendor" field enter your company name: TTO
- Under "Base Interface" choose: IUNIVERSAL
- We want to build for C64x+ devices, so for "Target" choose: C64P COFF
- The Destination Directory is where the generated files will be placed. Click the button and create (and then select) the directory shown above.
- The C6000 TI 'cgtools' Directory should point to your TI DSP compiler (the root of the compiler installation, just above above the "bin" directory). When invoking the wizard from within CCSv4, this is probably already set for you.
- Check “Expert Mode” and change the “Package Name” to match that above. (While not required, we wanted to organize our files in this way.)
- Make sure that “Generate CCSv4 project” is checked.
- Click Finish to generate the starter files.

**Common Mistake**

Make sure you change the Package Name, so that your directory paths are named like those in this lab write-up.
5. View wizard's generated output files.

The generated files will reside at:

C:\op6000\labs\lab14a_build_algo\tto\codecs\mixer

< repository >          < package name >

Import Codec Library Project into CCSv4

6. Open CCSv4 and “Import Existing Project”.

Import the codec wizard project we just created in:

C:\op6000\labs\lab14a_build_algo

7. Select the project you just imported and build it.

Before making any changes, you should be able to build the generated package as is. It’s worth verifying the generated files build correctly.

Select Project | Right-Click | Build Project
8. **Setup code completion for CCSv4.**

A good reason to use CCS is to take advantage of features like code completion. Later, when debugging, if you press <Ctrl> <Space> on your keyboard you can invoke the Eclipse code completion feature, which will help to finish typing the names of variables, functions, etc. You will likely want CCS to have the capability of auto-completing names/fields related to XDAIS’s IALG libraries.

To set this up, do the following:

a. Right-click on your project in the "C/C++ Projects" window and select Properties.
b. Click on "C/C++ Include Paths & Symbols".
c. Click "Add External Include Path".
d. Click "Browse" and navigate to the appropriate source directory. Specifically for IALG definitions, you need to point to `<xdais>\packages`.

```
C:\TI\codec_engine_2_26_01_09\cetools\packages
```

**Note**
The XDAIS path shown in this step assumes that you have installed the full version of the Codec Engine, which includes a number of other libraries in the "cetools" directory. If you happened to install the "lite" version of the Codec Engine, then you would need to have installed the XDAIS library separately – and would want to use that path instead.
Customizing the Code to Fit Your Algorithm

We have chosen to implement a 2-channel mixer algorithm. This algo takes two buffers, weights them each with their own gain value, then adds the buffers together.

Here is the data we will need to pass to our algo’s _process() function:

- Two **InBufs**
- One **OutBufs**
- Two Additional elements for **InArgs**:
  - gain0
  - gain1

**Before**
- **tto.codecs.mixer [Active]**
  - Includes
  - lib
  - package
  - mixer_tto_priv.h
  - mixer_tto.h
    - t/dais/dm/universal.h
    - t/dais/alg.h
    - MIXER_TTO_IMIXER_
      - IMIXER_PARAMS
      - MIXER_TTO_IALG
      - MIXER_TTO_IMIXER
    - IMIXER_DynamicParams
      - base
      - IMIXER_InArgs
      - IMIXER_InArgs
      - base
      - IMIXER_OutArgs
      - IMIXER_OutArgs
      - base
      - IMIXER_Params
      - IMIXER_Params
      - base
      - IMIXER_Status
      - IMIXER_Status
      - base
  - mixer.c

**After**
- **tto.codecs.mixer [Active]**
  - Includes
  - lib
  - package
  - mixer_tto_priv.h
  - mixer_tto.h
    - t/dais/dm/universal.h
    - t/dais/alg.h
    - MIXER_TTO_IMIXER_
      - IMIXER_PARAMS
      - MIXER_TTO_IALG
      - MIXER_TTO_IMIXER
    - IMIXER_DynamicParams
      - base
      - IMIXER_InArgs
      - base
      - gain0
      - gain1
9. Modify the algo’s data structures.

Since the buffers descriptors can take a variable number of buffers, we don’t really need to
modify the wizard’s output for them. We will have to add the gain variables to our code, though.

Please refer to the “Getting Started with IUNIVERSAL” wiki page – Step 4: Customizing the Code
to Fit Your Algorithm. (We provided this in PDF format in the lab14_starter_files folder.)

Some hints on what to edit when following the Getting Started with IUNIVERSAL:

**mixer_tto_priv.h**

e. Edits to <module>_<vendor>_priv.h:
   
   No changes needed...

**mixer_tto.h**

f. Edits to <module>_<vendor>.h (in our case: mixer_tto.h):

   - Define commands for use in the control() function.
     
     No changes needed...

   - Extend the I<MODULE>_Params as needed.
     
     No changes needed...

   - Extend the I<MODULE>_InArgs structure as needed.
     
     typedef struct IMIXER_InArgs {
     /* This must be the first field */
     IUNIVERSAL_InArgs base;
     XDAS_Int16 gain0;
     XDAS_Int16 gain1;
     };

     No changes needed...

   - Extend the I<MODULE>_OutArgs structure as needed.
     
     No changes needed...

   - Extend the I<MODULE>_DynamicParams structure as needed.
     
     No changes needed...

   - Extend the I<MODULE>_Status structure as necessary.
     
     No changes needed...
Lab 14a – Creating a Universal Algo

Edits to <module>.c

- const I<MODULE>_Params I<MODULE>_PARAMS
- <MODULE>_<VENDOR>_alloc()
- <MODULE>_<VENDOR>_free()
- <MODULE>_<VENDOR_initObj()
- <MODULE>_<VENDOR>_process()

This is where the actual algorithm goes! Add your algorithm code here.

Note, we provided the entire process() function code for you to cut/paste to help minimize typos.

```c
/*
 *  ======== MIXER_TTO_process ========
 */
/* ARGSUSED - this line tells the TI compiler not to warn about unused args. */
XDAS_Int32 MIXER_TTO_process(IUNIVERSAL_Handle h,
   XDM1_BufDesc *inBufs, XDM1_BufDesc *outBufs, XDM1_BufDesc *inOutBufs,
   IUNIVERSAL_InArgs *universalInArgs,
   IUNIVERSAL_OutArgs *universalOutArgs)
{
  XDAS_Int32 numInBytes, i;
  XDAS_Int16 *pIn0, *pIn1, *pOut, gain0, gain1;

  /* Local casted variables to ease operating on our extended fields */
  IMIXER_InArgs *inArgs = (IMIXER_InArgs *)universalInArgs;
  IMIXER_OutArgs *outArgs = (IMIXER_OutArgs *)universalOutArgs;

  /* Note that the rest of this function will be algorithm-specific. In
  * the initial generated implementation, this process() function simply
  * copies the first inBuf to the first outBuf. But you should modify
  * this to suit your algorithm's needs.
  */

  /* Validate arguments. You should add your own algorithm-specific
   * parameter validation and potentially algorithm-specific return values.
   */
  if ((inArgs->base.size != sizeof(*inArgs)) ||
      (outArgs->base.size != sizeof(*outArgs))) {
    outArgs->base.extendedError = XDM_UNSUPPORTEDPARAM;
    return (IUNIVERSAL_EUNSUPPORTED);
  }

  /* validate that there's 2 inBufs and 1 outBuf */
  if ((inBufs->numBufs != 2) || (outBufs->numBufs != 1)) {
    outArgs->base.extendedError = XDM_UNSUPPORTEDPARAM;
    return (IUNIVERSAL_EFAIL);
  }

  /* validate that buffer sizes are the same */
  if (inBufs->descs[0].bufSize != inBufs->descs[1].bufSize)
    return IUNIVERSAL_EFAIL;
  if (outBufs->descs[0].bufSize != inOutBufs->descs[0].bufSize)
    return IUNIVERSAL_EFAIL;
```

Continued
on next page

C6000 Optimization Workshop - iUniversal Lab Exercise

Lab 14 - 9
Lab 14a – Creating a Universal Algo

// DO IT!
pIn0 = (XDAS_Int16*)inBufs->descs[0].buf;
pIn1 = (XDAS_Int16*)inBufs->descs[1].buf;
pOut = (XDAS_Int16*)outBufs->descs[0].buf;
gain0 = inArgs->gain0;
gain1 = inArgs->gain1;
numInBytes = inBufs->descs[0].bufSize;

for(i=0; i<numInBytes/2; i++)
{
    pOut[i] = (pIn0[i]*(XDAS_Int32)gain0 + pIn1[i]*(XDAS_Int32)gain1) >> 15;
}

/* report how we accessed the input buffers */
inBufs->descs[0].accessMask = 0;
XDM_SETACCESSMODE_READ(inBufs->descs[0].accessMask);
inBufs->descs[1].accessMask = 0;
XDM_SETACCESSMODE_READ(inBufs->descs[1].accessMask);

/* report how we accessed the output buffer */
outBufs->descs[0].accessMask = 0;
XDM_SETACCESSMODE_WRITE(outBufs->descs[0].accessMask);

/* Fill out the rest of the outArgs struct, including any extended 
* outArgs your algorithm has defined. 
*/
outArgs->base.extendedError = 0;
return (IUNIVERSAL_EOK);

--- <MODULE>_<VENDOR>_control()

- By default this function already supports the required command 
  XDM_GETVERSION.

- There is an #ifdef 0 that you can get rid of to add handling for any commands 
  that you defined in <module>_<vendor>.h, (i.e. mixer_tto.h).

10. Build your modified algorithm to verify it’s free from C language errors.

Use CCSv4 to build the algorithm. Keep debugging the algorithm until it builds correctly.

In the next part, we will test the algorithm to verify it is logically correct. For now, we just 
want to make sure we have not introduced any C errors.
Lab 14a – Creating a Universal Algo

Create a CCS Project for our Test Algorithm

11. Create a new CCS Project.

12. Name and locate the project as shown below.

13. Choose the C6000 compiler target.
14. Select your codec project as a *dependent* project.
   This makes it easy to debug code from both projects at the same time.

![New CCS Project](image)

15. Set the project settings for running on the C64x+ DSP.

![Project Settings](image)

Choose:
- g. Generic C64x+ Device
- h. Little endian
- i. The default TI DSP compiler

and then hit **Next**.

**Avoid Common Mistake**
Make sure you click NEXT!
16. Create an *Empty RTSC Project*.

We want to create a RTSC project so we can make use of our new RTSC packaged algorithm. So, choose *Empty RTSC Project* and click *Next*.

17. Create a “separate, reusable RTSC Configuration project”.

Based on the “*Empty RTSC Project*” template from the previous dialog box, CCS will ask if you already have a RTSC config project or want to create a new one. In our case, we’ll be creating a new one.

While we could just add the RTSC config info to our current project (item 1 below), we have chosen to create a stand-alone RTSC config project.

When you select this option, CCS will create a new CCS project (of type RTSC Config Project). This means you’ll actually have 3 CCS projects now:

j. Algorithm
k. Test application
l. RTSC configuration

The RTSC configuration project is the way CCS can run Configuro. This is similar to adding the Configuro step to our makefile in previous labs.
18. Choose the CCSv4 installed packages that will be included with the project.

Fill-out the dialog as shown above, then click Finish.

Note: we’ll add more packages in our `codec.cfg` file in an upcoming step.

19. You should now see three projects:
Setup the new RTSC Config Project

20. Add the CE and BIOS configuration files to your new RTSC config project.

The Configuro allows us to consume RTSC packages that are specified in a .cfg file.

In CCS, we will need to add our .cfg file to the RTSC configuration project. In this way, it will end up doing the same thing as our Configuro command performed in our standard make file.

You can right-click on the mixer_tto_app_configuration project, select Add File to Project..., and add the following files from the Lab14a starter files:

```text
ce_test.cfg
cd_test.tcf
codec.cfg
```

from C:\op6000\labs\lab14a_starter_files\config

At the end of this step, your project should look something like:

![Project Structure](image)

**Important !!!**

Make sure that “codec.cfg” is the file which is excluded from the build.

You can do this by right-clicking on the individual files and selecting whether to include/exclude it from the build process.

The reason we’re excluding codec.cfg is that it’s actually included (similar to #include) into ce_test.cfg. The XDC tools require the .cfg and .tcf files to be named the same.


So many folks miss this little item, we decided to call it out specifically.

22. Tell the config project to read both .tcf and .cfg files.

Right-click and open the properties of the mixer_tto_app_configuration project and check the box under the: C/C++ Build | Advanced Options:
23. While you have the properties open, we need to add to the search path (i.e. XDCPATH).

Our config project needs two more paths added to its XDCPATH search list:

C:\TI\CCSv4\bios_5_41_07_24\packages
C:\op6000\labs\lab14a_build_algo

Without adding the lab14a path, the config project wouldn’t be able to find the algorithm we’ve just created.
Setup the Algorithm Test Project

The test project allows us to run and test our algorithm. Without this project, we wouldn’t know if the algorithm really gives the correct answer. We know it builds, but we also want to know it works logically, too.

24. **Add the test program — main.c.**

We have written a simple test application that will use the UNIVERSAL VISA calls to test your algorithm.

Right-click `mix_tto_app` and select **Add Files to Project…**

Add the following file to your project:

```
C:\op6000\labs\lab14a_starter_files
```

25. **Create a Target Configuration File for the C64x+ Simulator.**

CCSv4 uses **Target Configuration Files** to specify which target you want to run (i.e. debug) your code on. (In CCSv3.3, you were required to run CCS Setup which set the target for all projects withing CCS. CCSv4 allows each project to define a different target it will run on, which is very nice.)

New | Target Configuration Files

Name the file something like `C6437_Sim` and let’s just choose to use the shared location. (The shared location just means that every project in the workspace can use this Target Config file).

26. **Build the test application.**

You shouldn’t have any errors to fix … our fingers are crossed.
Run and Debug Algorithm

27. Start a debug session.

Click the debug icon to start a debug session and download the program to the simulator. Also, CCSv4 will change to a debug perspective (i.e. window layout).

28. Set breakpoints on the 4 VISA functions in our `main()` function.

    MIXER_create()
    MIXER_process()
    MIXER_control()
    UNIVERSAL_delete()

29. Set breakpoints in the algorithm, too.

One of the big conveniences of debugging our test application – along with the algorithm library package as a dependent project – is the ability to set breakpoints right in the algo itself.

Click on the C/C++ perspective button to go back into the project/editing window layout.

Navigate to the `mixer.c` file (in the `tto.codecs.mixer` project) and set a breakpoint inside the `MIXER_TTO_process()` function. For example, maybe set a breakpoint on the line:

    if ((inArgs->base.size != sizeof(*inArgs)) ||

30. Return to the Debug perspective and run/step thru the code.

Some hints when running the debugger.

    Run  Halt  Close Debugger  Step Into  Step Over  Asm  Step Into/Over  Restart

Note, you may see an error after the `MIXER_control()` call returns. At this point, the string return is not working properly. Sorry, we’ll figure it out later ... or you can take on the challenge.

31. When you’re finished testing the code, close the debugger.

You can also close CCSv4 now, too — if you want to.
Test Application Code

//============================================================================
//    FILE NAME : main.c
//    ALGORITHM : MIXER
//    VENDOR : TTO
//    TARGET DSP: C64x+
//    PURPOSE : This file contains code to test the MIXER algorithm.
// Nextxen Algorithm Wizard Version 1.00.00 Auto-Generated Component
// Creation Date: Mon - 17 January 2011
// Creation Time: 12:51 AM
//============================================================================

#include <xdc/std.h>
// which includes: stdarg.h, stddef.h
#include <ti/sdo/ce/CERuntime.h>
#include <ti/sdo/ce/osal/Memory.h>             // Contiguous memory alloc functions
#include <ti/sdo/ce/universal/universal.h>
// which includes: iuniversal.h, xdm.h, ialg.h, xdas.h, Engine.h, visa.h, skel.h
#include <stdint.h>                            // used for definitions like uint32_t, ...
#include <string.h>                            // used for memset/memcpy commands

// Note1: Make sure you have added this algorithms repository as a -i compiler option;
// that is, make sure the path that contains the folder "tto" is provided as a -i include
// path. The compiler will concatenate the -i path, along with the specified in the <> to
// find the actual header file.
// Note2: The 'mixer_tto.h' header also includes: imyalg.h
#include <tto/codecs/mixer/mixer_tto.h>

//============================================================================
//    Prototypes
//============================================================================
int main ( void );
void setup_IMIXER_buffers ( void );
void error_check ( Uint32 event, XDAS_Int32 val );

//============================================================================
//    Global/Static Variables
//============================================================================
#define PROGRAM_NAME        "universal_test"
#define ENGINE_NAME         "myEngine"
#define ALGO_NAME           "mixer"
static String             sProgName    = PROGRAM_NAME;
static String             sEngineName  = ENGINE_NAME;
static String             sAlgoName    = ALGO_NAME;
static Engine_Handle      hEngine      = NULL;
static UNIVERSAL_Handle   hUniversal  = NULL;
```c
static IMIXER_Params         myParams;
#define IN_BUFFER_SIZE 20
#define OUT_BUFFER_SIZE 20
#define INOUT_BUFFER_SIZE 16
#define STATUS_BUFFER_SIZE 16
static XDAS_Int8   *in0;              // [IN_BUFFER_SIZE];
static XDAS_Int8   *in1;              // [IN_BUFFER_SIZE];
static XDAS_Int8   *out0;             // [OUT_BUFFER_SIZE];
static XDAS_Int8   *status0;          // [STATUS_BUFFER_SIZE];
static XDM1_BufDesc  myInBufs;
static XDM1_BufDesc  myOutBufs;
static XDM1_BufDesc  myInOutBufs;
static IMIXER_InArgs         myInArgs;
static IMIXER_OutArgs        myOutArgs;
static IMIXER_DynamicParams  myDynParams;
static IMIXER_Status  myStatus;
#define RETURN_ERROR 0
#define RETURN_SUCCESS 1
static unsigned int         funcReturn  = RETURN_SUCCESS;
static XDAS_Int32           rStatus     = 0;
// ===========================================================================
// MIXER_ Function Macros
// The following three macros make it easier to call the algorithm's create, process,
// and control methods. They provide recasting of the functions and arguments from
// the MIXER algorithm, to the UNIVERSAL API. This is needed since the Codec Engine
// framework implements the common API, which provides portability and ease-of-use.
//
#define MIXER_create(hEngine, sAlgoName, Params)
    UNIVERSAL_create(hEngine, sAlgoName, (IUNIVERSAL_Params *)&Params)
#define MIXER_process(hUniversal, InBufs, OutBufs, InOutBufs, InArgs, OutArgs)
    UNIVERSAL_process(hUniversal,
                      &InBufs,
                      &OutBufs,
                      &InOutBufs,
                      (IUNIVERSAL_InArgs *)&InArgs,
                      (IUNIVERSAL_OutArgs *)&OutArgs )
#define MIXER_control(hEngine, eCmdId, DynParams, Status)
    UNIVERSAL_control(hEngine,
                      eCmdId,
                      (UNIVERSAL_DynamicParams *)&DynParams,
                      (UNIVERSAL_Status *)&Status )
// ===========================================================================
// Functions
//
int main(void)
{
    // --- Open the Codec Engine ---------------------------------------------
    CERuntime_init();
    hEngine = Engine_open(sEngineName, NULL, NULL);
    error_check(TEST_ENGINE_OPEN, (XDAS_Int32) hEngine);
```
//  ====  Create an Algo Instance ============================================
// Initialize the params used for the create call
myParams.base.size = sizeof(IMIXER_Params);

// The MIXER_create() function creates an instance of our algorithm; you
// can call the generic UNIVERSAL_create() function, but you would need to
// correctly cast the parameters. The iMIXER.h file defines macros which
// simplify the _create, _process, and _control function calls.
hUniversal = MIXER_create(hEngine, sAlgoName, myParams);
error_check(TEST_ALGO_CREATE, (XDAS_Int32) hUniversal);

//  ====  Run the Algorithm ==================================================
setup_IMIXER_buffers();

// Default values were applied; please change if you want to select other values.
myInArgs.base.size = sizeof(IMIXER_InArgs);
myInArgs.gain0 = 0x3fff;
myInArgs.gain1 = 0x3fff;

// IMIXER_OutArgs was not extended, so no additional values must be set in myOutArgs.
myOutArgs.base.size = sizeof(IMIXER_OutArgs);

rStatus = MIXER_process(hUniversal, myInBufs, myOutBufs, myInOutBufs, myInArgs, myOutArgs);
error_check(TEST_ALGO_PROCESS, rStatus);

//  ====  Call Algo control function =========================================
// IMIXER_DynamicParams was not extended, so no additional values must be set
myDynParams.base.size = sizeof(IMIXER_DynamicParams);
myStatus.base.size = sizeof(IMIXER_Status);

rStatus = MIXER_control(hUniversal, XDM_GETVERSION, myDynParams, myStatus);

if (!rStatus)
{
    printf("Program '%s': Algo '%s' control call succeeded\n", sProgName, sAlgoName);
    printf("Alg version: %s\n", (rStatus == UNIVERSAL_EOK ?
            ((char *)myStatus.base.data.descs[0].buf) : ":[unknown]");
}
else
{
    fprintf(stderr, "Program '%s': ERROR: Algo '%s' control call failed;
            rStatus=0x%x\n", sProgName, sAlgoName, (unsigned int) rStatus);
}

//  ====  Delete and Close the Algo Instance =================================
UNIVERSAL_delete(hUniversal);
Engine_close(hEngine);

//  ====  Return from Main Function =========================================
#else defined_DEBUG
    printf("Program '%s': Function main() now exiting.\n", sProgName);
#endif
    return(funcReturn);
}
void setup_IMIXER_buffers(void)
{
    // ---- ALLOCATE BUFFERS ---------------------------------------------

    // - Buffers are allocated with the Codec Engine's contigAlloc function
    // - On ARM, this fn alloc's memory from the CMEM driver, which is req'd
    //   when passing data to the DSP. A contiguous allocation is make when
    // run on the DSP, but this maps to a simple MEM allocation.
    // - This prevents a failure on architectures like OMAP3530 which provide
    //   an MMU in the DSP's memory path.

    in0    = Memory_contigAlloc( IN_BUFFER_SIZE, 8 );
in1    = Memory_contigAlloc( IN_BUFFER_SIZE, 8 );
out0    = Memory_contigAlloc( OUT_BUFFER_SIZE, 8 );
status0 = Memory_contigAlloc( STATUS_BUFFER_SIZE, 8 );

    // ---- INITIALIZE BUFFERS -------------------------------------------

    // - We chose to use a simple data set for testing our algorithm.
    // - In "real" life you would want to enhance this test program with test
    //   data that validates your algorithm.

    memset( in0,    0xA, IN_BUFFER_SIZE    );
    memset( in1,    0xB, IN_BUFFER_SIZE    );
    memset( out0,   0x0, OUT_BUFFER_SIZE   );

    // --- Setup buffer descriptors for calls used in the MIXER_process()
    //    and MIXER_control() functions

    myInBufs.numBufs   = 2;
    myInBufs.descs[0].bufSize = IN_BUFFER_SIZE;
    myInBufs.descs[0].buf  = (XDAS_Int8 *) in0;
    myInBufs.descs[1].bufSize = IN_BUFFER_SIZE;
    myInBufs.descs[1].buf  = (XDAS_Int8 *) in1;

    myOutBufs.numBufs  = 1;
    myOutBufs.descs[0].bufSize = OUT_BUFFER_SIZE;
    myOutBufs.descs[0].buf   = (XDAS_Int8 *) out0;

    myInOutBufs.numBufs  = 0;

    myStatus.base.data.numBufs  = 1;
    myStatus.base.data.descs[0].bufSize  = STATUS_BUFFER_SIZE;
    myStatus.base.data.descs[0].buf   = (XDAS_Int8 *) status0;
}
Lab 14b - Creating a "server" for your algorithm

Now that you’ve proven your algorithm works on a single CPU DSP system, we can wrap our algorithm into a server and call it from Linux on the ARM.

Copy the necessary files into the VM shared folder

1. Create the folder lab14b_run_algo in vm_images\shared.

2. Create the following directory.

   C:\vm_images\shared\lab14b_run_algo

We can’t implement these steps in the Optimization Workshop, since they depend upon us having an ARM+DSP processor with a Linux Build environment.

If you’re interested in trying this out, we suggest you go access the Linux VMware image, lab files, and instructions from the following workshop:

OMAP™/DaVinci™/Sitara™/Integra™ System Integration using Linux Workshop
http://processors.wiki.ti.com/index.php/OMAP%E2%84%A2/DaVinci%E2%84%A2_System_Integration_using_Linux_Workshop

3. Create the server folder.

   C:\vm_images\shared\lab14b_run_algo\server

4. Copy the algorithm into the lab14b_run_algo folder.

   C:\vm_images\shared\lab14b_run_algo\tt0\codecs\mixer

File management in Linux

5. Copy the entire lab14b_run_algo folder into ‘labs’.

   C:\vm_images\shared\lab14b_run_algo

6. Copy the makefile from lab14a_server and edit XDCPATH.

   Copy the makefile from your lab14a_server folder into the lab14b_build_algo server folder

   C:\vm_images\shared\lab14b_build_algo\app

   Verify that your current lab path is included in the XDCPATH correctly.

7. Copy the makefiles from lab14b_build_server/app to lab14b_build_algo/app and edit them.

   After copying the two makefiles: (1) verify that your new codec package is on the XDCPATH; and, (2) remove the OSD file from the INSTALL_OSD_IMAGE variable.

   INSTALL_OSD_IMAGE := ../osdfiles/ti_rgb24_640x80.bmp
8. Copy the app_cfg.cfg from lab14a_build_server/app to Lab14b_run_algo/app.

   Again, we need to only make one small edit. Change the engine name from “encodedecode”
   to “myEngine” – which is the name used in our main.c file.

Make the DSP Server

9. Switch to the Lab14b_run_algo/server folder and run the DSP Server using the wizard.

   Follow the steps from lab12a_build_server to create a new server using the “mixer” codec.

   Use the same platform and server package name as we’ve done in the past, but remember to
   use the repo location: /home/user/labs/lab14a

10. Build the server.

Build and Test the app and algo

11. Switch to the lab14b_build_algo/app directory and build/install the test application.

        make debug install

12. Switch over to Tera Term and run the application.

   If you’ve reset the EVM, make sure you run loadmodules.sh before running the application.
   You should see a printf statement output as the program completes each VISA call. (You can
   review the main.c code to find these printf’s in the test app – or add more if you’d like to
   trace things more closely...)
Chapter 1

Module 1 Exam

1. Functional Units
   (5 pts) a. How many can perform an ADD? Name them.
      six; .L1, .L2, .D1, .D2, .S1, .S2
   (5 pts) b. Which support memory loads/stores?

2. C6000 Memories and Busing
   (5 pts) a. What is the advantage of L1 memory?
      Fastest memory on the device (single-cycle; zero waitstates)
   (5 pts) b. What does the EDMA3 stand for ... and do?
      Enhanced DMA version 3 – transfer blocks of memory
   (5 pts) c. What is an SCR master?
      A CPU or peripheral that can initiate a data transfer across
      the Switched Central Resource (SCR) (aka TeraNet)

3. Conditional Code
   (10 pts) a. Which registers can be used as cond’l registers?
      A1, A2, B0, B1, B2  (‘C64x allows A0, too)
   (10 pts) b. Which instructions can be conditional?
      All of them

4. Performance
   (5 pts) a. What is the ‘C6201 instruction cycle time?
      5 ns  (C6201 can run up to 200 MHz)
   (10 pts) b. How can the ‘C6201 execute 1600 MIPs?
      1600 MIPs = 8 instructions (units) x 200 MHz
      How many MIPs can the ‘C6678 execute?
      80,000 MIPs* (8 instructions x 1.25 GHz x 8 core’s)

   * not counting the affect of Packed Data Processing (like ADD4)
4c. Performance

(10 pts) c. How many 16-bit MMACs (millions of MACs) can the 'C6201 perform?

400 MMACs  (two .M units x 200 MHz)

How about C674x or C66x cores?

<table>
<thead>
<tr>
<th>CPU Core (example device)</th>
<th>C64x ('C6416)</th>
<th>C64x+ ('C6416)</th>
<th>C674x ('C6A8168)</th>
<th>C66x ('C6678)</th>
</tr>
</thead>
<tbody>
<tr>
<td>MMACS (16x16)</td>
<td>4,000</td>
<td>10,000</td>
<td>12,000</td>
<td>40,000</td>
</tr>
<tr>
<td># .M units</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td># MACS per .M per cycle</td>
<td>x 2</td>
<td>x 4</td>
<td>x 2</td>
<td>x 16</td>
</tr>
<tr>
<td>Speed</td>
<td>x 1 GHz</td>
<td>x 1.2 GHz</td>
<td>x 1.5 GHz</td>
<td>x 1.25 GHz</td>
</tr>
<tr>
<td>Total</td>
<td>= 4000</td>
<td>= 10000</td>
<td>= 12000</td>
<td>= 40000</td>
</tr>
</tbody>
</table>

5a - 5b. Coding Problems

(5 pts) a. Move contents of A0 ➔ A1

MV  A0, A1
or  ADD  A0, 0, A1
or  AND  A0, -1, A1
or  OR  A0, 0, A1

(5 pts) b. Clear register A5

ZERO  A5
or  SUB  A5, A5, A5
or  MPY  A5, 0, A5
or  CLR  A5, 0, 31, A5
or  CLR  0, A5
or  XOR  A5, A5, A5
or  AND  A5, 0, A5
5c - 5e. Coding Problems

(5 pts) c. \( A_2 = A_0^2 + A_1 \)

MPY.M1 A0, A0, A2
ADD.L1 A2, A1, A2

(10 pts) d. If \( B_1 \neq 0 \) then \( B_2 = B_5 \times B_6 \)

[B1] MPY.M2 B5, B6, B2

(5 pts) e. Load an unsigned constant (0x19ABC) into register A6.

see next two slides

5e. Solutions that Don’t Work

mvk 0x19abc, a6 ➔ mvk 0x9abc, a6

A6 F F F F 9 A B C

mvkl 0x9abc, a6
mvkh 1, a6 ➔ mvkl 0x00009abc, a6
mvkh 00000001, a6

mvkl
mvkh

F F F F 9 A B C

0 0 0 0 9 A B C
5e. Solutions that Work

mvkl 0x00019abc, a6
mvkh 0x00019abc, a6
F F F F
9 A B C

mvkl
mvkh

F F F F
0 0 0 1
9 A B C

5f. Coding problems

(10 pts) f. Load A7 with contents of mem1 and post-increment the selected pointer.

load_mem1: MVKL .S1 mem1, A6
          MVKH .S1 mem1, A6
          LDH .D1 *A6++, A7
Chapter 3

1. Pipeline

(a) Name and describe the three primary pipeline stages.

Program-Fetch, Decode, Execute

Program-Fetch: PG, PS, PW, PR
4 phases required to read FP from memory

Decode: DP, DC
2 phases required to route instruction to functional unit and decode it

Execute: E1 - E10
Execution of actual instr in functional-unit

(b) Why did we make program fetches (PF pipeline stage) four cycles?

Otherwise, memories wouldn’t be fast enough for the C6000.

(c) Why are pipeline stages of a load (E1-E5) similar to the phases of a program fetch (PG-DP)?

They are both memory read operations.

2. What is a fetch packet? execute packet?

FP - group of eight instr all fetched together
EP - group of parallel instructions which all execute together
3. Insert NOPs as needed:

(30 pts)

```
start: LDH .D1 *A0, A1
        NOP 4
        MPY .M1 A1, A2, A3
; No NOP needed
        ADD .L1 A1, A2, A4
        LDB .D1 *A5, A6
        NOP 3
        LDW .D1 *A7, A8
; No NOP needed
        MPY .M1 A6, A9, A10
        NOP
        ADD .L1 A9, A10, A11
        B .S1 start
        NOP 5
```
### Register Allocation Table

<table>
<thead>
<tr>
<th>Instruction / Notes</th>
<th>A register file</th>
<th>#</th>
<th>#</th>
<th>B register file</th>
<th>Instruction / Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A0 B0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A1 B1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A2 B2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A3 B3</td>
<td></td>
<td></td>
<td>Address</td>
<td></td>
</tr>
<tr>
<td>(1)</td>
<td>A4 B4</td>
<td>(2)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(3)</td>
<td>A5 B5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(4)</td>
<td>A6 B6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(5)</td>
<td>A7 B7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(6)</td>
<td>A8 B8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(7)</td>
<td>A9 B9</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(8)</td>
<td>A10 B10</td>
<td>(9)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(10)</td>
<td>A11 B11</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(11)</td>
<td>A12 B12</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(12)</td>
<td>A13 B13</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(13)</td>
<td>A14 B14</td>
<td></td>
<td></td>
<td>*DP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A15 B15</td>
<td></td>
<td></td>
<td>*Stack</td>
<td></td>
</tr>
</tbody>
</table>

Registers A1, A2, B0-B2 can be used as conditional registers for all instructions.

Registers A4-A7, B4-B7 can be used for circular addressing pointers.

If modified, registers A10-A15, B10-B15 must be saved by assembly-called subroutine.

Other references refer to the register usage by C Compiler.
<table>
<thead>
<tr>
<th>Instruction / Notes</th>
<th>A register file</th>
<th>#</th>
<th>#</th>
<th>B register file</th>
<th>Instruction / Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A0</td>
<td>B0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A1</td>
<td>B1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A2</td>
<td>B2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A3</td>
<td>B3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A4</td>
<td>B4</td>
<td>(2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A5</td>
<td>B5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A6</td>
<td>B6</td>
<td>(4)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A7</td>
<td>B7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A8</td>
<td>B8</td>
<td>(6)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A9</td>
<td>B9</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A10</td>
<td>B10</td>
<td>(8)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A11</td>
<td>B11</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A12</td>
<td>B12</td>
<td>(10)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A13</td>
<td>B13</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A14</td>
<td>B14</td>
<td></td>
<td></td>
<td>*DP</td>
</tr>
<tr>
<td></td>
<td>A15</td>
<td>B15</td>
<td></td>
<td></td>
<td>*Stack</td>
</tr>
</tbody>
</table>

Registers A1, A2, B0-B2 can be used as conditional registers for all instructions. Registers A4-A7, B4-B7 can be used for circular addressing pointers. If modified, registers A10-A15, B10-B15 must be saved by assembly-called subroutine. Other references refer to the register usage by C Compiler.
<table>
<thead>
<tr>
<th>Cycle</th>
<th>.L1</th>
<th>.L2</th>
<th>.M1</th>
<th>.M2</th>
<th>D1</th>
<th>D2</th>
<th>S1</th>
<th>S2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix B - Circular Buffering

Appendix B consists of two parts:

1. Application Note
2. Optional set of slides
TMS320C6000 Non-Power of 2 Circular Buffers

Eric Wilbur
Yao-Ting Cheng

ABSTRACT

The TMS320C6000™ circular buffer block size must be specified as a power of 2. However, some filters require coefficient/data table sizes which are not a power of 2. This application report shows an easy work around to implement the circular buffer with any block size.

Contents

1 Design Problem ................................................................. 1
2 Solution ................................................................. 1
   2.1 Procedure ......................................................... 2

List of Figures

Figure 1. Pointers to the Beginning of the Circular Buffer ......................... 2
Figure 2. Pointer Increment and Reset ....................................... 3
Figure 3. Pointer Increment and Reset ....................................... 3
Figure 4. Pointer Increment and Reset ....................................... 4

List of Examples

Example 1. Code Listing ...................................................... 5

TMS320C6000 is a trademark of Texas Instruments.

1 Design Problem

Eight C6x registers (A4~A7, B4~B7) can be used for circular addressing. The block size (or buffer size) must be specified as a power of 2 (i.e. $2^n$). However, some filters require coefficient/data table sizes which are not a power of 2. So, how then can you implement these algorithms on the C6x? One method to solve the problem is provided below.

2 Solution

Let’s start with an example of an FIR filter with 6 16-bit coefficients/samples. The code to implement this solution is given at the end of the document.

$$ Y = \sum_{i=1}^{6} X_i \cdot C_i $$

(1)

This solution does waste some RAM (the $2^n$ blk size minus the actual table size, in this case: 8–6 = 2 locations), but without any speed penalties. The basic principle is that you create a “hole” of unused samples that circulates through memory. The benefit is that once you set up your tables correctly, the code is very straightforward.
2.1 Procedure

1. Arrange the input samples in incrementing order such as X1,X2,...,X6 and the coefficients in descending order such as C6,C5,...,C1.

2. Set the block size of the circular buffer to the $2^n$ size greater than the actual table size, select circular register and initialize AMR. In our example, the block size will be 16 bytes or 8 shorts (16-bit). A4 will be used in circular mode (as the sample pointer), therefore AMR= 0x00030001.

3. Initialize the circular buffer pointer A4 to the top of the input samples (i.e. A4=&X1).

4. Initialize another pointer (using linear mode), to the top of the coefficients. In our example B4=&C1.

5. Set the loop counter to be the number of coefficients minus one. So, B0=5. This might look like a problem because your loop will only execute 5 times instead of 6. However, see step 7 for the solution.

6. Load the value from *A4++ and *+B4[B0] to registers and perform a MAC. As you can see, the count value is being used as a pre-offset to the base of the coefficient table. Therefore, the code will access C1 first, then C2, etc.

7. In the MAC loop, the counter should be decremented, looping a total of 6 times. However, please note that the SUB instruction should occur one cycle AFTER the branch or the code will only loop 5 times. This method allows the code to use B0 (the count value) as a pre-offset for the coefficients. If you are pipelining your algorithm, the same concept applies.

![Figure 1. Pointers to the Beginning of the Circular Buffer](image-url)
8. Get a new input sample. After the MAC operation, the circular register (e.g. A4) is pointing to the next “empty” location to be filled. When loading a new value into the sample table, if you post increment by \((2^n - \text{actual table size} + 1)\) (in our example this would be \(8 - 6 + 1 = 3\)), the pointer (A4) will be set to the new “top” of the buffer (the oldest sample).

9. Reset the circular pointer to point to the oldest sample. This can be done separately or as part of loading the new sample (as described in step 8).
10. Go to step 5. As you can see in the diagram above, a “hole” of unused samples is created inside the buffer. Let’s say X9 is the newest sample. The filter will run from X4 through X8 and then X9. In this case, X2 and X3 locations were NOT used. As the filter continues, this “hole” of size 2 moves in a circular fashion. So, when X10 comes in, it overwrites X2, the filter runs from X5–X10 and X3/X4 locations are not used, etc. There is no wasted space in the coefficient table.

11. Note: This example does not include any software pipelining. However, the same concept can be applied to a s/w-pipelined loop. The goal was to provide a methodology for dealing with an algorithm using a block size which is not a power of 2.
Example 1. Code Listing

```assembly
.title "fir.asm" ; non 2^n Circular Buffer
.def init

half .equ 2 ; half is defined as 2 bytes
.data
coeff .short 6,5,4,3,2,1 ; FIR filter coefficients
initsmp .short 1,2,3,4,5,6 ; input samples
new_smp .short 7,8,9,0xa ; new input samples
.bss sample,8*half,8*half
.bss output,1*half,1*half
.text

init_AMR:
MVK .S2 0x0001,B0 ; setup cir. buf AMR=0001_0003h
MVKLH .S2 0x0003,B0 ; setup cir. buf AMR=0001_0003h
MVC .S2 B0,AMR ; blk size is 16 bytes, pointer is A4

init_buffer: ; assume the variable has been initialized
init_pointers:
MVK .S2 new_smp,B7 ; init pointers
MVKH .S2 new_smp,B7
MVK .S2 coeff,B4
MVKH .S2 coeff,B4
MVK .S1 output,A9
MVKH .S1 output,A9
MVK .S1 sample,A4
MVKH .S1 sample,A4

fir: ZERO .L1 A7
MVK .S2 5,B0
loop: LDH .D1 *A4++,A5 ; load samples
LDH .D2 *+B4[B0],B5 ; load coefficients
NOP 4
MPY .M1x A5,B5,A6
NOP
ADD .L1 A7,A6,A7
[B0] B .S1 loop
[B0] SUB .L2 B0,1,B0
NOP 4
get_new_smp:
LDH .D2 *B7++,A8 ; get new sample
STH .D1 A7,*A9 ; store the result to output
NOP 3
STH .D1 A8,*A4--[5] ; store new sample to buffer
; and init circular pointer
B .S1 fir
NOP 5
B .S1 $
NOP 5
```

IMPORTANT NOTICE

Texas Instruments and its subsidiaries (TI) reserve the right to make changes to their products or to discontinue any product or service without notice, and advise customers to obtain the latest version of relevant information to verify, before placing orders, that information being relied on is current and complete. All products are sold subject to the terms and conditions of sale supplied at the time of order acknowledgment, including those pertaining to warranty, patent infringement, and limitation of liability.

TI warrants performance of its semiconductor products to the specifications applicable at the time of sale in accordance with TI’s standard warranty. Testing and other quality control techniques are utilized to the extent TI deems necessary to support this warranty. Specific testing of all parameters of each device is not necessarily performed, except those mandated by government requirements.

Customers are responsible for their applications using TI components.

In order to minimize risks associated with the customer’s applications, adequate design and operating safeguards must be provided by the customer to minimize inherent or procedural hazards.

TI assumes no liability for applications assistance or customer product design. TI does not warrant or represent that any license, either express or implied, is granted under any patent right, copyright, mask work right, or other intellectual property right of TI covering or relating to any combination, machine, or process in which such semiconductor products or services might be or are used. TI’s publication of information regarding any third party’s products or services does not constitute TI’s approval, warranty or endorsement thereof.

Copyright © 2000, Texas Instruments Incorporated
Circular Buffer Using Non-2\textsuperscript{n} Size

FIR Algorithm:
Sample size = 6
Buffer size = 8 (power of 2)

“The Bubble in Memory”
Step 1: setup AMR and ptr to smpl
Step 2: Calculate 6-term result
Step 3: Next sample
Step 4: repeat steps 2-3

Non 2n Buffer Example

DECLARATIONS
SETUP
AMR
A4 = smpl
B4 = coeff
B0 = count

ALGORITHM
A4 (circular)
B4 (+offset using tapsize)

NEXT SAMPLE
A4 reset to “top” of buffer

Tapsize .equ 6 ;# taps (count)
Bufsize .equ 8 * 2 ;pwr 2 > tapsize
 coeff .short a5, a4, a3, a2, a1, a0
 smpl .usect “firBuf”, bufsize, bufsize

setup: MVK 0001h, B1 ;AMR=00030001
MVKLH 0003h, B1
MVC B1, AMR
MVKL smpl, A4
MVKH smpl, A4
MVKL coeff, B4
MVKH coeff, B4

FIR:
ZERO A7
MVK tapsize-1, B0
loop:
LDH *A4++, A5
LDH *+B4[B0], B5
NOP 4
MFY A5, B5, A6
NOP
ADD A6, A7, A7
[B0] loop
[0] sub B0,1,B0
NOP 4
next: LDH *new_smpl_ptr, A8
NOP 4
STH A8, *A4--[tapsize-1]
B FIR
NOP 5
Circular Buffering Example

Non 2^n Buffer Example

<table>
<thead>
<tr>
<th>b4</th>
<th>coeff</th>
<th>a4</th>
<th>a3</th>
<th>a2</th>
<th>a1</th>
<th>a0</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>x(0)</td>
<td>x(1)</td>
<td>x(2)</td>
<td>x(3)</td>
<td>x(4)</td>
<td>x(5)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

tapsize .equ 6  ;# taps (count)
bufsize .equ 8 * 2 ;pwr 2 > tapsize
 coeff .short a5, a4, a3, a2, a1, a0
 smpl .usect "firBuf", bufsize, bufsize
 .sect "text"
setup: MVK 0001h, B1 ;AMR=00030001
MVKLM 0003h, B1
MVC B1, AMR
MVKL smpl, A4
MVKH smpl, A4
MVKL coeff, B4
MVKH coeff, B4
FIR: ZERO A7
loop: LDR *A4++, A5
LDH **B4[B0], B5
NOP 4
MPY A5, B5, A6
NOP ADD A6, A7, A7
[B0] B loop
[B0] SUB B0,1,B0
NOP 4
next: LDR *new_smpl_ptr, A8
NOP 4
STH A8, *A4--[tapsize-1]
B FIR
NOP 5

TT O
Technical Training Organization

Pointer Operands - Circular Addressing

AMR - Address Mode Register

buFSIZE .set 8*2 ⇒ 2^n+1 ⇒ n=3

Mode
00: linear (default)
01: circular (using BK0)
10: circular (using BK1)
11: reserved

Block size (bytes) = 2^{N+1}
Circular Buffering Example

**Non 2^n Buffer Example**

```asm
tapsize .set 6 ;# taps (count)
bufsize .set 8 * 2 ;pwr 2 > tapsize

FIR: ZERO A7
MVK tapsize-1, B0
loop: LDH *A4++, A5
      LDH *+B4[B0], B5
      NOP 4
      MPY A5, B5, A6
      NOP
      ADD A6, A7, A7
      [B0] B loop
      SUB B0,1,B0
      NOP 4
```

coef:
- A5
- A4
- A3
- A2
- A1
- A0

smpl:
- x(0)
- x(1)
- x(2)
- x(3)
- x(4)
- x(5)

x16 (le)

---

**Non 2^n Buffer Example**

```asm
tapsize .set 6 ;# taps (count)
bufsize .set 8 * 2 ;pwr 2 > tapsize

FIR: ZERO A7
MVK tapsize-1, B0
loop: LDH *A4++, A5
      LDH *+B4[B0], B5
      NOP 4
      MPY A5, B5, A6
      NOP
      ADD A6, A7, A7
      [B0] B loop
      SUB B0,1,B0
      NOP 4
```

coef:
- A5
- A4
- A3
- A2
- A1
- A0

smpl:
- x(0)
- x(1)
- x(2)
- x(3)
- x(4)
- x(5)

x16 (le)
Circular Buffering Example

Non $2^n$ Buffer Example

tapsize .set 6 ;# taps (count)
bufsize .set 8 * 2 ;pwr 2 > tapsize

FIR: ZERO A7
MVK tapsize-1, B0
loop: LDH *A4++, A5
      LDH *+B4[B0], B5
      NOP 4
      MPY A5, B5, A6
      NOP
      ADD A6, A7, A7
[B0] B loop
     SUB B0,1,B0
     NOP 4

next: LDH *new_smpl_ptr, A8
      NOP 4
      STH A8, *A4--[tapsize-1]
      B FIR
      NOP 5
Circular Buffering Example

Non 2\textsuperscript{n} Buffer Example

tapsize .set 6 ;# taps (count)
bufsize .set 8 * 2 ;pwr 2 > tapsize

FIR: ZERO A7
MVK tapsize-1, B0
loop: LDH *A4++, A5
      LDH *+B4[B0], B5
      NOP 4
      MPY A5, B5, A6
      NOP
      ADD A6, A7, A7
      SUB B0,1,B0
      NOP 4
      [B0]
      B loop
next: LDH *new_smpl_ptr, A8
      NOP 4
      STH A8, *A4--[tapsize-1]
      B FIR
      NOP 5
Circular Addressing in Linear Assembly

Circular Addressing (.circ)

\.circ x/B6, y/A7 ...

- \.circ provides two effects:
  - maps symbol to register (same as \.map)
  - circular declaration

- Register symbol must be mapped to a circular register
  - A4, A5, A6, A7
  - B4, B5, B6, B7

- Only valid inside a procedure (.cproc)

- Does not insert code for setting up circular addressing, it only maps the register to be used (as shown on next slide)

```assembly
main.c
#define tapsize 6 ;# taps (count)
#define bufsize 8 * 2 ;pwr 2 > tapsize

#pragma DATA SECTION(coeff, ".data")
short coeff[tapsize] = {a5,a4,a3,a2,a1,a0};

#pragma DATA_ALIGN(smpl, bufsize)
#pragma DATA_SECTION(smpl, "firBuf")
short smpl[bufsize];

fir.sa
.sect "code"
.global _coeff, _smpl
fCirc: .cproc taps, bsize
.reg aData, cReg
.circ sReg/A4

setup:
MVKL 0001h, aData ;AMR=00030001
MVKLH 0003h, aData
MVC aData, AMR
MVKL _smpl, sReg
MVKH _smpl, sReg
MVKL _coeff,cReg
MVKH _coeff,cReg
```